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1 Uvod do systému Maple

1.1 Systém Maple

vvvvvv

problémi. S jeho pomoci také miizeme vytvaret dokumenty vysoké kvality, prezentace a in-
teraktivni uzivatelské nastroje. Maple patii do skupiny systémii pocitacové algebry umoznu-
jici jak symbolické, tak numerické vypocty. Systém navic obsahuje komponenty podporujici
vyuku matematiky:.

Vyrobcem systému je kanadské spole¢nost Maplesoft Inc., jejiz webové stranky® poskytuji
siroké informace o systému a jeho dalsSich pribuznych programech jako je MapleSim, Maple-
Net, Maple T.A. a mnoho dalsich nastroji a programti. Webové stranky mimo jiné obsahuji
tzv. Aplikacni centrum (Application Center), z néjz si mize kazdy zaregistrovany uzivatel
stahnout ukézkové programy demonstrujici pouziti systému Maple pfi feSeni mnoha riz-
nych matematickych i technickych problému. Poskytuji i tzv. Studentské centrum (Student
Center), kde si zaregistrovany student miize stdhnout mnoho studijnich materiala. Dalsimi
viznamnymi zdroji informaci o Maple jsou diskuzni férum uZivatelit Maple? a web distribu-
tora Maple pro Ceskou a Slovenskou republiku®, kde je vétsina dokumentt v ¢eském jazyce
[5], [9].

Systém Maple je vyvijen od roku 1980, kdy se objevila jeho prvni limitovana verze.
Ptelomovym obdobim byly roky 2003-2005, v nichz vznikla devata a nasledné desata verze
Maple 10 prinéasejici nové grafické uzivatelské rozhrani zvané Standard Worksheet a poté tzv.
dokumentovy rezim (Document mode). Diky nim se ovladani systému Maple stalo vyrazné
jednodussim. V soucasné dobé vznika kazdy rok nova verze, v dobé psani tohoto textu byla
na trhu nejnovéjsi verze Maple 14. A pravé touto verzi se budeme zabyvat.

Se systémem je mozné pracovat nékolika rtiznymi zptisoby, které volime pii spusténi
programu ze startovaciho menu pocitace nebo kliknutim na prislusnou ikonu na plose. Maple
je k dispozici pro rizné operacni systémy. V nasledujicim textu popiseme, jak s program
spoustime v nejrozsirenéjSim opera¢nim systému Windows.

1.1.1 Standardni zapisnik (Standard Worksheet)

Grafické uzivatelské rozhrani Maple zvané Standard Worksheet se spusti ze startovaciho
menu pocitace vybérem polozky Programy > Maple 14 > Maple 14 nebo kliknutim na
ikonu Maple 14 na plose. Toto prostiedi poskytuje veskeré moznosti systému Maple a po-
méhé vytvéaret elektronické dokumenty (zapisniky) zobrazujici matematické vypocty, texty
a komentafe spolu s propracovanou pocitacovou grafikou. Nékteré je mozné v zapisniku

vvvvvv

teli potfebné informace. Jelikoz jsou vytvorené dokumenty interaktivni, tj. v jistém smyslu

Thttp: //www.maplesoft.com
2http://www.mapleprimes.com
3http://www.maplesoft.cz



,Zivé", muze si uzivatel sdm upravovat preddefinované hodnoty parametrii, vyhodnocovat
prikazy, a ziskavat tak nové vysledky.

Menu zapisniku Maple mé tfi vodorovné listy: hlavni menu (Menu Bar, zcela nahore),
ndstrojovou listu (Toolbar, pod hlavnim menu) a kontextovou listu (Context Bar, pod na-
strojovou ligtou). Zapisnik dale obsahuje palety ( Palettes, svisly blok na levé strané?), vlastni
pracovni pole — dokument (Document), do néjz zadavame piikazy, texty, provadime vypo-
¢tové a grafické akce, a stavovou listu (Status Bar, zcela dole). Vlastni pracovni pole je mozné
zobrazit pfes celou obrazovku skrytim palet a vSech list (kromé hlavniho menu) kliknutim
na prislusné polozky v zalozce View hlavniho menu.
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Obrazek 1.1: Maple 14: Prostfedi Standard Worksheet.

1.1.2 Klasicky zapisnik (Classic Worksheet)

Classic Worksheet se spusti ze startovacitho menu pocitace vybérem polozky Programy >
Maple 14 > Classic Worksheet Maple 14 nebo kliknutim na ikonu Classic Worksheet
Maple 14 na plose. Tento zapisnik Maple je urcen predevsim pro méné vykonné pocitace
s omezenou paméti. Neposkytuje také vSechny funkce, prikazy a moznosti systému Maple
jako Standard Worksheet [5].

1.1.3 Prikazovy radek a kalkulacka Maple

Se systémem Maple miizeme pracovat i pouze v rezimu tzv. prikazového radku spustitelného
ze startovaciho menu pocitace vybérem polozky Programy > Maple 14 > Command-
line Maple 14. Piikazovy fadek je urcen k feSeni rozsdhlych a slozitych tloh. K dispozici
pritom nejsou zadné grafické prvky.

4Palety se automaticky zobrazuji v levém bloku. Prostfedi systému nabizi blok pro palety i po pravé
strané obrazovky (automaticky zavieny), kam je mozné nékteré (ale i vSechny) pfesunout.
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> (x2-5%x+6)*(x2-1) /((x-1)*(x-2));
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> simplify(%)
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1
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Obrdzek 1.2: Maple 14: Prostiedi Classic Worksheet (pfevzato z [5]).

ogramData‘Microsoft’ Windows' Start Menu',Programs',M
Maple 14 <IBM INTEL NI> B
. Copyright <{c> Maplesoft., a division of Waterloo Maple Inc. 2818
A1l rights reserved. Maple is a trademark of l
Waterloo Maple Inc.
Type ? for help.

Obrdzek 1.3: Maple 14: Ptikazovy Fadek.

Déle je mozné pouZivat (a vytvafet) tzv. maplety, tj. grafickd uzivatelskd rozhrani ob-
sahujici okénka, textova pole a dalsi vizualni prvky umoznujici pouhym klikdnim spoustét
vypocty. Kalkulacka systému Maple je specialni typ mapletu, ktery je k dispozici pouze
pro operacni systémy Windows. Spousti se ze startovactho menu pocitace, kde se vybere
Programy > Maple 14 > Maple Calculator [5].

6



1.1.4 Document Mode, Worksheet Mode

Dale se budeme vénovat pouze rozsifenému prostredi Standard Worksheet. V tomto prostiedi
je mozné pracovat ve dvou zékladnich rezimech: Worksheet Mode a Document Mode. Prvné
jmenovany odpovida prostiedi Classic Worksheet, v némz je kazdy ptikaz Maple uvozen sym-
bolem [> a musi byt ukoncen stfednikem (vysledek se zobrazi na dal$im fadku uprostied)
nebo dvojteckou (vysledek se nezobrazi). Otevira se v hlavnim menu zvolenim File > New
> Worksheet mode. Document Mode poskytuje prehlednéjsi zapis prikazi a matematic-
kych vzorct bez ,pfebytecnych® symbolid. Pii otevieni nového souboru z nastrojové listy
je automaticky spustén praveé tento rezim, jinak je mozné jej téz otevrit z hlavniho menu
v polozce File > New.

Obvykle je zapisnik nastaven do jednoho rezimu®, ktery je moZné zvolit pii otevirani
nového souboru v hlavnim menu (File > New > ...). Existuje v8ak i moznost pfepinat
mezi rezimy v ramci jednoho zapisniku, kdy je ¢ast vytvorena v jednom rezimu, ¢ast v jiném.
Z Document Mode se pfepneme do Worksheet Mode kliknutim na ikonku [> v néstrojové
listé. Naopak z Worksheet Mode se do rezimu Document Mode prepneme vybérem polozky
v hlavnim menu (Format > Create Document block) [5].

1.1.5 Math Mode, Text Mode

Pro rozliseni ptikazti a obycejného textu slouzi kontextova lista zapisniku, kde mame na
vybér Text Mode a Math Mode. Math Mode odpovida pfikaztiim (po stisku klavesy Enter
dojde k vyhodnoceni), v Text Mode piSeme texty dokumentu podobné jako napf. v textovém
editoru Word (po stisku klavesy Enter prejdeme na novy fadek bez jakéhokoli vyhodnocenti).
Volit rezim zépisu mizeme bud kliknutim mysi (v kontextové listé nad dokumentem jsou
uvedeny nazvy predstavujici jednotlivé moznosti) nebo vybérem polozky v hlavnim menu
(Edit > Switch to Text/Math Mode). Totéz lze rychleji provést klavesou F5.

V rezimu Worksheet Mode lze pro text i pro piikazy pouzit oba druhy zapisu. Pro psani
textu je nutné kliknout na ikonku T v nastrojové listé nebo zvolit polozku v hlavnim menu
(Insert > Text). Podobné pro zépis piikazi jazyka Maple je nutné kliknout na ikonku [>
v néstrojové listé nebo zvolit polozku v hlavnim menu (Insert > Maple Input). Pti otevieni
nového souboru je zapisnik automaticky nastaven na psani ptrikazi.

K piikaziim méme déale moZnost zapisovat komentafe uvedenim symbolu m¥izky (#)
pred text, ktery ma byt komentafem (viz obrazek 1.5) [5].

1.2 Zakladni ovladani systému

Jiz vime, jak spustit systém Maple a jak zvolit pracovni prostiedi, které chceme. Oteviit
jiz vytvofeny program mutZeme z hlavniho menu (File > Open...) nebo spusténim pro-
gramu rovnou z operacniho systému (prostiednictvim néjakého souborového manaZeru).
Kdyz chceme vytvofeny dokument ulozit, zvolime polozku File > Save (resp. File > Save
As...) v hlavnim menu systému Maple. Dokumenty prostiedi Standard Worksheet mayji
priponu mw, dokumenty prostiedi Classic Worksheet piiponu mws. V prostiedi Standard
Worksheet je mozné oteviit oba typy souborti, v prosttedi Classic Worksheet pouze typ
MWwS.

Maple poskytuje také moznost exportovat dokumenty jako soubory jinych typt. Pod-
porovany jsou typy: HT'ML, PDF, LaTeX, Maple Input, Maplet, Maple Text, Plain Text,

5Ten zpravidla volime pii prvnim spusténi po instalaci systému nebo jej miizeme nasledné nastavit v hlav-
nim menu: Tools > Options... > Interface.



Zapis v rezimu Document Mode Zapis v rezimu Worksheet Mode

Tento text je v reZimu Text Mode. _
Stiskem klavesy Enter jsme se dostali na dali fadek. Tento text je téZ v rezimu Text Mode.

Na nasledujicim #adku se pfepneme do reZimu Math Mode.
Tento text fe v reZimic Muth Meode.

prikaz L
prikaz
néfaky text > piikaz
néfaky text pfikaz
256-125 > ptikaz;
solve(x* — 7x +12=0) > 256-125
4,3 32000

[ > 256%125;

32000

Obrazek 1.4: Rezimy zapisu (pfevzato z [5]).

256-125 # néjaky komentdf
32000

> 256%*125; # néjaky komentar
32000
[>

Obrdzek 1.5: Zapis komentéare v pfikazovém rezimu (pfevzato z [5]).

Maple T.A. a Rich Text Format. Pro export dokumentu vybereme polozku Export As...
ze zalozky File v hlavnim menu.

Nyni si ukdzeme, jak v Document Mode zadavat jednoduché ptikazy. Budeme proto
predpokladat, ze zapisnik je jiz nastaven pro psani piikazt (Math Mode).

Zakladni operace: pro s¢itani pouzivame symbol plus (+), pro od¢itani minus (—), pro né-
sobeni (*), ale pozor, pro déleni musime pouzivat pouze lomitko (/), dvojtecka (:) m4 jiny
vyznam (viz déle).

Zadani zlomku: zadame c¢itatel, lomitko (/) a jmenovatel. Pro opusténi zapisu jmenovatele
sta¢i stisknout Sipku doprava (ve zlomku je téZ mozno pohybovat se Sipkami).

Zadani mocniny: zadame zaklad, symbol st¥iska (") a exponent. Pro opusténi zapisu ex-
ponentu je opét mozné pouzit Sipku doprava.

1.2.1 Vyhodnoceni prikazu

Prikaz vyhodnotime stiskem klavesy Enter. Vysledek se zobrazi na dalsim fadku uprostied.
V diivéjsich verzich (méné nez 10) systému Maple bylo nutné piikaz ukoncovat stfednikem,
aby se provedl. Tato moznost nadéle ztstala (tj. zadame-li za piikaz stfednik, ,nic nepoka-
zime*“) a v nékterych situacich je dokonce jedind mozna — napft. textovy rezim (Text Mode)
prikazti v Worksheet Mode nebo pii psani piikazi v prostiedi Classic Worksheet. 7. pie-
deslych verzi Maple se uchovala i funkcionalita symbolu dvojtecka (:), kterd po zafazeni
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za piikaz a nasledného stisku klavesy Enter potlac¢i zobrazeni vysledku na dalsim radku
(tj. ptikaz se vyhodnoti, ale na obrazovku se nic nevypise). Proto neni mozné dvojtecku
pouzivat jako operator déleni. V. Document Mode je navic mozné zapisovat piikaz i s vysled-
kem na jeden tfadek. Po napsani prikazu k tomu staci namisto stisku klavesy Enter pouzit
klavesovou zkratku ,,Ctrl + =“.

Jak bylo zminéno drive, interaktivni dokumenty v Maple jsou ,zivé“. Tim mame na mysli
skutecnost, ze i v diive vytvofeném dokumentu s vyhodnocenymi prikazy otevieném po
libovolné dlouhé dobé muzeme kterykoli vyraz upravit, znovu vyhodnotit (stisknout Enter
nebo ,,Ctrl + =*) a dostaneme novy vysledek. Oznacime-li mysi nékolik (libovolné mnoho)
ptikazt a stiskneme ikonku ! (vykii¢énik) z nastrojové listy, vSechny oznac¢ené piikazy budou

postupné vyhodnoceny. K vyhodnoceni vSech piikazti v dokumentu slouzi ikonka !!! (tii
vyk¥i¢niky).

Maple obsahuje vice nez tisic symboldi, pomoci nichz mizeme
tvorit matematické vyrazy a typograficky kvalitni text. Patii mezi — =

né pismena a cislice, jimiz vytvafime jména (posloupnost znaki za-
¢inajici pismenem, za kterym miize nasledovat kombinace pismen,
¢isel a vybranych symbol), redlna ¢isla (celd, racionélni, iracionalni,
s desetinou teckou nebo v notaci pohyblivé fadové ¢arky), komplexni | ¥Eseression
¢isla, aritmetické, booleovské a jiné operatory (+,—, !, /,*, [, lim, ... . Z
), konstanty (7, e, ...), imagindrni jednotku, nekone¢no, matema- e J & '
tické funkce (cos(x), sin(%), ... ) a proménné (pojmenované jménem ] ,

..). Velkou pfednosti systému Maple je jeho schopnost symbolic- H % f =
kych matematickych vypocti. Nékteré z matematickych symboli,
které mizeme pouzit, nejsou na klavesnici, a tak se zadavaji bud LA |
z palety nebo pomoci svych nazvi [5]. ab =

l} MapleCloud J

l P Handuwriting J

1.2.2 Palety \,f— . ]

Palety jsou pojmenované ,,obdélnicky“ s nabidkou pfeddefinovanych ¢ In(a)
symbolt, zapist, vyrazi apod. (obrazek 1.6), zpravidla pfi levém log,,(a) log,(a)
okraji zapisniku. Kazda paleta obsahuje symboly piislusné skupiny. | gn.) cos(s) tan(s)
Napriklad paleta s nazvem FEzxpression nabizi nékteré zakladni ma- ;
tematické vyrazy, paleta Greek pismena fecké abecedy atd. Stan- [r] fla) fla,b)
dardné zistava nékolik palet nezobrazenych. V hlavnim menu (View f=a—)
> Palettes) mizeme seznam zobrazenych palet upravit tim, Ze né- f:=(a,b) —
které pridame, odebereme, ale tfeba i jinak sefadime. Totéz lze pro- ¥ x<a
vést jen za pomoci mysSi. Pfidrzenim levého tlacitka vybranou pa- flx) s ! :
letu pfesuneme na jiné misto, stisknutim pravého tlacitka vyvolame
stejnou nabidku, jako bychom postupovali pires hlavni menu. Klik- L J
nuti levého tla¢itka mysi na nékterou z palet zobrazi (pfip. skryje) |\ J
symboly, které paleta nabizi. Vlozit z palety symbol do zapisniku Lb'Cnmmon Symbals J
L J
L J
L J

P Units (SI)

= Linits (FP3)

pak stac¢i pouhym kliknutim, ptripadné ,pfetdhnutim®“ s pomoci le-
vého tlacitka mysi. Obecné barevné zvyraznéné symboly ve vyrazu
je mozné déle specifikovat (upravovat) dosazenim hodnoty, s niz po-
tfebujeme pracovat [5]. =
Obrdzek 1.6: Palety.

P Components

10
Priklad 1.1: Vlozte do dokumentu vyraz ) 2°.
i=1

Reseni: Pro zapsani zadaného vyrazu potiebujeme celkem dva rizné symboly: sumu



a mocninu. Sumacni symbol nalezneme v paleté Expression. Kliknutim na tuto paletu ji
otevieme (na obrazku 1.6 je jako jedind oteviend) a vybereme z ni pfitomny sumacni symbol.
Po jeho vlozeni do zapisniku pak jednoduse pfepiSeme obecné symboly (k, n a f) pozado-
vanymi hodnotami. Pohybovat ve vzorci se mtizeme pomoci Sipek na klavesnici, s vyhodou
lze vyuzit klavesy Tab, pritom k tGpravé vyrazu miizeme pouzivat i vSechny ostatni klavesy
jako napt. Delete, Backspace, mezernik, ... Znak f pfepiSeme mocninnym vyrazem. To
miizeme provést bud vloZenim dalitho symbolu z palety Expression (symbol a®) a nésled-
nou upravou (specifikaci hodnot a, b), nebo uzitim jiz znamé klavesy pro tvorbu mocnin —
stiisky (7).

Piiklad 1.2: Vlozte do dokumentu vyraz » %
i=1

323642
17-24

Priklad 1.3: Vloite do dokumentu vyraz

1n(e5)!-sin(1YT‘")73-13

\/log,(16)—1

Priklad 1.4: Vlozte do dokumentu vyraz \/

1.2.3 Nazvy symbola

Mimo palet miizeme k zapisu symbolt uzivat jejich nazvi. Napiiklad symbol 7 vlozime za-
psanim jeho nazvu Pi® pro odmocninu je vyhrazen nazev sqrt, takze v/ vlozime napsdnim
sqrt (x). Pri vkladani symbolti pomoci nazvt nebo pfi tvorbé piikazi se mtize hodit funkce
,dokoncovani“. Pro zadani symbolu pak staci napsat jeho tivodni pismeno (pismena) a po-
moci klavesy Esc nebo klaves ,,Ctrl + mezernik“ nésledné z vyskakovaciho okénka zvolit
pozadovany piikaz. Na obrazku 1.7 je ukézka nabidky pro dokonceni zépisu pismen so [5].

softoy

=0l i
colve soke
solve solva(agn )
solve sofua (eqn, x|
solve (system) sofva( [agnl, egnd, L, (xI 22, .}
solve_group (DETools) (symmetry generator and wariables) DETools [solve group i (Esf}, [x.0]]
solvefor sobefor
sark sort .
sart {lisk) SOFE(BE)
ﬂt iwith ordering Function) .sorf[.ﬁ'.sf,_f}] il

Obrdzek 1.7: Funkce automatického dokoncovani (pfevzato z [5]).

6Maple rozlisuje mals a velk4 pismena. Napiiklad zapis Pi piedstavuje Ludolfovo éislo 7 i s jeho hodnotou,
zatimco zapis pi pfedstavuje pouze symbol (fecké pismeno) 7.
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323642

Priklad 1.5: Vlozte do dokumentu vyraz |*5-o;

bez pouziti palet.

Reseni: Pro absolutni hodnotu z pozadovaného vyrazu pouzijeme piikaz abs, pii zada-
vani mocnin vyuzijeme symbolu stiisky (7). Vysledny zapis zadaného vyrazu tedy bude:
abs ((3273-64"2)/(17%2°4)).

ln(e5)!-sin(177‘”)73~1

/log2(16)—1

Priklad 1.6: Vlozte do dokumentu vyraz ® bez pouziti palet.

1.3 Napovéda

Vyznamnou soucasti systému Maple je jeho napovéda. K dispozici je ne€kolik riznych typi
napovédy, které nejlépe najdeme v hlavnim menu v nabidce Help. Zakladni stranky napo-
védy zobrazime vybérem polozky Maple Help’.

Vyhledavat v ndpovédé muzeme bud zadanim hledaného textu do textového pole v levé
horni ¢asti okna (na obrazku 1.8 je v tomto poli zapsan text abs), nebo tematickym vyhleda-
vanim v pfipravené stromové struktufe témat v levé ¢asti okna (na obrazku 1.8 je rozbalena
Matematika a v ni téma Calculus, tedy Matematické analyza). Odkliknutim zadaného slova
abs v textovém vyhledavacim poli napovédy zobrazime v hlavni ¢asti okna napovédu prave
k prikazu abs. Jak mizeme vidét na obrazku 1.8, napovéda obsahuje zakladni popis prikazu,
obecny zapis piikazu pro jeho pouziti a konkrétni ukazkové priklady.

23 Maple 14 Help - [abs] =10 x|

File Edit ‘View History Help

& B w7 @ B ¥ [E

Search For: % Topic © Text : =
be LI earch abs - The absolute value function
—
Resources:|all 'l .
I Calling Sequence
Table of Contents | Search Resuls |
[ | Getting Started 1] abs(x) I
What's Mew bs(a, %)

[ | Create Maple Worksheets absin. X
[ |, Share Maple Warksheets
[ | Customize the Maple Window
[ | Cuskomize the Maple Syskem Parameters ||
B Toolboxes x - expression or rtable
Conneckivity
£ | Mathematics n - positive integer

slgebra

Easic Mathematics L.

£ L Cakeulus ¥ Description

| Continuity Testing . .
Differential Calculus » The abs function retumns the absolute value of the expression x
mplicitdiff * You can enter the command absusing either the 1-D or 2-D calling sequence. For example, abs(-11) is equivzlent to
, Integration [-11].
- Lirnit: - . . - . . . .
) T':::sforms *If x1s an rtable (Array, Matrix, or Vector), the abs function applies the abs function to each entry in the table, and

) Caleulus of Yariations returns the resulting rtable.

| Conversions » If xincludes a function L. then abs will attempt to execute the procedure abs/f to determine the abselute value of the
., Differential Equations cotresponding part of . The user can thus easily extend the functionality of abs.
Diffy tial-algebraic Equati - . N .
1 D:ff:::t::\;‘i:n;s; Huations » The derivative of absis denoted by abs(1. x). This is signum(x) for all non-0 real numbers, and is undefined
. Discrete Mathematics otherwise. Neither first order nor higher order derivatives of abs can be determined if xis an rtable.
J Evaluation » Higher order derivatives of abs are denoted by abs(n, x). where n is a pesitive integer. When n is known, the

. Factorization and Sobving Equations

expression is automatically simplified to the appropriate expression in a derivative of either signum or abs.
. Financial Functions -

b b b [ ] [ ]
BG-GB - (- - - - -

. Functiondvisor

. Fuzzy Sets T Examp]es

. General Information > |—11|
- | Geometry |: 11 41 .
Graphing Calculator LI _‘I _’lJ

Obrazek 1.8: Hlavni napovéda systému Maple.

"Pro vyvolani této napovédy miiZzeme také pouzit kldvesovou zkratku ,Ctrl + F1“, nebo posledni ikonku
nastrojové listy.
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1.3.1 Tour of Maple, Quick Reference, Quick Help
Nabidka Help hlavniho menu poskytuje jesté neékolik jinych forem napovédy. Polozka Take

nuti na Quick Reference otevie tabulku informaci o ovladani systému Maple, zejména pro
nové uzivatele. Jedna se o zékladni informace s odkazy do napovédy Maple Help pro jejich
véda. Standardné se objevuje v kazdém novém zapisniku pii pravé strané v podobé ¢erného
okénka (pokud toto nastaveni nezrusime). Po zavfeni je mozné ji vyvolat stiskem klévesy
F1, ¢ jako polozku v hlavnim menu [5].

1.3.2 What’s New, Startup Dialog

Dalsimi druhy napovédy jsou piehled rozsifeni stavajici verze Maple oproti predchéazejici verzi
(dostupné pres Help > What’s New) a tzv. Startup Dialog obsahujici tipy pro praci
se systémem Maple. Startup Dialog se zobrazuje vidy po spusténi systému (pokud toto
nastaveni nezrusime) [5].

1.3.3 Manuals, Resources, and more

Vyvolanim Manuals, Resources, and more prejdeme do dalsi oblasti napovédy, z niz
popiseme tTi nejdtlezitéjsi ¢asti.

Maple Portal

Od predchazejici verze (tedy Maple 13) je k dispozici tzv. Maple Portal. Spustit jej miZeme
samostatné (Maple Portal mé vlastni ikonu na plose) nebo pfes nadpovédu v hlavnim menu
(Help > Manuals, Resources, and more > Maple Portal). Maple Portal slouZi jako po-
mocnik novym i zkusenéjSim uzivateliim hledajicich pokrocilejsi napovédu. Je v ném mozné
rychle najit detailni popis prace se systémem Maple od feSeni nejjednodussich problémi az
po velmi slozité ulohy [5].

Applications and Examples

Z napovédy je mozno vyvolat i spustitelné soubory (tj. jiz vytvorené dokumenty) demon-
strujici moZnosti systému Maple. Otevieme je pfes ndpovédu v hlavnim menu (Help >
Manuals, Resources, and more > Applications and Examples) a pak kliknutim na
zvoleny piiklad [5].

Manuals

Déle je je mozné vyvolat anglické manualy User manual, Introductory Programming
Guide, Advanced Programming Guide a Getting Started with Maple Toolboxes
podrobné popisujici moznosti systému Maple. Otevieme je pres napovédu v hlavnim menu
(Help > Manuals, Resources, and more > Manuals) a pak kliknutim na zvoleny
manual [5].

1.3.4 Pomocnici, instruktori a fesené ulohy

Systém Maple poskytuje také jiz pripravené ,pomocné nastroje“ pro feseni tloh. Jsou to
tzv. Pomocnici (Assistants), Instruktori (Tutors) a Ulohy (Tasks), které vyvolame z hlav-

12



Talking to Maple

Mapie Portal

The Maple Portal is designed as a starting place for any Maple user. Maple's Tutorials will help you get started with Maple, leam about the key tools available in Maple, and lead you through a series of
problems. From here, investigate maore detailed topics in the Portals for Engineers, Students, and Math Educators

inutes to complete

How to Get Started
Entering Math

Putting Your ldeas Together

Combining Text and Math
Solving Equations
Expressions, Functions, and Procedures

bl

How do l...

—.enter a simple expression?
..enter a function?

L.Bnter a matrix?
~.evaluate an expression?
L.plot a function?

Commands and Packages

Using Top Commands and Packages
Getting Help

Plotting

2-0 and 3-D Plots
Using the Plot Builder Assistant

Werking with Matrices

Creating Matrices and Yectors

Data Structures

including lists and Arrays

Data Manipulatien

Importing and Exporting Data
Rancdom Distributions
Statistics, Regression, and Curve Fitting

Tools and Features

Learn rore about Maple's tools and features, such as palettes and contesxt-
sensitive menus

Palettes

Context-Sensitive Menus

Cornrnand Completion

Eguation Labels

Assistants

Maple Help

FPlotting Guide

Applications
Example Worksheets

Word Processing Teels

Sections and Tables
Docurment Enhancements

Dynamic Applications

Exploration Assistant
Expression Plotting
Interactive Circle Plotting

Manuals

Pertals for...

Engineers —

Math Educators
Units Working with Units

_I Customizing Unit Settings ma_ v v _I;I
5 0

Memery: - Time: - Text Mode

Obrdzek 1.9: Maple Portal (pfevzato z [5]).

niho menu (Tools > Assistants nebo Tools > Tutors anebo Tools > Tasks). Pomocnici
(Assistants) obsahuji naptiklad néstroje pro hledani funkéni zavislosti v datech, optimalizaci
funkci, feseni diferencidlnich rovnic a dalsi. Pro dany typ tlohy maji implementovano né-
kolik casto pouzivanych algoritmi. Po vyvolani provedou uzivatele nastavenim a specifikaci
parametri tlohy a zvolenou metodou tlohu vyfesi. Instruktori ( Tutors) provedou uZivatele
fegenou problematikou pomoci jednoduchych nazornych ptikladt. Ulohy (Tasks) zobrazuji
na piikladech, jak Fesit rizné tlohy. Zobrazi se vyvolanim z hlavniho menu (Tools > Tasks
> Browse) [5].

1.3.5 Prikaz ? (otaznik)

Symbol ? (otaznik) je dal$im ze zpusobu zobrazeni napovédy. Zapsanim a provedenim pii-
kazu ? otevieme hlavni stranku napovédy. Otaznik spolu s nazvem pfikazu otevie napovédu
na strance tykajici se zadaného prikazu. Tedy napt. prikaz 7evalf otevie hlavni napovédu
systému na strance popisujici syntaxi a sémantiku ptfikazu evalf spolu s priklady jeho pou-
ziti. Zapsanim dvou otaznikd na zacatek prikazu otevieme tutéz stranku napovédy ve ,sba-
leném* tvaru osnovy, v niz je mozné oteviit (odkryt) libovolné ¢asti. Zadanim tii otazniki
pted ptikaz otevieme napovédu na piikladech pouziti tohoto ptikazu [5].

Oteviit napovédu na strance zadaného piikazu (resp. klicového slova) mizeme téz stisk-
nutim klavesy F2 (za pfitomnosti kurzoru na kli¢ovém slové).

Priklad 1.7: Zjistéte, k ¢emu slouzi piikaz sum a jak se pouziva.

Priklad 1.8: Zjistéte, jak je mozné v systému Maple pracovat s vektory a maticemi.
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1.4 Provadéni vypoctu

Maple provadi pfesné numerické vypocty s celymi, racionalnimi i iraciondlnimi ¢isly. Kazdy
zadany matematicky vyraz se snazi zjednodusit (napi. zlomek zkratit a prevést na zakladni
tvar, upravit algebraicky vyraz, ...), ale ne za cenu ztraty presnosti. To znamend, Ze napfi-
klad racionélni ¢isla (zlomky) udrzuje stale v jejich zdkladnim tvaru. Podobné s konstantami
7, e a dal$imi, s odmocninami a jinymi vyrazy pracuje jako se symboly. Timto je zarucena
absolutni pfesnost vypoctu i v pfipadé, kdy nepracujeme pouze s celymi ¢isly [5].

Jsou vsak situace, kdy potfebujeme znat ptibliznou hodnotu realného nebo racionalniho
¢isla v pohyblivé radové carce. K tomu slouzi prikaz evalf, jenz vrati zaokrouhlenou hod-
notu svého argumentu na pocet platnych cifer mantisy specifikovany systémovou proménnou
Digits. Ta je standardné nastavena na hodnotu 10. VSechny vypocty, pfi nichz je nutné za-
okrouhlovat ¢isla, provadi proto Maple s presnosti na 10 platnych mist. Proménnou Digits
miizeme nastavit na takika libovolné pfirozené cislo. Omezeni, jak vysoké toto ¢islo mize
byt, zjistime piikazem kernelopts(maxdigits). Pro pfedstavu uvedme, Ze pro Maple 14 je
toto Cislo 268 435 448, tedy vice nez 268 miliont platnych cifer, s kterymi dokaze systém
teoreticky“® poéitat [5].

Pi

i
Digits

10
evalf (Pi)

3.141392654
evalf (P1, 5)
3.1416
evalf (Pi, 20)
3.1415926535897932385

Obrdazek 1.10: Piikaz evalf (pfevzato z [5]).

Aniz bychom ménili nastaveni proménné Digits, miZzeme zobrazit libovolny vyraz s poza-
dovanou presnosti pouze pomoci piikazu evalf. Prikaz je mozné pouzit s jednim nebo dvéma
parametry. Jediny zadany parametr znamena, ze tento zadany vyraz bude vyhodnocen na
pocet platnych mist specifikovany v proménné Digits. Pfidany druhy parametr fekne funkeci
evalf, na kolik platnych mist ma vyraz vyhodnotit, viz piiklady na obrazku 1.10 [5].

Maple rozeznavéa presnd ¢isla (mezi néz patii i zminéné symboly 7 a e, zlomky atp.)
a Cisla typu Floating-Point, nebo-li ¢isla v pohyblivé fadové carce. Jestlize systému zadame
vyraz, v némz néktery z jeho podvyrazi bude typu Floating-Point, mize Maple na cely
vyraz pohlizet jako by byl tohoto typu a bude vysledky vypoctt zaokrouhlovat. To nejlépe
uvidime na dalsich ptikladech na obrazku 1.11 [5].

1.4.1 Prikazy

Pro provedeni vypoc¢tu méame zpravidla vice moznosti. Tou zakladni, ktera je k dispozici ve
vsSech verzich systému, jsou ptikazy jazyka Maple. Chceme-li naptiklad vypocitat odmocninu

8Vypodet se s rostoucim poctem platnych mist prodluzuje a je pamétové naroénéjsi, coz zpiisobuje prak-
tickou nepouzitelnost pro vyssi pocet (zavisly na typu tlohy) cifer.
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2 3 13
3Y27%

, ale % + 1.5 =2.166666667

J2+Y3=J2 + /3, ale J2.0 +/3 =1.414213562 + /3

Obrdzek 1.11: Presna ¢isla a ¢isla typu Floating-Point (pfevzato z [5]).

z Cisla 2,5, zapiSeme v systému Maple prikaz sqrt (2.5). Stejného vysledku dosahneme pou-
zitim symbolu pro odmocninu z palety Expression. Pokud chceme urcit nejmensi spole¢ny
nasobek ¢isel 10, 12 a 15, mtzeme vyuzit piikazu lcm, nebo zapsat ¢isla na fadek za sebe
(oddélend ¢arkami) a pres pravé tlacitko mysi zvolit z kontextové nabidky Apply Function
> Least Common Multiple, viz obrazky 1.12, 1.13 [5].

10,12, 15
Uk Chrl
(e uyts el
Copty full predision
Copy as MathML
Paste ChrlH-y

Evaluate
Evaluate and Display Inline Ctri+=
Explore

apply Function Greatest Common Divisor

Apply a Command
Dok Product
Map Command Cnko

Least Common Multiple

Select Element b
Simplify »
Conskructions ]
Canversians ]
Floks 3
2-D Math b
Table »

Obrazek 1.12: Provedeni vypoctu pomoci kontextové nabidky (pfevzato z [5]).

Priklad 1.9: Zobrazte Cislo 7 s pfesnosti na pét desetinnych mist.

Re$eni: Pro zobrazeni ptiblizné (zaokrouhlené) hodnoty s poZadovanou presnosti vy-
uzivame piikazu evalf. Funkci evalf dame jako prvni argument vyraz, jehoz pribliznou
hodnotu chceme uré¢it (tj. 7). Druhy argument bude specifikovat pocet platnych mist. Jeli-
koz chceme, aby pocet desetinnych mist byl roven péti, pocet platnych mist nastavime na 6.
Ziskame tak vysledek na obrazku 1.14.

Priklad 1.10: Zobrazte Eulerovo ¢islo s presnosti na dvé desetinnd mista.

Priklad 1.11: Vypoditejte, kolik je 1 — 33 — £2 — 23, Pro¢ neni vysledek roven 07



sqrt(2.5) = 1.581138830
J2.5 =1.581138830
lem (10,12, 15) =60

integer lcm

10,12, 15 ——— 60

Obrdzek 1.13: Rtzné moznosti provedeni vypoctu (pievzato z [5]).

evalf (T, 6) = 3.14159

Obrdzek 1.14: ReSeni piikladu 1.9.

1.4.2 Oznaceni vysledku

Kazdému zobrazenému vysledku se v zapisniku prirazuje ¢iselné oznaceni, které se zapisuje
zcela vpravo na fadek s odpovidajicim vysledkem. Oznaceni je mozné potlacit (tj. nezobra-
zovat), znovu vyvolat, pfipadné upravit jeho formét v hlavnim menu (Format > Equation
Labels > ...). Diky oznaceni se miZzeme na piedeslé vysledky odvolédvat a pouzivat je
pii tvorbé dalsich piikazt. V ukézkach vytvorenych dokumentt (prezentovanych v tomto
textu) je oznaceni vysledki vzdy potlaceno. PouZiti oznaceni ilustruje obrazek 1.15.

2
36
_18 a
3
8-3
24 2
5—n
5—m 3
10 + @)
34 )

Obrdzek 1.15: Oznaceni vysledku (pfevzato z [5]).

Pokud chceme napiiklad pric¢ist ¢islo 10 k vysledku s oznadenim (2), pak napiseme ,10
+ “ a pres klavesovou zkratku ,Ctrl + L vlozime pozadované oznaceni (tedy do ,vyska-
kujiciho okénka“ zadame ¢islo 2 a potvrdime (OK)). Misto klavesové zkratky ,,Ctrl + L¢
je mozné pouzit horni menu (Insert > Label...). Pozor, zépis (2) vytvofeny (pouze) na
klavesnici pfi tvorbé piikazu Maple nepochopi, pro vlozeni oznaceni do prikazu je tfeba
disledné pouzivat predesly postup s ,vyskakujicim okénkem® zobrazenym na obrazku 1.16
[5].

Maple déale nabizi moznost odkazovat se na posledni tii vysledky (v tomto pfipadé je
jedno, zda byly zobrazeny ¢i nikoliv, a zda maji né&jaké oznaceni) pomoci symbolu % (pro-
cento). Jedno procento (%) predstavuje posledni vysledek, dvé procenta (%%) predposledni
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Insert Label x|

Type: IEquatiu:un j

Identifier: I

(o] 4 Cancel |

Obrdazek 1.16: ,Vyskakujici okénko“ pro zadani oznaceni (pfevzato z [5]).

a tii procenta (%%%) pred-predposledni. Upozornéme, Ze vysledek ziskany témito ptikazy za-
visi na potradi vykonanych pfikazi, ne na jejich umisténi v zapisniku! Tedy napft. % vypiSe
posledni vysledek ziskany pfedchozim (¢asové) vykonanym piikazem (obrazek 1.17).

2
—+3
3 +
17
3
83
24
S—m
5—mn
%, %o, W%
17
5—m, 24, —
JT'? El 3

Obrazek 1.17: Vyuziti procent pfi odkazovani se na predchozi vysledky (pfevzato z [5]).

1.4.3 Prirazeni hodnot do proménnych

Odkazovat se na vyrazy mizeme také po jejich prifazeni k néjaké proménné. Operatorem
ptifazeni je (dvoj)symbol := (dvojtecka + rovnitko).

Namisto (dvoj)symbolu := muzeme k pfifazeni pouzit piikaz assign. Tak, jak muZzeme
vyrazy do proménnych piitazovat, mizeme téz pfifazeni zrusit (tj. odebrat proménné ulo-
zenou hodnotu). Zminéné provedeme piikazem unassign nebo pfifazenim nézvu proménné
v apostrofech (obrazek 1.18).

Pritazovat hodnoty miizeme i do tzv. systémovych proménnych. Jiz jsme se setkali s pro-
ménnou Digits vyjadiujici pocet platnych mist, s nimiz Maple pocita. Ilustraci na ob-
razku 1.19 mtzeme srovnat s obrazkem 1.10.

Odstranit ulozenou hodnotu v systémové proménné nelze. Do systémovych proménnych
miizeme hodnoty pouze prifazovat, nebo vratit prikazem restart nastaveni vSech systémo-
vych proménnych na jejich piivodni hodnoty. Provedeni ptikazu odstrani vSechny ulozené
hodnoty v paméti (tedy i ndmi definované proménné, nactené baliky atd.). Ptikaz restart
se proto pouziva zpravidla na poc¢atku feseni nové tlohy, zejména pak na zacatku kazdé prace
se zapisnikem (aby se pfedeslo tomu, Ze budeme pouzivat proménnou, v niz je z diivéjska
uloZena pro nas nespravna hodnota) [5].
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a o
a ¢
a =2 assign(e, 2)
2 c
a 2
2 wnassign('c')
e
b c
b a
bi=3-a 2
6 o i="aq'
b a
6 a
a

Obrdzek 1.18: Piitazeni hodnot do proménnych a odstranéni ulozené hodnoty (prevzato z [5]).

Pi

N
Digits

10
evalf (P1)

3.141592654

Digits == 3

5
evalf (P1)

3.1416

Digits == 20

20
evalf (Pi)

3.1415926535897932385

Obrdzek 1.19: Proménnd Digits a ptikaz evalf (prevzato z [5]).

1.4.4 Baliky

Knihovna piikazt jazyka Maple je rozdélena na hlavni knihovnu a tzv. baliky®. Piikazy, s ni-
miz jsme se doposud setkali, patfi do hlavni knihovny, a miizeme je tak pouzivat ihned po
spusténi systému. Naproti tomu vétsina specidlnich prikazt nalezi do baliki, které musime
pred pouzitim piislusného prikazu bud nacist do dokumentu pomoci piikazu with, nebo za-
dat pfikaz spolu s nazvem baliku. Nacteni baliku pomoci pfikazu with umozni pouzivani
vsech ptikazi z prislusného baliku. Naopak zadani ptikazu spolu s nazvem baliku je nutné
provadét pii kazdém pouziti tohoto piikazu, pokud balik nenac¢teme (piikazem with).

Nacteni baliku mtizeme zrusit prikazem unwith. Pokud balik nenacteme a pouzijeme
z né&j néjaky prikaz, Maple jej nerozpozna a prikaz vypise jako textovy retézec. Naptiklad
prikazy pro praci s vektory a maticemi nalezi do baliku LinearAlgebra. Jestlize chceme
tedy pouzit pfikaz Eigenvalues pro nalezeni vlastnich ¢isel matice, na¢teme nejprve balik
LinearAlgebra, jak dokumentuje obrazek 1.20 [5].

9Kromé pojmu balik se v ¢esting pouziva také termin knihovna.
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-2 1 -1

Matice:=| 1 -1 0
-1 0 -1
-2 1-1
1-1 0
-1 0-1
with ( LinearAlgebra) :
Eigenvalues( Matice)
0
-1
-3
unwith( LinearAlgebra)
Eigenvalues( Matice)
-2 1-1
Eigenvalues 1-1 0
-1 0 -1

LinearAlgebra| Eigenvalues| ( Matice)
0
-1
-3

Obrazek 1.20: Pouziti baliku.

Jednim z vyznamnych balikt je balik s ndzvem RealDomain. Systém Maple pracuje s
komplexnimi ¢isly a pravé balik RealDomain umoznuje omezit se pouze na mnozinu realnych
cisel’® (obrazek 1.21).

simplify(\/x* )
1

(-8)°

Soh’e(xs +x, xc)

In(-1)

with( RealDomain) :
csgn(x) x Sfmpi’;ﬁ'(ni ¥ )
Ix]
1
/ 3
(-8)"7 (-8)
-2
0.1 -1 Sofve(x3 +x x)
n 0
In In(-1)
undefined

Obrazek 1.21: Pouziti baliku RealDomain.

10Uplny seznam piipadii (resp. piikazii), v nichZ se miizeme pomoci tohoto baliku omezit jen

¢isla, nalezneme v ndpovédé k baliku RealDomain
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Jednotky

Praci s jednotkami umoznuje balik Units. Pfi vypoctech tak nemusime pracovat jen s ¢isly,
ale mizeme jim pritazovat i jednotky. K vlozeni jednotek do zapisniku vyuzijeme palety
Units. Obrazek 1.22 ilustruje pouziti jednotek pfi vypoctu gravitacni sily piisobici v tthovém
poli Zemé (kde gravita¢ni zrychleni je pfiblizné rovno 9,81 ms~2) na téleso o hmotnosti
10 kg. Vidime, ze Maple umi jednotky také zjednoduSovat (resp. upravovat na jiny tvar).
Ke zjednoduseni vyrazi pfitom slouzi piikaz simplify.

Fi= 10[[;@]]-9.31%
98.10 [[kg] =1
[s]?

simplify (%)
98.10 [V]

Obrdazek 1.22: Pouziti jednotek (prevzato z [5]).

Maple rozpoznava jednotky riznych soustav a velikosti, s nimiz umi pracovat a vzajemné
je prevadét. Pro prevod jednotek je k dispozici specialni nastroj zvany Units Calculator.
Spustit jej mizeme z hlavniho menu pies Tools > Assistants > Units Calculator....
Ukazku poskytuje obrazek 1.23.

Pokud chceme pouzit jednotku, ktera neni v paleté Units, mtzeme si ji vytvorit sami
tak, ze priddme jednotku s ndzvem unit a nazev prepiSeme. V systému Maple 14 je imple-
mentovano pres 500 jednotek (tzn. v paleté Units je pouze nékolik vybranych) [5].

-
HIIIIIBSOft Units Calculator

— -

Convert between over 500 units of measurement. See Units help index for details.

First, select a dimension from the drop-down box. Then select the units to convert from and to.
Click the "Perform Unit Conversion" button. The "Convert Back" button converts in the
opposite direction.

Convert; I*° Result: |2-048000000
From: [feet (f0) =] To: |meters (m) ~|
Dimension: length =l

Perform Unit Conversion | Convert Back |

Obrdzek 1.23: Units Calculator (prevzato z [5]).

1.4.5 Reseni rovnic

K feseni rovnic v systému Maple slouzi piikaz solve a nékolik piikazti k nému piibuznych
zavislych na typech rovnic, viz tabulka 1.1.
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Tabulka 1.1: Piikazy pro feSeni rovnic

Typ rovnice

Piikaz pro reseni

Rovnice a nerovnice

solve, fsolve

Obycejné diferencialni rovnice dsolve
Parcialni diferencialni rovnice pdsolve
Rovnice v oboru celych ¢isel isolve
Rovnice v oboru celych ¢isel v konec¢ném télese | msolve
Linearni integralni rovnice intsolve

Systémy linearnich rovnic

LinearAlgebra[LinearSolve]

Rekurentni rovnice

rsolve

Pomoci interaktivniho prosttedi Standard Worksheet mtzeme Tesit rovnice téz pomoci
kontextové nabidky. Zapiseme rovnici a pravym tlacitkem mysi zvolime pozadovany piikaz.
Obrazek 1.24 ilustruje nékteré priklady Feseni rovnic.

Ptikazy pro feseni rovnic nemusi vzdy zobrazit vSechna feSeni. Pokud je chceme zobrazit,

pridame piikazu solve nepovinny parametr Al1Solutions, viz obrazek 1.25 [5].

Rovnice

Soive(xz +35-x+ 6=0)
-2, -3

solve

S+ 6=0—"5 [x=-2}, {x=-3}

Nerovnice
Soive(xz +35x+6< 0)

solve

WS+ 6 <05 (-3 <y, x< -2}

Rekurenini rovnice

N(t+1)=(14+a—b) N(t), N(0) =MD

Diferencialni rovnice

di

RealRange(COpen( -3 ), CGpen(-2))

realve({M(t+1)=(1+a—5&)- N(z), N(0) =MD}, M(x))
MO (1+a—5)

S0lVE TECUTTENCE
bk bilebinctt

dsozue[ [im:) = (@ — b)-N(t), N(0) =NEJU

d:
N(t)=np !
iN(r) = (a—b)-N(t), N(0) = Np—Lr=DE

MO (14 a—b)

Nl{t} = I c[a—b)r

Obrazek 1.24: Ukazka feseni riznych druhti rovnic pouzitim jednak ptikazu, jednak kontextové

nabidky (pfevzato z [5]).

Symbol _Z2~ na obrazku 1.25 predstavuje libovolnou celoéiselnou proménnou. Ze jde o ce-
lo¢iselnou proménnou pozname podle toho, ze se v symbolu vyskytuje pismeno Z. Podobné
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solve (sin(x) =cos(x))

R
4

solve (sin(x) = cos (x), AllSolutions )

1

St 72~
about( _Z2)

originally ZZ, renamed EZ-~:
iz assumed to be: integer

list assurmnptions

Fl———————— { F2~uinteger}

Obrdazek 1.25: Zobrazeni vSech FeSeni rovnice (pfevzato z [5]).

by vyskyt naptiklad pismena C znacil proménnou komplexni. Cifra 2 v symbolu proménné
oznacuje poradi, v jakém byla proménnd v zépisniku zavedena. A nakonec znak ~ vyja-
diuje, ze proménna spliuje néjaky predpoklad. Jaké predpoklady proménna spliiuje pritom
zjistime prikazem about, pripadné zapisem proménné a po kliknuti pravym tlacitkem mysi
zvolenim What Assumptions z kontextové nabidky. V zobrazeném ptikladu na obrazku
1.25 je predpoklad celociselnosti (u jiz celoéiselné) proménné prebytecny.

Daéle muze prikaz solve zobrazit vysledek se strukturou Root0f vyjadiujici kofen (tj. fe-
Seni) rovnice v nevyhodnoceném tvaru. Reseni pak vyhodnotime bud piikazem allvalues
(pro symbolické vyjadieni), nebo piikazem evalf (pro numerické vyjadieni) — obrazek 1.26.
Vedle prikazii mizeme téz vyuzit pravého tlacitka mysi, zvolit z kontextové nabidky polozku
All Values (pro symbolické vyjadieni) a ziskany vysledek pfevést na numerickou hodnotu
zvolenim Approximate > 10 (pro 10 platnych mist) z kontextové nabidky.

Sofve(x4 —2:0+ 2=0)
RoorOf[_Z4 -2 _23 + 2, index = 1), ROOIOf[_Z4 -2 _2'3 + 2, index =2),
Rc:nc:nrt’__)f(_Z4 -2 _23 + 2, index =3 ), Jf?ooer(_Z’4 -2 _2'3 + 2, index =4)

allvalues({%})

1 1 1 1 1 1 1,1
e I- 4421, = =1+ = Ja+21, =+ =1
2 R T N N R S
1 1,1 1
-~ =Ja-21, =+ I+ J4-21
2V 2 Tt

evalf (%)
{-0.5290855140 — 0.7429341359 I, - 0.5290855140 + 0.7429341359 1,

1.529085514 — 0.2570658641 I, 1.529085514 + 0.2570658641 1}

Obrdzek 1.26: Tvar zobrazeni feSeni rovnice (pfevzato z [5]).

Symboly _Z ve struktufe Root0f nyni nepfedstavuji celo¢iselnou proménnou (nebot za
pismenem Z nendsleduje ¢islo), nybrz proménnou libovolnou (tj. i komplexni).

Systém Maple po zadani piikazu vypise zpravidla pouze TesSeni, pripadné chybova hlaseni
¢i varovani. U piikazu solve (a nejen u néj) toto chovani zpusobuje ,prazdny vypis“ v pfi-
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Soﬁve(x2 < 0)
infolevel [salve] =1

SOJE‘LJE'(XZ < 0)
solve: Warning: no solutions found

Obrdzek 1.27: Proménnd infolevel a ,prazdny vypis“ pfikazu solve (pfevzato z [5]).

solve({x +y=2,x—y=0})

{x=1,y=1}
infolevel [ salve] =1
golve({x +y=2,x—p=0})
Linear: # equations 2

{x=1,y=1}

infolevel [salve] =3 :

solve({x +y=2,x—p=0})

Linear: # equations 2

Rational: # equations 2

Rational: 2 equations solwved, rank: 2

{x=1y=1}

infolevel [ salve] == 5:

solve({x +y=2,x—p=0})

Linear: # equations 2

Rational: # equations 2

Rational: # equations 1

Rational: # equations 0O

Rational: backsubstitution at: 2
Rational: backsubstitution at: 1
Rational: 2 equations solwved, rank: 2

{x=1y=1}

Obrdzek 1.28: Proménnd infolevel a priikaz solve (pfevzato z [5]).

padé, ze Maple zadné TeSeni nenasel. Pro vypis podrobnéjsich informaci o priibéhu vyhod-
noceni piikazu a vysledcich slouzi proménné infolevel. Mtzeme ji nastavit bud pro kazdy
prikaz samostatné, pricemz do hranatych zavorek za proménnou vlozime nézev prislusného
prikazu, nebo ji nastavime vSem prikaztim soucasné na stejnou hodnotu uvedenim slova
all do hranatych zavorek. Proménné miize nabyvat hodnot 1, 2, ..., 5. Cim vys§ hodnota
je prifazena v proménné infolevel, tim vice informaci o vyhodnoceni pfikazu obdrzime.
Standardné neni proménna nastavena na zadnou hodnotu, coz v podstaté odpovida nasta-
veni proménné na hodnotu 0. Pouziti proménné infolevel dokumentuji obrazky 1.27 a 1.28

[5]-

Priklad 1.12: Reste nerovnici: |z — 2| < 1 pro x € R.
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Reseni: Pro feSeni nerovnice pouzijeme piikaz solve.

solve(|x —2| < 1)
RealRange( Open(1), Open(3))

Obrdzek 1.29: Reseni prikladu 1.12.

Ziskany vysledek odpovidé zépisu x € (1,3). Vyraz RealRange znaci redlny interval,
vyraz Open(1) vyjadfuje otevieny interval (v bodé 1). Pokud bychom zadali argument pii-
kazu solve do slozenych zavorek (tj. solve ({|1x-2]<1})), ziskali bychom vysledek ve tvaru
nerovnosti.

Priklad 1.13: Reste nerovnici [z — 2| < 1 pro z € Z.
Priklad 1.14: Reste nerovnici |z — 2| > 1 pro = € Z.
Piiklad 1.15: Uréete kofeny polynomu 23 — 3 - 22 — 13 -2 + 15 pro z € R.
Reseni: Kofeny polynomu miizeme uréit réiznymi zptisoby. Jednak je mozné pouzit pifkaz

solve a hledat body, v nichz je polynom nulovy. Systém Maple nabizi téz ptikaz roots pro
hledani kofenti polynomu jedné proménné. Oba postupy ilustruje obrazek 1.30.

Joh’e(xa —32 —13.x+ 15=O)
5,1,-3
}'oozs(xg —3 - 13-x+ 15)
[[]-e 1]% [Sf 1:|f [ -3, 1]]

Obrdzek 1.30: Reseni piikladu 1.15.

Vystup prikazu roots je tvoren seznamem dvojic. Kazda dvojice obsahuje hodnotu ko-
fenu a jeho nasobnost.

P#iklad 1.16: Reste nerovnici x < 22 —12<4-x pro x € R.

Piiklad 1.17: Urdete obecné koieny kvadratického polynomu tvaru a - 22 + b - x + ¢ pro
a € R\ {0},b € R, c € R,z € C. Zamyslete se, jak byste v feseni postupovali, kdybychom
povolili moznost a = 0 a x omezili jen na realna cisla.

Piiklad 1.18: Reste rovnici tan(z) = v/3 pro z € R.

P#iklad 1.19: Reste soustavu rovnic
S-x—T-y=-9,
3-x+y=>5

prox € R,y € R.
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2 Matematicka analyza s Maple v R

2.1 Vyrazy a jejich upravy

2.1.1 Zjednoduseni vyrazu

Ke zjednoduSeni vyrazu slouzi predevsim piikazy simplify, normal a combine. Piikaz
simplify provadi zakladni zjednoduseni zadaného vyrazu, pfikaz normal je urcen pro upravy
zlomki a ptikaz combine slucuje vyrazy. Vybrané priklady pouziti mtizeme pozorovat na ob-
razku 2.1.

X x—2y
Iifv
ﬂmplﬁ[ x+2y i 2 —4y J
x+1
x4+ 2y
Slmpféﬁ/{ Cb +1ﬂr€:] )
de
1 X
mal | —
Hmma[ . +x+1 ]
x+1 +Jr2
x(x+1)
normaf[i +— expanded
x x+1 P
x+1 +Jr2
x2 +x
Combme(esin(a)-cos(b).ccos(a)-sin(.?;))
sin(a+b)
€
combine(2-sin(x) -cos(x) )
sin( 2 x)

Obrdzek 2.1: Zjednodusovani vyrazi.

2.1.2 Omezujici podminky

Priikazu simplify (stejné jako ostatnim piikazim) mtZeme doplnit omezujici podminky
(resp. predpoklady), které budou aplikovany pifi zjednodusovani zadaného vyrazu. Prove-
deme to bud pfidanim druhého parametru assume = podminka, nebo zapisem assuming
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podminka za piikaz simplify. Jako druhy parametr mizeme uvést také mnozinu omezuji-
cich rovnosti. Konkrétni ptiklady vidime na obrazku 2.2.

simplify( )

Simpf;ﬁ'( \/xc_z assume= reaf)

esgn(x) x

I

Simpfgﬁ'( \/? , assume = posz’rfve)

o 2 i
simplifv\ || X~ , assume = negative

Simpfgﬁ'(\/?) assuming x :: real

Simpfgf}'(‘.f ¥ ) assuming x :: positive
Simpfg'fy( (-1 }Z) assuTing z 1 even

Simpfgﬁ'( (-1 }2) assuming z :: odd
-1

vi=x+6r+5x+4u—2r—9x-y+12
6x+4r+4u—9xy+12
Simpfgfv(v: {x=2,}'=3:u=1})
40 — 18y

Obrazek 2.2: Zjednodusovani vyrazu — dalsi moznosti pfikazu simplify.

2.1.3 Uprava polynomu

Ptredevsim pro tpravy polynomt mame k dispozici ptrikazy collect, coeff, sort, factor
a expand, jejichz pouziti shrnuje tabulka 2.1 a na prikladech dokumentuji obrazky 2.3, 2.4.

Tabulka 2.1: Prikazy pro tpravy pfedevsim polynomi
Prikaz | Pouziti
collect | vytykani ve vyrazech (nejen polynomech)
coeff koeficient u zvoleného ¢lenu polynomu
sort setfidéni ¢lenti polynomu (nebo prvki seznamu)
factor | rozklad polynomu na soucin kofenovych Ciniteli
expand | roznasobeni / rozvinuti (nejen u polynomi)

2.1.4 Prevod vyrazu na jiny tvar

Zéavérem této sekce zminime velmi univerzalni prikaz convert. S jeho pomoci miizeme pfe-
vadét zadany vyraz (pfipadné jinou datovou strukturu jako nap¥. seznam) na jiny (zvoleny)
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a-In(x) -ln(x) x —x
aln(x) —Iln(x)x—x
collect( %, In(x) )
(a—x)In(x) —x
collect(a +a-\[3 ,a)
(1+V3)a

py=2"—8 X +23x" +68 X —244- " — 224 x +384:

caeﬁ(pl_. X, 4)
23
caeﬁ(pl_. x, 1 )
-224
caeﬁ(pl_. X, O)
384

SOP‘I(]. +x +3 372 —4-:{4)
~4x X 3041
SOP‘I(l +X +3x2— 4-x4: x, tdeg, a.sceﬂdmg)
1+3_7cz+:153—4::(4

Obrazek 2.3: Pouziti pirikazi collect, coeff a sort.

6 5 4 3 2
pafl =x —8-x +23-x +68-x —244.-x —124.- x+ 384
6 5 4 3 2
x —8x +23x +68x —244x —224x+ 384
pol, ==x' — 6% +22.X — 48-x + 40
4 3 2
x —6x +22x —48x+ 40

5, :Zfacmr(poi’l}
(x—1) (x=3) (¥ —=8x+32) (x+2)°
5, :Zfacmr(pafz}

(=]

(¥ —2x+10) (x—2)

expand(.sl)
6 5 4 3 2
x —8x +23x +68x —244x —224x+ 384
expand(.sj)
4 3 2
x —6x +22x —48x+40

Obrdzek 2.4: Pouziti ptikaz factor a expand.

tvar!. Obrazky 2.5 a 2.6 ukazuji pouzZiti pfikazu pro pfevod desetinného &isla na zlomek (pfi-

1 Jelikoz mé piikaz convert mnoho riiznych pouziti, doporuc¢ujeme étenéii podivat se na stranku napovédy
k tomuto piikazu (viz ?convert).
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dévame parametr rational) a pro prevod vyrazu na parcialni zlomky (pfidavdme parametr
parfrac?).

convert(0.125, rarional )
1
8
convert( 12.567, rational )
12567
1000
convert(0.33333333, rational )
33333333
100000000
ALE POZOR!!! (za desetinou te¢kou je 10 "trojek™)
convert(0.3333333333, rational )
1
3
_ (xs + 1)
f=13 2
(" =)
41
1 2
X =X
convert( f, parfrac)
1 1
x—— +
¥ x—1
X
= —X
(x-b)
X
(x—=1Db)
convert( f, parfrac, x)
1 . + b i
v=b " (x—p)
convert( f, parfrac, b)
X
2
(-x+5)

Obrazek 2.5: Pouziti ptikazu convert.

Jak jsme jiz vidéli, v prostiedi Standard Worksheet je obvykle vice moznosti, jak Tesit
danou ulohu. U vySe uvedenych piikladi (na obrazcich 2.1 — 2.6) je mozné vyuzit také
kontextové nabidky. Do dokumentu vlozime vyraz, ktery chceme upravovat, klikneme na
néj pravym tlacitkem mysi a z kontextové nabidky zvolime pozadovany piikaz (¢asto i s
upfesnénim pozadované tpravy, tj. napt. vybereme Simplify>Simplify nebo Combine>exp
¢i Simplify>Assuming Real atp.). Timto zpisobem miizeme obdrzet napiiklad vysledky
na obrazku 2.7.

2Symbol I v systému Maple znaci imagonarni jednotku.
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(4. —6-22—2)

fi=—
(' —2-¥ —2-x+4)
4% —6x" —2
X —2x —2x+4
convert( f., parfrac)
,
3x 1
3 + 2
x —2 Xr—=-

convert( f, parfrac, real)
1.01 i 1.27+2.00x 0.992
x—2 ¥ 11259921050 x + 1.587401052 X — 1.259921050
convert( f, parfrac, complex)
0.980 + 0.003341 0.999 + 0.00528 1 1.00 — 0.002941 1.02 — 0.005681
x—2. x+0630—1091 x+0.630+1.091 -1.26 +x

Obrdzek 2.6: Moznosti piikazu convert pfi rozkladu vyrazu na parcidlni zlomky.

X + x—2y simplify x4+ 1
x+2y 2 gyl x+2y
L'l‘ X normal .7C+1+.‘!C2
x x+1 x(x+1)

esin(a) rcos(b) E:cos(a) -sin(b) combing esin[a) cos(b) + cos(a) sin( &) combing esin(a +5)
3 assuming real
g EEEE
lect
a-ln(x) -ln(x) x —x“=% (@ —x) In(x) —x

=8 231 68 1 —244- % — 224 x + 38428 (x— 1) (x—3) (P —8x+32) (x+2)

2

d z :
(x—1) (x—3) (® —8x+32) (x+2)2"E" P —8x +23x" +68x — 24457 — 224 x + 384
0.125 convert to rational 1
o Lo * 8
X convert to partial fractions inx b + 1
(x=b)* (x—b)*  x—b

Obrazek 2.7: Zjednodusovani vyrazi pomoci kontextové nabidky.
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Priklad 2.1: Urcete hodnotu vyrazu % prob=16,z =9,y = 3.

Reseni: Pro vyfeseni mame vice moznosti. Pouzijme nejprve pifkaz simplify podobné
jako na obrazku 2.2. Mize se stat, ze prikaz neupravi ,najednou” zadany vyraz az na nej-
jednodussi tvar. V takovém piipadé (ktery pravé nyni nastane) jej pouzijeme dvakrat. Dalsi
moznosti je pouzit vyhodnocovaci ptrikaz eval.

simplify .x3 b {a-;:z-x) ,{b=16,x=9,y=3}
y
— 25
simplifv( %)
3
nebo
Sfmpfgﬁ'[simpfgﬁ'[ ‘x:—b . {a-;:z-x) \ {b=16:x=9,y=3}]]
.
3
&
.sfmpf;ﬁ'[evaf[ ‘x:—b Nax—bx) \ {b=16:x=9:y=3}]]
v a—bhb
3

Obrdzek 2.8: Regeni piikladu 2.1.

Priklad 2.2: Vytvofte polynom, ktery ma jeden trojnasobny kofen s hodnotou % a jeden
dvojnasobny s hodnotou —5. Necht je vysledny polynom v roznasobeném tvaru.

Resend: Polynomi spliiujicich zadani je nekoneéné mnoho, piipustime-li moznost mit
i dalsi kofeny. Kofeny jednozna¢né urcuji kofenové ¢initele polynomu. Polynom majici pouze
kofeny zminéné v zadani bude tvofeny t¥emi ¢initeli tvaru (z — 2) a dvéma tvaru (z — 5).
Roznasobeny tvar ziskdme prikazem expand.

3 2
expand[ [x— T) -(x-I-S)‘J
1

s 53 3 387
L 3_ 38 2 35— 8

|
Lh

X —

2 4 8

[e2a}

Obrdzek 2.9: Reseni prikladu 2.2.

Piiklad 2.3: Zjednoduste vyraz cos(n - 7) za predpokladu, zZe n je sudé.
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Priklad 2.4: Zjednoduste vyraz

Priklad 2.5: Zjednoduste vyraz

sin(2 - x) — cos(z)
cos(2-xz) — 1+ sin(x)

Priklad 2.6: RozloZte na soucin: 4 - 22 - (y? — 2%) +25-v - (22 — ¢?).
Priklad 2.7: Zjednoduste: (2-h+5-5)>—(2-h+5-5)-(2-h—5-3).

Priklad 2.8: Necht

pr=a"+15-21 48523 +225 - 2% + 274 -2+ 120, py=a’+6-x+8.
Zjednoduste %' Vysledek rozlozte na soucin kofenovych ciniteld. Vyraz z—j rozlozte na par-
cialni zlomky.

2.2 Funkce jedné proménné

2.2.1 Definice funkce

V prostiedi Standard Worksheet jsou 2 zptisoby, jak definovat funkci. Vytvorme naptiklad
funkci f(x) = 2% Prvni moznosti (k dispozici jen v prostiedi Standard Worksheet a pro
matematicky rezim Math Mode) je napsat funkéni pfedpis stejné, jak jsme to udélali pred
chvili, s tim rozdilem, Ze namisto rovnitka (,,=“) pouZijeme symbol pro pfifazeni (,:=*),
tedy f(x):=x"2. Po spusténi piikazu musime v nasledné zobrazeném vyskakujicim okénku
potvrdit, ze se jedna o definici funkce. Druhou moznosti (platnou i v jinych prostfedich
systému Maple), jak vytvorit funkci, je pouziti Sipkové notace. Ptikaz pak vypada nasledovné:
f :=x->x"2. Sipku vytvofime poml¢kou nasledovanou symbolem ,vétsf nez* (,>“).

V prostiedi Standard Worksheet si definovani funkce mtzeme ulehc¢it vyuzitim palet.
Bud je mozné pii vytvareni ptikazu pouzit Sipku z palety Arrows, nebo miZeme vzit celou
Sablonu prikazu vytvoreni funkce z palety Expression a modifikovat v ni pozadované sym-
boly. Funkéni hodnotu definované funkce v daném bodé ziskame zapisem nazvu funkce spolu
s hodnotami parametrii v zdvorce (nemusime pfitom zadévat pouze numerické hodnoty).

Dilezité je v Maple dtsledné rozlisovat funkce a vyrazy, lépe feceno funkéni operatory
a vyrazy. V matematice totiz uzivame pojem funkce i v ptipadech, které v Maple predstavuji
vyrazy (funkéni vyrazy — napt. f(x)). Jestlize vytvofime vyraz, napfiklad x~2, a pfitadime
jej k néjaké proménné, napr. g, jedna se stale pouze o vyraz. Hodnotu g pro x = 5 nemuzeme
proto urcit jako funkéni hodnotu v bodé 5, ale musime pouzit vyhodnocovaciho prikazu eval,
ptipadné do z pfifadit hodnotu 5. Naproti tomu funkéni hodnotu funkce f (nebo vhodnéji
feeno funkéniho operdtoru) v bodé 5 ziskdme specifikaci argumentu operatoru (funkce) f,
viz obrazek 2.11 [5].

Déle Maple nabizi piikaz unapply, ktery ze zadaného vyrazu udéla funkci (funkéni ope-
rator). Tento piikaz ma dva argumenty: vyraz, z néhoz chceme udélat funkci, a nezavisle
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f:zx—>x2

x—x
z(x) =¥

=%
£(5) _
z(5)
fla+b)

(a+b)’
z(3-¢)

O9¢

Obrdzek 2.10: Definice funkce v prostfedi Standard Worksheet.

fi=x— apply( 1, x)
x—+x£ X
o= xz
s 5 apply( 1. 5)
X 25
f(5)
23 unapply( g, x)
g(5) x>y
- 2
x(5)°
eval(g,x=75) unapply(g. x) (5)
- 25
X
X
x: =35
g
25
f(x)
25

Obrdzek 2.11: Rozdil mezi funkci a vyrazem (pievzato z [5] a doplnéno).

proménnou. Podobné méame k dispozici téz prikaz apply, ktery z funkéniho operatoru udeéla
vyraz (aplikuje funkéni operator na zadany argument /argumenty) — prava ¢ast obrazku 2.11.

Virazy a funkce miizeme téz definovat po ¢astech pomoci ptikazu piecewise. Argumenty
v zévorce urcuji vzdy nejprve interval nasledovany funkéni hodnotou na tomto intervalu. Po-
sledni mnozinu bodt jiz zapisovat nemusime, staci funkéni hodnota. Maple ji doplni ve zby-
vajici mnoziné zatim nedefinovanych bodi. Je mozné téz sestrojit funkcei, kterd je definovana
pouze na libovolné podmnoziné realnych ¢isel. Pokud ma funkce definovana po ¢astech pouze
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dva rizné predpisy, muzeme k jejimu vytvoreni vyuzit symbolu oteviené slozené zavorky
z palety Expression (viz obrazek 2.12) [5].

fi=x—piecewise(x < 0,-1,x=0,0,1)
x—piecewise(x < 0, -1,x=0,0,1)

f(-8)

-1
f(0)

0
£(153.6)

1

2 = x—piecewise (x < 0,-x, undefined )
x—plecewise (x < 0, —x, undefined)

2(-8)

8
72(4)

undefined
0 X< M
£(x) = 1 x>0
x%pl'ecewx'se{x <n 0,71 =z, 1)

£(0)

0
£(3)

0
£(4)

1

Obrdazek 2.12: Funkce definovana po ¢astech (pfevzato z [5]).

2.2.2 Vlastnosti funkci

Definice 2.1: Definicnim oborem funkce f nazyvame mnozinu vSech hodnot, pro néz je
funkce f definovana. Znacime ji D(f)3. Oborem hodnot funkce f nazyvdme mnozinu vsech
hodnot, kterych funkce f na svém definiénim oboru nabyva. Znacime ji H(f)*.

Definice 2.2: Funkce f se nazyva shora ohranicend, pokud existuje K € R tak, ze f(z) <
K pro vSechna z € D(f). Analogicky, funkce f se nazyvé zdola ohranicend, pokud existuje
L € R tak, ze f(x) > L pro vSechna x € D(f). Funkei f nazyvame ohranicenou (omezenou),
pokud je f ohranicena zdola i shora.

3V literatute je téz mozné se setkat s oznadenim Dom(f).
4V literatufe je téZ mozné se setkat s oznacenim I'm(f), ptipadné R(f).
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Definice 2.3: Funkce f se nazyva sudd, pokud pro vSechna x € D(f) plati, ze —x € D(f)
a f(x) = f(—x). Funkce f se nazyva lichd, pokud pro vSechna = € D(f) plati, ze —z € D(f)

a f(r) = —f(-x).

Definice 2.4: Necht M C D(f) obsahuje alespoti 2 body. Rekneme, Ze funkce f je na M
(a) rostouct, jestlize Vy,x9 € M : 11 < 3 = f(x1) < f(22),

(b) klesajici, jestlize Va1, 29 € M : 11 < x9 = f(x1) > f(x2),

(c) nerostouct, jestlize Vay,x9 € M : 21 < 9 = f(21) > f(x2),

(d) neklesagict, jestlize V1,29 € M : 11 < 29 = f(x1) < f(x2),

(e) konstantni, jestlize Vay,xo € M : f(x1) = f(x2).

Definice 2.5: Necht M C D(f) obsahuje alesponi 2 body. Rekneme, Ze funkce f je na M
(a) prostd (injektivni), jestlize V1,29 € M : 11 # x5 = f(x1) # f(22),

(b) zobrazenim na mnozinu N C H(f) (surjektivni), jestlize Vy € N : dx € M A f(x) =y,
(c) bijektivni z M do N, jestliZe je prostd na M a soucasné je zobrazenim na mnozinu N
(tedy injektivni a surjektivni).

Systém Maple neméa zadné piikazy na urcovani pravé definovanych vlastnosti. To vsak
neznamena, ze tyto vlastnosti nemtizeme urcovat sami. V nékterych pripadech ndm mitze
systém Maple pomoci.

I defini¢ni obor a obor hodnot funkce musime zjistit sami. Systém Maple miizeme efek-
tivné vyuzit pouze v pripadech, kdy si nejsme jisti, jestli dany bod patti do nékteré z mnozin,
a to bud pokusem o vyhodnoceni funkce v daném bodé nebo hleddanim feSeni rovnice, kdy
se uvazovana funkce rovna danému bodu.

Priklad 2.9: Urcete D(f) a H(f) funkce f(x) = In(x).

Resent: 7 ptednisky Matematické analyzy vime, ze D(f) = RY = {z € Rjz > 0}
a H(f) = R. Systém Maple bychom vyuzili asi jen v pfipadé, kdybychom si nebyli jisti, jak je
definovana funkce in(z) a chtéli se naptiklad presvédcit, ze neni definovana pro z = 0. V tom
pripadé bychom mohli zkusit ziskat funkéni hodnotu v bodé 0. Na obrazku 2.13 vidime, ze
obdrzime chybovou zpréavu, ktera je sice trochu matouci (zmifiovano je déleni nulou), nicméné
funkéni hodnota neexistuje. Podobné mizeme napiiklad ovéfit, ze 0 € H(f), feSenim rovnice
In(xz) = 0. Upozornéme, ze Maple pocita standardné s komplexnimi ¢isly, a tak vyhodnoceni
funkce In(x) pro zdporné x nezptusobi Zadnou chybu. JelikoZ se pohybujeme v oboru realnych
Cisel, je tfeba se omezit pouze na néj nactenim baliku RealDomain (viz obrazek 1.21).

In(0)

Error, {(in 1n) numeric exception: division by zero

solve(ln(x) =0)

Obrdzek 2.13: Reseni piikladu 2.9.

Pro zjisténi, zda je funkce (shora, zdola) ohranicend, ¢ nikoliv, mizeme vyuzit ptikazu
minimize a maximize pro hledani nejmensich a nejvétsich funkénich hodnot. V ptipadé, ze
funkce neni ,,v nékterém sméru“ ohranicend, vraci zminéné ptikazy hodnotu oo, resp. —oo.
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Dalsi funkéni vlastnosti mizeme uréovat (ovéfovat) za pomoci piikazi evalb nebo verify.
Tyto prikazy otestuji, zda je zadany vyraz pravdivy, ¢i nikoliv. Ukazme si to na néasledujicim
prikladu.

Priklad 2.10: Urcete, zda je funkce cos(x) suda nebo licha.

Reseni: Opét z prednasky vime, ze funkce cos(z) je funkei sudou. Sudost funkce otes-
tujeme zjisténim pravdivostni hodnoty vyrazu cos(x) = cos(—x), lichost podobné podle
pravdivostni hodnoty vyrazu cos(z) = —cos(—x). I tentokrat bychom spravné méli pou-
7it balik RealDomain, nebot bez néj ovéfujeme zminéné rovnosti pro vechna komplexni x.
V obou ptipadech vsak ziskame stejny vysledek.

evalb(cos(x) =cos( -x) )
true
evalb(cos(x) =-cos( -x) )

false

Obrdzek 2.14: Reeni prikladu 2.10.

Prestoze muizeme vytvorit logické vyrazy i pro zbylé funkéni vlastnosti, piikazy evalb
a verify vétsinou vraceji hodnotu FAIL jako znameni, ze nedokazi o pravdivostni hodnoté
rozhodnout. Nékteré dalsi priklady je proto potfeba Tesit samostatné a systém Maple vyuzit
jen k drobnym podiuloham® — jako v nasledujicim prikladu 2.11.

Piiklad 2.11: Urcete, zda je funkce cos(x) na R rostouci, klesajici, prosta ¢i bijektivni.

Reseni: 7 prednasky vime, 7ze funkce cos(x) na celé mnoziné R Z4dnou ze zminénych
vlastnosti nespliuje, coz miizeme dokazat nalezenim protipiikladu. Vezméme napt. body
x1=0azy =2 7. Plati, Ze x1 < 3 (tj. x1 # 2) a soucasné cos(x1) = cos(z3). Tedy funkce
neni rostouci, neni klesajici a neni prosta, z ¢ehoz plyne, Zze nemuze byt ani bijektivni.
Systém Maple tu mizeme pouzit ke zjistovani funkénich hodnot (i kdyz v tomto pfipadé
zname funkéni hodnoty zpaméti).

V praxi se nam vsak ¢asto hodi najit intervaly, v nichz funkce nékteré vlastnosti spliiuje.
Funkce cos(z) je periodickd s periodou 2 - m a na intervalech [k - m, (k+ 1) - 7| pro k € Z

je bijektivni (tedy i prostd), pro suda k je na téchto intervalech vzdy klesajici, pro lichd k
rostouci.

Priklad 2.12: Dokazte, ze funkce sin(x) je ohrani¢ena.

Piiklad 2.13: Uvazujme funkei f(z) = m. Je f suda nebo licha? Urcete jeji defini¢ni
obor a obor hodnot. Je f ohrani¢ena?

Priklad 2.14: U nasledujicich funkci urcete, zda jsou sudé, liché, nebo ani jedno.

(a) fx)=9—a?, (b) f(2) = V2, (0) fla)=1.

35



Priklad 2.15: Definujte funkci f, pro niz plati:
(a) D(f)=(0,1), H(f) = (0,2),
(b) D(f) =R\ {1}, H(f) =R\ {0},
(c) D(f) =R\A{0}, H(f) =R\ {1},
(d) D(f) =R, H(f) =R*, f je prost,
(e) D(f) =R\ (-2,2), H(f) =R,
(f) D(f) =R, H(f) =R\ (-2,2),
(2) D(f) =R, f je prosta a ohranicen,

(h) H(f) =R, f je suda.

Priklad 2.16: Naleznéte k € R tak, aby byla funkce f(z) = 2® — k - 2? + 2 - z licha.

Priklad 2.17: U nasledujicich funkci urcete, zda se jedna o bijekei, ¢i nikoliv.
(a) f:R—=R, f(z)=a-z+b,a,beR,
(b) f:Ry =Ry, f(z) =z,
(c) f:R—Ry, f(z)=2a?
(d) f:R—=R, f(z) =2?

(e) f:R\{0} =R\ {0}, f(z) = 3.

2.2.3 Inverzni funkce

Definice 2.6: Necht f je prostd funkce. Funkci f~!, pro niz plati: D(f') = H(f) aVz €
D(f): 3y € H(f) tak, ze f~(y) = 2 & f(x) = y, nazyvame inverzni funkci.

Poznamka 2.1: Z definice plyne, Ze funkce a jeji inverze jsou osové symetrické vzhledem
k primce y = z.

Systém Maple ma uchovano nékolik zakladnich funkeci s jejich inverzemi v tabulce s na-
zvem invfunc. Praktic¢téjsi je vyuzit ptrikazti InverseTutor nebo InversePlot z baliku
Student [Calculus1] vykreslujicich do jednoho grafu funkci, jeji inverzi a osu y = x jakozto
osu symetrie. Piikaz InverseTutor provadi zminéné v mapletu, ptikaz InversePlot slouzi
pro pouziti v dokumentu (obrazek 2.15).

Hledat pfedpis inverzni funkce mtzeme rovnou podle definice 2.6, a to feSenim rovnice
f(y) = = pro neznamou y.
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with ( Student| Caleulusl ]) :

Inver.sepfm[ &.-4.2 )

The Inverse of
flx) =exp(x)
2 |
6 i )
,a"'
4 /
[/
_,-"Jl
) / /If_
A VAT I I
1 X
-2 4
.
|—rx) The inverse of /() |
Obrdzek 2.15: Vykresleni funkce a jeji inverze.
2
Flx) =+
7
X=X
¥(x) = sobve( f(y) =x.y)
x—solve( f(y) =%y)
yix)[1]
—
v X
yix)[2]
_\I,-’?

Obrdzek 2.16: Reeni piikladu 2.18.

Priklad 2.18: Naleznéte inverzni funkci k funkei f(z) = 22.

Reseni: Nase odpovéd by mohla byt velice struéna, nebot funkce f neni prosté, a tak k ni
neexistuje funkce inverzni. Nicméné je mozné funkci f rozdélit na dvé funkce prosté a hledat

inverzi ke kazdé zvlast.
V systému Maple provedeme diive zminény postup, tj. budeme fesit rovnici f(y) = z.
Ziskame 2 feSeni, a to pravé pro 2 ,prosté ¢asti“ funkce f. Pro z < 0 je inverze k 2 rovna

—+v/z, pro x > 0 je rovna /x (obréazek 2.16).

Priklad 2.19: Naleznéte inverzni funkce k nésledujicim funkcim:
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Priklad 2.20: Existuje funkce, ktera je sama sobé inverzi? Pokud ano, je jedina, nebo jich
existuje vice?

2.2.4 Slozena funkce

Operatorem slozeni funkei je v systému Maple symbol @ (zavina¢). V praxi se bez néj vSak
obejdeme, kdyz pouzijeme kulaté zavorky. Na obrazku 2.17 je nékolik piikladi vytvoreni
slozené funkce, které potvrzuji rovnost f(f~!(x)) = .

flx) =x ﬂ
_T_*_TJ
3
glx) =Vx )
__{_}xl-j
(f@g) (x)
X
f(g(x))
X
f(x) = sin(x)
x—sin(x)

x—+arcsin(x)

Obrazek 2.17: Slozena funkce.

2.3 Vykresleni grafu funkce

2.3.1 Vykreslovani

Prosttedi Standard Worksheet poskytuje nékolik moznosti, jak zobrazit graf funkce nebo
vyrazu. Nejrychlejsi a ziejmé nejjednodussi moznosti je zapsat do dokumentu vyraz (resp.
funkci), ktery chceme vykreslit, kliknout na néj pravym tlacitkem a z kontextové nabidky
zvolit Plots > 2-D Plot.
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ET;] Interactive Plot Builder: Seleck Plot Type

—Select Plot Type and Functions

x|

Edit Functions |

—Select Plok

2-D plok

2-D polar plat
3-0 conformal plok of a complex-valued Function

2-D conformal plot of a complex-valued Function
2-D complex; plat

3-0 camples: plak

—Select Yariable Purposes, Ranges, and Plot Options

¢ ks [« =] |0 o o
Options | Preview |
r

Cn "Plo’ return plok command

Flot I Cancel |

Obrdzek 2.18: Zvoleni typu vykresleni v Plot Builder (prevzato z [5]).

ET,] Interactive Plot Builder: Specify Expressions

x|
File

— Expressions

Add
Edit:

Remove

i

— Wariables

fAdd

Remoye

d

6] | Quik |

Obrdzek 2.19: Okénko pro zadani vyrazu z funkcéniho predpisu a nezavisle proménnych v Plot
Builder (pfevzato z [5]).
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Déle miZzeme vyuZzit pomocnik Plot Builder, a to dvéma zptsoby. Bud opét zapiseme do
dokumentu vyraz z funkéniho predpisu, klikneme pravym tlacitkem mysi a zvolime Plots
> Plot Builder, nebo zamiiime do hlavniho menu a vybereme Tools > Assistants >
Plot Builder.... V prvnim pfipadé se objevi okénko Interactive Plot Builder (obrazek
2.18), v némz upfesnime typ vykresleni. Pokud uvazujeme funkci jedné proménné, volime
2-D Plot. Je mozné volit i jinou moznost jako napfiklad vykresleni v polarnich soutfadnicich
(2-D polar plot). Kliknutim na tla¢itko Plot zobrazime graf v dokumentu [5].

V druhém pripadé, kdy Plot Builder vyvolame z hlavniho menu, se ndm objevi okénko
(viz obréazek 2.19), do néjz zadame vyraz z predpisu funkce, kterou chceme zobrazit (zadani
nam umozni tla¢itka Add, resp. Edit), a proménné (pokud vyraz obsahuje pouze proménné,
systém je vyplni sdm). Kliknutim na tla¢itko OK ptejdeme do jiz zndmého okénka pro zvoleni
typu vykresleni (obrazek 2.18). Dalsi moznosti k vykresleni grafu vyrazu nebo funkce je ptikaz
plot.

Pti vykreslovani muzeme specifikovat nékolik atribut® meénicich podobu grafu. Opét je
nékolik moznosti, jak atributy zadavat. Pii pouziti pomocnika Plot Builder se v okénku
Interactive Plot Builder (obrazek 2.18) objevuje tlacitko Options. Kliknutim na toto
tla¢itko prejdeme na okénko (viz obrazek 2.21) umoziujici nastavit parametry vykresleni
jako jsou rozsah hodnot zavisle i nezavisle proménné, barva a styl vykreslované ktivky, titulek
grafu, legenda atd. Uzite¢né je navic tlac¢itko Preview umoznujici pfedbézné si prohlédnout
soucasny stav a nasledné pokracovat v dalsim nastavovani atributti vykresleni grafu.

2

\ 1004 /  |plot [ x )

A 'l

\ \ 100 s

A 201 f’f \ /
\ / \ 20 /
\ 60 / Y /
) 601 /
X — \\‘ / \\' /
\ 40 / ‘-.\ /
AN S \ 40 1 /
W / 20 y,
r T —= = T 1 ~ -
-10 -3 0 3 10 -10 5 0 3 10
X

Obrdzek 2.20: Vykresleni grafi pomoci kontextové nabidky a pfikazu plot (pfevzato z [5]).

P1i pouziti prikazu plot muzeme totéz provést specifikaci nepovinnych parametri jako
jsou thickness pro tloustku kiivky, color pro jeji barvu, labels pro popisky os, legend
pro tvar legendy u obrazku, axes pro nastaveni soufadych os a dalsi. Ukazku pouziti piikazu
plot s nastavenim nékterych nepovinnych parametri nabizi obrazek 2.22 [5].

Vzhled grafu mtizeme upravovat i po jeho vytvoreni a umisténi do dokumentu. Jednak lze
na graf kliknout pravym tlacitkem mysi a z kontextové nabidky vybirat vlastnosti grafu, které
jsme mohli ménit jiz dfive, nebo mtizeme vyuzit kontextové listy tésné nad dokumentem. Po
kliknuti levym tla¢itkem mysi na graf se ve zminéné listé zobrazi nastroje skupiny nazvané
Plot. K dispozici je téz skupina s ndzvem Drawing. Nastroje v téchto skupinach umozinuji
do hotového grafu ptidavat text, kreslit, ¢ jinak graf upravovat [5].

Jestlize chceme vykreslit vice funkei (resp. vyrazi) do jediného grafu, zapiSseme vSechny
do hranatych, pfipadné slozenych, zavorek jako prvni parametr pfikazu plot. Uzivatelim
doporucujeme pouzivat spise hranaté zavorky, v nichz systém Maple respektuje poradi. Po-
kud nechceme u vykreslovanych funkeci nic dale specifikovat, je ndm jedno, v jakém pofadi
Maple funkce ,vezme* a vykresli, pouzijeme libovolné zavorky (tj. hranaté nebo sloZzené).
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Wariables Label  Orientation
# |-1IZI ko IlD Ix Ihnriznntalll
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~Skyle ~Title

IdeFauIt VI I
~Line ITimes ;”10 ;ILI;'
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Find Discontinuities
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Show Removable
Innrmal vl Advanced Settings |
Mumber of Points 200 -
ITimes v"lEl 'l B | I |

Fill ko x-axis I

N

—Wiew
~Coordinate System

Icartesian ;I
Preview | Flok I Command | Back. | Reset | Cancel |

Constrained Scaling I

Obrdzek 2.21: Okénko Plot Builder pro nastaveni parametru grafu (pfevzato z [5)).

pﬁoi:(xQ, x=-5 .3, calor=biue, thickness =3, legend

="Graf funkee x"2", [abels = [ "x", "y"])
251
201
154

¥
104
5 -
4 3 0 2 4
X
m Graf funlice x72

Obrazek 2.22: Vykresleni grafu pii specifikaci nékterych nepovinnych parametrt (pfevzato z [5]).
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Pokud vsak chceme napt. kazdé z kiivek priradit néjakou barvu, pouzitim hranatych zavorek
se barvy aplikuji v tom poradi, v jakém ocekavame. Pti pouziti slozenych zavorek tomu tak
byt nemusi, viz obrazek 2.23.

pfoz( [xz, xg, x:] x=-2 .2, thickness= 3. color= | green, red, brown | ) pZoz( {xz, xg, x:} x=-2 .2, thickness =3, color= | green, red, brown | )

g 8-
6 64
44 4 4
14 74

Obrazek 2.23: Vykresleni grafu vice vyrazt pfikazem plot.

K dispozici je dale prikaz display z baliku plots, kterym muiizeme dosdhnout stejného
vysledku. Jednotlivé grafy nejprve vytvorime a pfifadime do proménnych, jez dame jako
parametry pravé piikazu display (obrazek 2.24).

2 .
pl = pi’oz(x ,x=-2..2, thickness =13, cofa}‘:g?‘een)

PLOT(...)
p2 = pi’or(x{ x=-2..2, thickness =3, color= red)
PLOT(...)
p3 = plot(x,x=-2 .2, thickness=3, color = brown)
PLOT(...)
plots[ display] ([ p1, p2, p3])
8 -
6 -
4_
2 -
2 - 0 i 2

Obrazek 2.24: Vykresleni grafu vice vyrazti pomoci pfikazu display.
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2.3.2 Animace

V systému Maple muzeme téz vytvaret animace. Animace se sklada z nékolika graft, které
jsou po spusténi zobrazené v sekvenci za sebou. Vytvorime ji bud piikazem animate z baliku
plots, nebo pomoci Plot Builderu. Obrazky 2.25 a 2.26 ukazuji nastaveni Plot Builderu
pro vytvoreni animace, obrazek 2.27 ilustruje tentyz priklad pfi pouziti piikazu animate.

E1: Interactive Plot Builder: Specify Expressions =|

File
~ Expressions
At singx) Add
Edit |
Rermoyve |
~ Variables
i add
Ed
Rermoyve |

Obrdzek 2.25: Zadani vyrazu z predpisu funkce v Plot Builderu (pfevzato z [5]).

Ukonceni Plot Builderu, resp. provedeni prikazu, umisti do dokumentu ,,prazdny* graf.
Kliknutim na néj zobrazime skupinu néstroji v kontextové listé s ndzvem Animation.
Pomoci téchto nastrojii mizeme animaci spustit, zménit jeji rychlost, podivat se na libovolny
snimek animace atd.

Animace miZeme upravovat stejné jako grafy, tj. ménit tloustku, barvu a druh kfivky,
soufadné osy, legendu apod. Navic méame k dispozici nékolik nepovinnych parametrti, diky
nimz muzeme napiiklad uréit pocet graf, z nichz se animace skladé (parametr frames), nebo
kolik grafi vyjma posledniho mé ztistat trvale zobrazenych po spusténi animace (parametr
trace) [5].
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F1: Interactive Plot Builder: Seleck Plot Type |

~Select Plot Type and Functions

Anirnakion Edit Functions |

~Select Plok

2-D plat

z-D polar plat

3D confarmal plot of a complex-valued Function
2-D conformal plot of a complesx-valued Function
Z-0 comples plok

3D complex: plat

~Select Yariable Purposes, Ranges, and Flok Options

Ix Bxis Ix;l I—ID ko Ill:l—

I.‘mimat.iocn FarameteT In;l ID ko |2—
r

Options | Preview

On 'Plot’ return plat command

Plok I Cancel |

Obrdzek 2.26: Zvoleni druhu vykresleni (animace) v Plot Builderu (pfevzato z [5]).

with(plots)
animate [ plot, [A*sin(x), x=-10.10], A=0..2)
A=2.0000

.fﬁ‘-, | .'/\ ;'m\

Obrdzek 2.27: Animace vytvorend prikazem animate (prevzato z [5]).
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Priklad 2.21: Vykreslete funkci f(z) = 2° + 15 - 2* + 85 - % + 225 - 22 + 274 - x + 120.

Reseni: K vykresleni zadané funkce ji staci zapsat do dokumentu a pouzit néktery z difve
uvedenych postupt. Musime vSak mit na paméti, co bychom radi na grafu vidéli a ze je
mozné ziskany vysledek ovlivnit. Naptiklad v tomto pfipadé, kdyz nespecifikujeme rozsah
vykresleni (pouZije se standardni rozmezi -10..10) zcela zkreslime informaci o chovani funkce
na intervalu [—5, 0].

Flx) =2 +15x" + 852 +225:% + 274 x4 120 plot(f(x),x=-6.0)
w2 +15x" +85% 4225 4274 x + 120 o
plot(f(x))
300000 4 04
200000 4 r T T p———,
-6 s 4 3 -2 -1 0
x
100000 4 -50 4
-100 4
-fﬁ -5 0 5 1
x

Obrdzek 2.28: Reseni prikladu 2.21.

Priklad 2.22: K funkci g(x) = €*? naleznéte inverzni funkci. Vykreslete do jednoho grafu
funkei g(x), jeji inverzi a funkci f(z) = x. Do grafu pridejte také legendu.

Piiklad 2.23: Zkoumejte zavislost funkce h(x) = ** na parametru a € R (pomoci ani-
mace). Kdy je funkce rostouci a kdy klesajici?

Priklad 2.24: Vrafte se k ptikladtim 2.12 — 2.20 piedchozi sekce a vykreslenim grafti se
ujistéte o spravnosti vasich odpovédi.

2.4 Limita a spojitost funkce

Definice 2.7: Funkce f(z) ma v bodé zy € R limitu L € R, jestlize ke kazdému ¢ > 0
existuje 6 > 0 tak, Ze pro vSechna = € (x¢ — §, 9 + 0) rtzna od zo plati: |f(z) — L] < e.
Takovou limitu nazyvame vlastni limitou ve vlastnim bodé.

Definice 2.8: Funkce f(z) ma v bodé zp € R limitu L € R zleva, jestlize ke kazdému
e > 0 existuje 6 > 0 tak, ze pro vSechna = € (¢ — 6, x¢) plati: |f(xz) — L| < e. Analogicky
definujeme limitu zprava.

Definice 2.9: Funkce f(x) ma v bodé zy € R limitu rovnu +o0, jestlize ke kazdému M € R
existuje 0 > 0 tak, ze pro vSechna x € (xg—0, x9+0) rizné od x, plati: f(x) > M. Analogicky
definujeme limitu rovnu —oo. Takovou limitu nazyvame nevlastni limitou ve vlastnim bodé.
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Definice 2.10: Funkce f(z) mé& v bodé +oo limitu rovnu L € R, jestlize ke kazdému e > 0
existuje K € R tak, Ze pro vSechna x > K plati: |f(x) — L| < €. Analogicky definujeme
limitu v bodé —oo. Takovou limitu nazyvame vlastni limitou v nevlastnim bodé.

Priklad 2.25: Definujte limitu zprava.

Priklad 2.26: Definujte nevlastni limitu v nevlastnim bodé.

V systému Maple pouzijeme k vypoctu limity bud pfislusny symbol z palety Expression
(a upravime v ném barevné symboly, jak potfebujeme) nebo piikaz limit, ktery ma povinné
dva parametry — vyraz (tj. i funkéni vyraz) a bod, v némz hleddme limitu. Také je mozné
zadat do dokumentu vyraz, jehoz limitu chceme urcit, kliknout na néj pravym tlacitkem
a z kontextové nabidky zvolit polozku Limit. Otevie se ndm okénko, v némz je dale tieba
specifikovat bod, v némz hledame limitu. Mtzeme déale uvést i typ limity — oboustrannou
(zdkladné zvolend), limitu zleva nebo limitu zprava.

V pripadé pouziti palety specifikujeme jednostrannou limitu zapsanim symbolu + nebo
— do exponentu bodu, v némz chceme limitu urcit. Piikazu limit mtzeme zadat tieti
(nepovinnny) parametr ve tvaru right nebo left pro limitu zprava, resp. zleva. Vsechny
zminéné postupy ilustruje obrazek 2.29. V jeho pravé ¢asti je definovana funkce a pfi urc¢ovani
limit pouzivan funkéni vyraz f(x). Funkéni operator (tj. f) pouzit nemtzeme.

ffmiz[i_. x= O] = undefined fix) = 1
x x
Efmiz[i_.x=0, rfghz) = o .T—*L

X X
lim — = undefined
JLim, —~ = undefine limit( £ (x),x=0) = undefined

: 1 o -0 -
xhn[]l+?_ o0 limit( f(x),x=0, right) = o
o lim_f(x) = undefined
Ce 1 limit x—0
oboustranna limita: — —— undefined
X .

o 1 limit [im flx) = e
limita zprava: g — w x

Obrdzek 2.29: Urceni limity v bodé.

Systém Maple v nékterych piipadech zobrazuje neocekavané vysledky, které mizeme
oznacit za chybné. Jedna se napiiklad o limity na obrazku 2.30. Vypsanym vysledkem se nam
systém snazi dat omezeni na funk¢éni hodnoty v okoli bodu, v némz hledame limitu. Podle
uvedenych definic v tomto textu vSak musime konstatovat, ze prislusné limity neexistuji.

Priklad 2.27: Urcete nasledujici limity:

(a) lim 222, (c) lim <=,
.. sin(a-x) d) lim tan(z).
(b) ilE)I(l) sin(b~1‘)’ ( ) z"%-'— ( )
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Obrazek 2.30: Nedostatky Maplu pfi ur¢ovani limity.

Priklad 2.28: Urcete nasledujici limity:

3 . x — . x €T

(a) lim 2% (0) lim 322, (e) tim S5,
(b) lim M : 342 . sin(t)-cos(t)
ooz eos(@) (d) lim 7=, (F) Tim 2

Jak byste limity urcovali bez systému Maple?

Priklad 2.29: Definujte funkci, ktera:

a) ma vlastni limitu ve vlastnim bodé,

(
(b

ma vlastni limitu v nevlastnim bodé,

)
)
(c) mé nevlastni limitu ve vlastnim bodg,
(d) ma nevlastni limitu v nevlastnim bodé,
)

(e) spliuje vSechny pfedchozi body (a) — (d).

Jak jsme se zminili v sekci 1.3.4, Maple obsahuje pomocné nastroje, které nam ulehcuji
feseni uloh a pomahaji v uceni nékterych matematickych postupt pii jejich feseni. Jednim
z takovych nastroji je maplet zvany Limit Methods. Spustime jej z hlavni nabidky zvole-
nim Tools > Tutors > Calculus — Single Variable > Limit Methods.... Tento nastroj
umi fesit zadané limity krok po kroku pomoci implementovanych matematickych pravidel.
MiZzeme mu tedy zadat vyraz a bod, v némz chceme urcit jeho limitu, a nechat napriklad
maplet zobrazit celé feseni krok za krokem kliknutim na tlacitko All Steps. Vysledek tohoto
postupu na prikladu 2.28.(b) mtZeme vidét na obrazku 2.31. V mapletu si vS§ak mtizeme zob-
razit pouze nasledujici krok vypoctu, pokusit se pouzit nékteré z implementovanych pravidel
nebo pozadat o napovédu, které pravidlo pouzit.

Definice 2.11: Rekneme, 7e funkce f(zr) je spojitd v bodé z, pokud mé v tomto bodé
vlastni limitu a plati: lim f(x) = f(zo).
T—T0

Definice 2.12: Rekneme, 7e funkce f(z) je zprava (resp. zleva) spojita v bodé xy, pokud
ma v tomto bod€ pfislusnou jednostrannou vlastni limitu a plati: lim_ f(z) = f(xo) (resp.
T—T0

IEZI;_ f(@) = f(z0)).
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E1aCalculus 1 - Limit Methods |
File Edit Rule Definition  Apply Rule  Understood Rules  Help
Enter a function
’VFunction I(cos((1I2)*xj-sin((1,|'2]*x]|)ll'cos(x) ‘ariable Ix at IPiII'Z Direction I - l
%,."2 + Iim CO.SL%IJ =]
i - x — % T -
T2 lim  sin(x)
=T [+ show Hints et Hink |
1 ey 1
=2 +cos| lim —x
2V 1 2
1 X— T m
= — - Canstant Identity |
2 lim  sin(x)
- % T[ Constant Multiple
1 )
— 2 +cos| — Iim x Sum Difference
2 2 1
1 x— T T Product Quotient
2 lim  sin(x)
. % - Pawer Change
- I'Hopital's Rule Divide by zero
1 JZ £ !
7 Tim sm( t’] Factor Rewrite
X — % T
< Exponential Makural Logarithnm |
= 2 W 2 = <krige j <hyperbolic= j
ﬂ | pl <archrigz j <archyperbaolic> j
Undo | Mexxk Step | All Steps | Close |

Obrazek 2.31: Pomocnik pro urcovani limit.

Definice 2.13: Rekneme, Ze funkce f(x) je spojita na intervalu J € D(f), pokud
(a) f je spojitd v kazdém vnitfnim bodé intervalu J

(b) a patii-li levy (resp. pravy) koncovy bod do intervalu J, je v ném funkce f spojita
zprava (resp. zleva).

V systému Maple miizeme jednak testovat rovnost limity a funkéni hodnoty, jak plyne
z definice. Pro urcovéani spojitosti funkce na intervalu je vSak mozné (a vhodné) vyuzit
piikazu discont hledajiciho nespojistosti funkce. Piikaz méa dva povinné parametry, a to
vyraz, jehoz nespojitosti urcujeme, a nezavisle proménnou.

Pokud je funkce y = f(x) nespojitd na daném intervalu jen v kone¢né mnoha (izolova-
nych) bodech, systém Maple ji v téchto bodech spojuje tiseckami rovnobéznymi s osou y.
Jestlize chceme nespojitosti zobrazit korektné, pouzijeme nepovinny atribut discont piikazu
plot, ktery nastavime na hodnotu true — viz obrazek 2.32.

Od verze Maple 14 je mozné také zobrazovat odstranitelné nespojitosti (obrazek 2.33).

Piikaz discont vSak neni mozné pouzivat u funkci definovanych po ¢astech. Vysledkem
prikazu jsou v tomto ptripadé vzdy body ,,podezielé” z nespojitosti. Pro zjisténi, zda se jedna
o nespojitosti ¢ nikoliv, je potfeba v téchto bodech provést test (existence a) rovnosti limity
a funkéni hodnoty. Obrazek 2.34 ukazuje pouziti pfikazu discont v piipadé funkce f(x)
zadefinované po castech.
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X plot(tan(x),x=-5..5,y=-3 .3, thickness=3)
3_

24

14

_24
_3d
plot(tan(x),x=-5..5,y=-3 .3, thickness = 3, discont= true)
discont= true) 39
2_
¥
1_
4 2 2 4
3 o2 -1 14
-24
_3d
discont( f(x),x) discont( tan(x), x)
L] 1
2 [m_23~ + ?rc]
r_ZI~
Obrdzek 2.32: Zobrazovani nespojitych funkei.
216y #4
Piiklad 2.30: Naleznéte ¢islo C' € R tak, aby funkce f(x) = cf“* A

byla spojita pro vSechna x € R.
Resent: Jelikoz 22 —16 = (z—4)-(z+4), plati f(z) = x+4 pro x # 4, a tedy lim f(x) =8.
Z definice spojitosti pak dostavame: C' = f(4) = 8.

Priklad 2.31: Urcete body nespojitosti funkei:

z+1 . > 2
(a) f(z)=<22—-1 ... 1<x<2,
z—1 o<1
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f(x) = piecewise(x + 5,x,6)

3
— (x—1)
fi=x— 271 : x— piecewise(x # 5,x, 6)
=
plot(f(x),x=-5..5,y=-15 .10, thickness = 3, discont plot(f(x), thickness=3)
=true) 107
in
5]
y b
4 20 2 4 -10 -3 5 10
X X
=51
5
/_\-10-
10
_15.

plot(f(x).x=-5 .5, y=-15 .10, thickness =3, discont |plot( f(x), thickness =3, discont = [ showremovable] )

= [ showremovable]) 10+
D_
5_
¥y
e
4 z 0 z 4 {0 5 3 10
* x
_5_
5
10
_ID_
_15_
discont( f(x),x) discont( f(x), x) s
5

{_1:1}

Obrdzek 2.33: Zobrazovani nespojitych funkci a vyznacovani odstranitelnych nespojitosti.

discont( piecewise(x < 0,x,x = 0,x),x)

{0}

Obrdzek 2.3/4: Pouziti ptfikazu discont u funkce definované po ¢astech.

3-22—-1 ... x<0

Piiklad 2.32: Naleznéte ¢isla ¢, d € R tak, aby funkce f(z) =< c-2+d ... 0<z<1
Vo438 cox>1

byla spojita pro vSechna x € R.

Priklad 2.33: Uvedte piiklad funkce, kterd na uzavieném intevalu neni spojité, ale ma

limitu v kazdém bodé tohoto intervalu.
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2.5 Derivace funkce

Definice 2.14: Necht f je funkce, 2y € R. Existuje-li lim %ﬁ;ﬁxo), nazyvame tuto limitu

Tr—XT0

derivaci funkce f v bodé x,.

Poznamka 2.2: Derivace funkce f(z) je funkce, kterd je definovana ve vsech bodech,
v nichz existuje limita z pfedchozi definice. Tuto funkci zna¢ime nékolika zpusoby: f'(z),
% nebo %(f). Analogicky mizeme definovat druhou derivaci funkce f(z) jako derivaci
funkce f'(x) a podobné derivace vyssich Fadu.

Poznamka 2.3: Limita v definici 2.14 mizZe byt vlastni i nevlastni. Podle toho rozlisujeme
také vlastni a nevlastni derivaci. V tomto textu si situaci uleh¢ime a budeme uvazovat pouze
vlastni derivace. Z tohoto dtivodu budeme slovo ,vlastni“ vynechavat a slovem ,derivace®
budeme vzdy rozumét vlastni derivaci.

Systém Maple nabizi (jako obvykle) nékolik moznosti, jak urcit derivaci funkce. Opét
mizeme vyuzit kontextové nabidky (tj. zapsat do dokumentu vyraz, ktery chceme derivovat,
kliknout na néj pravym tlac¢itkem mysi a z nabidky zvolit polozku Differentiate s vybérem
nezavisle proménné). Déle je mozné pouzit oba jiz uvedené symboly zapisu derivace, které
jsou k dispozici v paleté Expression. Systém Maple (v rezimu Document Mode) rozpozna
i zépis f'(z) (tj. pouziti apostrofu jako symbolu derivace). Dlasi moznosti je piikaz diff
majici dva povinné argumenty: vyraz a nezavisle proménnou.

%(x2+2-x+6} =2x+2

(¥ +2-x4+6) =2x+2

2|

dg'ﬁ‘(x2+2-x+6,x) =2x+2

differentiate wrt x

X +2x+6 > 2x 42

(X +2x4+6)'=2x+2

Obrazek 2.35: Piehled moznosti pii vypoctu derivace.

P1i pocitani derivaci musime byt opét opatrni a rozliSovat mezi funkénim operatorem
a vyrazem. VSechny zminéné zptusoby urceni derivace funkce (nebo lépe vyrazu) vraci vysle-
dek jako vyraz. Pokud chceme poté urcit jeho funkéni hodnotu, musime bud pouzit prikaz
eval, nebo ze ziskaného vyrazu udélat funkci prikazem unapply, pfipadné pouzit apostro-
fovou notaci pro zapis derivace, viz obrazek 2.36.

Systém Maple disponuje téz prikazem D predstavujicim diferencidlni operator. Jeho ar-
gumentem je funkéni operator a vysledkem derivace opét jako funkce (funkéni operétor) —
prava cast obrazku 2.36.
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d
Kh{x}
2x+2
eval( %, x=2)
6

g = unappf}'[ %h{x):x]

x—=2x+42
g(2)
6
h'(2)
6

D(sin)

D(sin) (x)

cOs

cos(x)

Obrazek 2.36: Vypocet derivace v bodé.

(¥ +2x+6)"=2

(L+2x+6)" =0

dgﬁ(xz —I—?.-x—l—ﬁ_.x:x_.x)

Obrdzek 2.37: Vypocet derivaci vyssich rada.

Derivace vyssich radi zadavame tak, jak jsme zvykli ,,s tuzkou na papiire*. PTi pouziti
piikazu diff se n-td derivace specifikuje tak, ze zaddme nezavisle proménnou n-krat (jako
argument pifkazu)®. Systém Maple (opét pouze v reZimu Document Mode) umi rozpoznat
i zapis s ¢islem derivace v exponentu vyrazu v kulatych zavorach — toto je nutné pii odkliknuti

jesté potvrdit ve vyskakujicim okénku (obrazek 2.37).

5Je mozné pouzit i zkraceny zapis ve tvaru diff (f(x),x$n).
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Stejné jako u limit poskytuje Maple pomocné nastroje pro vypocet derivaci. Prvnim z nich
je maplet zvany Derivatives. Spustime jej z hlavni nabidky zvolenim Tools > Tutors >
Calculus — Single Variable > Derivatives.... Maplet pro zadanou funkci vypocita jeji
prvni a druhou derivaci, zvolené funkce vykresli do jednoho grafu.

E';’, Calculus 1 - Derivative EI
File Help

- Plot Window

~Enter a function and an interval [a,6]———
1 4

| Fise) = |*cos(x)
a=n b= pi
a

~Derivatives

7 I Fixi= Icos(x)-x*sin(x)
-2+ W Display F{x) in the plok
I iy = |-2*sin(x)-x*cos(x)
-3

[~ Displare F'(x) in the plak

Display I Plot Options Close

torder'=[1], 'wiew'=[0, .. 2,14, -2.5L .. 1.241):

~ Maple Command

DerivativePlet(x*coes(=1,0 .. Pi,

Obrazek 2.38: Pomocnik pro vypocet a zobrazeni derivaci.

[1a Calculus 1 - Differentiation Methods

X
File Edit Rule Definition Apply Rule Understood Rules  Help
Enter a function
’7Functi0n Ix*sin(x) ‘ariable [x Skart |
L (wsin)) ’
= [% ] sin(x) +x [ %sm[}:)]
d [ Show Hinks Get Hint |
=sin(x) + x Esm(x)
= sinlx) + xcos(x)
Constant Identity
Constant Multiple
Sum Difference
Product Quatient
Paower Chain Rule
Integral Rewrite
Exponential Matural Logarithm
<hrig= | <hwperbolic> |
<arckrigs ¥ || <archyperbalic> |
Undo | Mexk Step | Close |

Obrazek 2.39: Pomocnik pro vypocet derivaci.
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Druhy pomocny nastroj je maplet s ndzvem Differentiation Methods. Spustime jej
z hlavni nabidky zvolenim Tools > Tutors > Calculus — Single Variable > Differen-
tiation Methods.... Stejné jako analogicky pomocnik u limit umi fesit derivace zadanych
funkei krok po kroku pomoci implementovanych matematickych pravidel (ktera nalezneme
v napovédé). Mizeme mu tedy opét zadat vyraz a nezéavisle proménnou a nechat maplet
zobrazit celé feseni krok za krokem kliknutim na tlacitko All Steps. Vysledek tohoto po-
stupu mizeme vidét na obrazku 2.39. V mapletu si také mlizeme zobrazit pouze nésledujici
krok vypo¢tu (Next Step), pokusit se pouzit nékteré z implementovanych pravidel nebo
pozadat o ndpovédu (Get Hint), které pravidlo pouzit.

Priklad 2.34: Urcete:

() 7 (f(2) - g(2)), (c) fla 2®+b-2®+c -z +d),

() £(/(g()), @ #(%).

Priklad 2.35: Uvedte priklad spojité funkce na intervalu J, kterd na tomto intervalu neni
diferencovatelna (tj. nemé v alesponl jednom bodé derivaci). Dokéazete uvést piiklad funkce
spojité na intervalu .J, ktera na tomto intervalu nema derivaci pravé ve dvou bodech?

Poznamka 2.4: Geometrickou interpretaci derivace funkce f(z) v bodé zy je smérnice
tecny k funkei f(z) v tomto bodé. Jestlize tedy y = k -z + ¢ je rovnici teény v bodé zg, pak

k? = f/(ZL‘()).

Priklad 2.36: Urdete rovnici tecny k funkci f(z) = 2? v bodé 2y = 1. Vykreslete do
jednoho grafu funkci f(z) i tuto te¢nu.

Priklad 2.37: Najdéte bod z( tak, aby tecna k funkci f(x) = z3 v tomto bodé byla
rovnobézna s pfimkou y = 12 - x — 5. Vykreslete do jednoho grafu funkci f(z), nalezenou
te¢nu a zadanou piimku.

Priklad 2.38: Najdéte bod z, tak, aby tefna k funkci f(x) = 2 v tomto bodé byla kolméa
na primku y = —% -x—b5. Vykreslete do jednoho grafu funkei f(x), nalezenou teénu a zadanou
primku.

2.5.1 Diferencial

Definice 2.15: Rekneme, Ze funkce f je diferencovatelnd v bodé zg, jestlize je v ném
definovana a jestlize existuje A € R tak, ze }llim f($°+h)_}{(”"°)_A'h = 0. Funkce A-h (h € R)

—0

se nazyva diferenciglem funkce f v bodé g a znadi se df (xo)(h).

Poznamka 2.5: Jak jiz bylo zminéno v prikladu 2.35, ,diferencovatelnd funkce® je totéz
co ,funkce majici derivaci®.

Diferencial je mozné pouzit k urceni ptiblizné hodnoty funkce v okoli bodu se znamou
funkéni hodnotou. V systému Maple se tato ,vyhoda“ smazava, jelikoz samotny Maple nam
okamzité vypise pribliznou funkéni hodnotu s ,libovolnou“ presnosti. Pfesto je mozné si na
prikladech vyznam pojmu ovérit a vyuzit Maple alespon k dil¢im vypoctim.
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Priklad 2.39: Urcete piiblizné: arctan(1.01).
Resend: Vyjdeme z definice 2.15. Ta ndm k4, Ze f(zo+h) ~ f(xo) +df (zo) - h. V nasem
piipadé zo = 1 a h = 0.01. ReSeni ziskané v Maple je zndzornéno na obrazku 2.40.

. d
Derivace zadané funkce: — arctan(x) = ! 5
ox 1+x

S pfesnosti na 10 mist pomoci Maple: arctan( 1.01) = 0.7903732467

Pfiblizné pomoci diferencialu:

1 1
5--0.01=arctan(1.0) + 200

arctan(1.01) =~ arctan(1) + =0.7903981634
1

Obrdzek 2.40: Reseni prikladu 2.39.

Priklad 2.40: Urcete priblizné: v/51.
Piiklad 2.41: Urdete pfiblizné: v/123.
Piiklad 2.42: Urdete pfiblizné: 2.95%.

2.5.2 Taylortv polynom

Definice 2.16: Necht n € NU{0} a f je funkce majici v bodé zy € R derivace az do fadu
n. Polynom

(o)
1!

fl/(l,o)

f(n)(lfo)
2!

n!

T (x) = f(zo) + (x —x) + (2 —w0)® + .. (x—x0)",x € R,

se nazyva Tayloruv polynom stupné n funkce f v bodé zy. Funkci
R)(z) = T](x) - f(x)
fikdame Tayloriv zbytek a cely vyraz
T(x) + Rl (x)

nazyvame Taylorovym vzorcem.

Poznamka 2.6: Jak jsme si mohli v§imnout, aproximace funkéni hodnoty pomoci dife-
rencialu je vlastné specialni pripad Taylorova polynomu pro n = 1. Taylortiv polynom také
muzeme vyuzit k aproximaci funkéni hodnoty v okoli bodu se zndmou funkéni hodnotou.

vvvvvv

vysoké musi byt n, abychom docilili pozadované presnosti aproximace.

Poznamka 2.7: Necht jsou splnény predpoklady definice 2.16. Pak existuje ¢islo © € (0, 1)
tak, ze
FU D (@o + © - (z = wp))

By(x) = (n+1)!

. (ZL‘ _ 170)n+1.
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Poznamka 2.8: Kdyz polozime v Taylorové vzorci xg = 0, vSechny vyrazy se nam zjedno-
dussi. V takovém pripadé také nekdy mluvime o Maclaurinové vzorci. Pro Maclauriniv
zbytek pak plati:
Rl(z) = [T 2)
(n+1)!

Systém Maple obsahuje pfikaz taylor vypisujici Tayloriv vzorec pfislusny zadané funkci
v prvnim parametru pfikazu. Druhym povinnym parametrem je bod, v némz se vzorec reali-
zuje. Standardné je vzorec vypisovan pro n = 5, coz je o jedna nizs$i hodnota nez zakladni na-
staveni systémové proménné Order. Tato proménna predstavuje fad Taylorova zbytku, tedy
¢islo n+1. Pocet ¢lent Taylorova vzorce tak mtizeme ovlivnit pfenastavenim proménné Order
nebo zapsanim této hodnoty na misto tfetiho (nepovinného) parametru pitkazu taylor®.

Nékdy se ndm muze hodit pracovat pouze s Taylorovym polynomem (tedy bez Taylorova
zbytku). K tomu je potfeba pouzit piikaz convert, kterému zaddme jako prvni parametr
Tayloriiv vzorec (ziskany piikazem taylor) a na misto druhého parametru zapiSeme slovo
polynom (¢imZ se ,zbavime“ vyjadfeni Taylorova zbytku pomoci funkce O).

taylor(sin(x), x=x0) =
sin(x0) + cos(x0) (x —x0) — % sin(x0) {x—x{)]l2 - % cos(x0) {x—x0}3 + ,)1—4 sin(x0) {x—xif)]l4 + % cos(x0) {x—xO}S

+0((x—x0)°)

o oy —._ 1 3 1 s 6
taylor(sin(x),x=0) =x 6 ¥ + 120 * +O(x)

(X _ 1 2 1 3 1 4 1 3 1 5 1 7 1 8 1 9 10
ra}fo;(e:x—O:IO)—l+x+?x e TR AR T iR b B e e T TR e v +0(x")

1 2 1 3 1 4 1 5 1 i 1 7 1 g 1 0
ertl 2 y = —_ - R
convert( %, polynom) =1 +x+ > + 6 ¥ + EYiR + 120 * + 70 ¥ + 5010 ¥ + 20320 © + 362880 ~

Obrdzek 2.41: Ukazka pouziti pfikazu taylor.

Piiklad 2.43: Najdéte Maclauriniv polynom funkce tan(x) patého stupné.
Priklad 2.44: Vytvoite Tayloruv polynom pro funkci z* ¢tvrtého stupné v bodé 1.

Priklad 2.45: Pomoci Taylorova polynomu vyjadiete funkci f(z) = 25 +xt+ 23+ 22 +2+1
jako polynom v proménné x — 2.

Jak jsme se zminili v pozndmece 2.6, Taylortiv polynom mtizeme vyuzit k nalezeni pfiblizné
funkéni hodnoty. Diky poznamkam 2.7 a 2.8 mame navic nastroj, jak urcit tuto hodnotu se
zadanou presnosti. Podobné jako v pfipadé pouziti diferencidlu plati i zde, ze (podstatné)
jednodussim zpisobem ziskdme dokonce presnéjsi hodnotu pouhym pouzitim systému Maple.
Presto mtize Maple slouzit jako pomocnik pti vypoctu a soucasné diky nému mizeme oveérit,
zda byla splnéna pozadované pfesnost vypoctu.

6V tomto piipadé nedojde ke zméné hodnoty uloZené v proménné Order, ovlivnén bude pouze p¥islusny
vypis prikazu taylor.
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Piiklad 2.46: Urcete hodnotu Eulerova ¢isla e s chybou mensi nez 1073,

Reseni: Chceme zjistit hodnotu ¢isla e, vezmeme si proto na pomoc funkci f(z) = €*
a budeme hledat funkéni hodnotu f(1). Funkci musime aproximovat v néjakém jiném bodé
nez je bod 1 (nebof pro ten bychom dostali pfesnou hodnotu e a v ni¢em by ndm to ne-
pomohlo), soucasné ale ne piili§ daleko od tohoto bodu (¢im dale od tohoto bodu bychom
hledali aproximaci, tim nepfesnéjsi bude vysledek). Abychom si situaci co nejvice zjedno-
dusili, vezmeme bod 0 (ktery je ,blizko“ bodu 1), pro néjz mame tvar Taylorova (resp.
Maclaurinova) zbytku uréeny poznamkou 2.8.

Méame tedy funkci f(x) = e® a vime, Ze pro prislusny Maclaurintiv zbytek plati:

€®~JJ
~ (n+1)!

anrl’

kde © € (0,1). Nés bude zajimat funkéni hodnota v bodé 1, tj. pro x = 1 dostéavame:
©

(n+ 1)1

V zadani je pozadovana piesnost 1073, M4 tedy platit:

|RS (1) <1072,

Dosazenim ziskame:

e® e®

(n+1)!': (n+1)!

Nyni je tfeba si uvédomit, ze e® < 3, jelikoz © € (0,1). Mtzeme proto psat, ze plati:

<1073

e® e3

CES TS

Kdyz nyni najdeme n takové, ze
3
— <1077,
(n+1)!

pak bude jisté platit:
e

(n+1)!

Ziskané n predstavuje stupen Maclaurinova polynomu, takze uz zbyva pouze popsany postup
aplikovat v systému Maple — obrazek 2.42.

<1073

Piiklad 2.47: S chybou mensi nez 10~2 uréete hodnotu &sla:

(a) ¢ (b) V/250.

2.6 VysSetfeni prabéhu funkce

Nez zacneme s vySetfovanim prubéhu funkce na ptikladech, pripomenme si zakladni dilezité
pojmy a jejich vlastnosti.
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Hledame tedy n splfivjici nerovnost:

3 -3
CE I

Coz je to samé jako:
(n+1)1>3-10°=3000

Maple takovou nerovnost vyfesit neumi, ale pfipadné metodou "pokus-omyl"
zjistime, ze:

(n41)1>3000 =n=>6

Maclaurinfiv vzorec:
Ia}'i’or( ¢, x=0,7 )
1 1 1 4 1 5 1 6 [ x? )

2 3
1+x+?x +Ex +§x + 120x + 72O.vc + 0O\

Maclauriniv polynom:
app = convert( %o, polynom)
1 4 1 5 1 s

1 2 3 1
1+x+?x +€x +§x + 120x + 720x

Vytvofeni funkce ze ziskaného vyrazu:
aprox ‘= unapply( app, x)
1 4 1 s 1 &

1 2 3 1
x—>1+x+?x +Fx +§x + 120 x + 720 X

Aproximace Maclaurinovym polynomem:

evalf (aprox(1)) =2.718055556

Piibli#na hodnota v Maple:
evalf (') = 2718281828

Chyba aproximace:
chyba = |eva{f (aprox(1)) - evalf! ( ! )l =0.000226272

Obrdzek 2.42: ReSeni prikladu 2.46.

Poznamka 2.9: Necht f(z) je funkce. Pokud f’(x) > 0 pro vSechna z € J, pak je f(x)
na intervalu J rostouci. Pokud f/'(x) < 0 pro vSechna x € J, pak je f(r) na intervalu J
klesajici.

Definice 2.17: Rekneme, e funkce f(z) md v bodé zy € R lokaln{ minimum, jestlize
existuje § € R, & > 0 tak, ze f(x) > f(xy) pro vSechna x € (xy — d,xz0 + J). Analogicky
definujeme lokalni maximum funkce. Lokalni minima a maxima se souhrnné nazyvaji lokalni
extrémy.

Poznamka 2.10: Necht f(x) je spojitd v bodé xy. Jestlize existuje d € R, § > 0 tak, ze
f(z) je neklesajici na intervalu (xy — 0, x9) a nerostouci na intervalu (zg,zo + d), mé f(x)
v bodé xg lokalni maximum. Analogické tvrzeni plati pro lokalni minimum.

Poznamka 2.11: V pfedchozi poznamce jsou zamérné pouzity vyrazy ,neklesajici“ a ,ne-
rostouci. Lokalni minimum (resp. maximum) se totiz mize podle definice nachézet i na in-
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tervalu, kde je funkce konstantni. V tom pripadé se jedna o tzv. neostry extrém. Pro piipad
ostrych extrémi je mozné v predchozi poznamce nahradit slovo ,neklesajici“ za ,rostouci®
a ,nerostouci za ,klesajici“.

Poznamka 2.12: Body g, v nichz f'(z¢) = 0, nazyvame staciondrnimi body. Tyto body
a body, v nichz funkce f(x) nemd derivaci, jsou ,,podezielé* z toho, ze jsou lokadlnimi extrémy
funkce. Jestli se skutecné jedna o extrém, uréime bud podle definice 2.17, poznamky 2.10
nebo poznadmky 2.13.

Poznamka 2.13: Necht f'(zg) = 0 a f"(z9) # 0. Pokud f"(z¢) < 0, mé funkce f(z)

v bodé x( lokdlni maximum. Pokud f”(zg) > 0, mé funkce f(z) v bodé zy lokalni minimum.

Definice 2.18: Necht f(z) je funkce, J interval. Rikdme, Ze f je konvexni na J, jestlize
pro kazdé dva body x1, o € J, v1 < x5 a kazda dvé nezaporna realna c¢isla ay, as takova, ze
a; + ag = 1 plati:

flar- @+ as-x2) < ay - f(x1) +ag - fag).

Pokud za tychz predpokladt plati:

flag -z +az-x9) > ay - f(w1) + az - f(x2),

fikdme, ze f je konkavni na J. Pokud zménime vSechny neostré nerovnosti na ostré, mluvime
o ryzi konvexite, resp. ryzi konkduvite.

Poznamka 2.14: Necht f ma na intervalu J C D(f) druhou derivaci. Pokud f”(x) > 0
pro vSechna z € J, pak je f na J konvexni. Pokud plati ostrd nerovnost, je f na J ryze
konvexni. Analogicky, pokud f”(z) < 0 pro vSechna x € J, pak je f na J konkavni. V piipadé
ostré nerovnosti je ryze konkavni.

Poznamka 2.15: Body, v nichZ se méni ryzi konvexita funkce na ryzi konkavitu a naopak,
nazyvame inflexnimi body. Necht tedy o € R, § € R, § > 0. Pokud f(x) je na (xq—d, x¢) ryze
konvexni a na (xg, o + 0) ryze konkavni (resp. naopak), nazyvame bod zy bodem inflexnim.

Poznamka 2.16: V bodech nespojitosti xy funkce f(z) zkouméame, jestli v nich jsou
asymptoty bez smérnice, a to ovéfenim, zda lim f(x) = +oo nebo lim f(z) = +oc.

T—T0 z—z0t
Déle zkouméame, zda mé funkce f(x) asymptotu (asymptoty) se smérnici, tj. zda existuji
A, B € R tak, ze lim f(x) =A-x+ Bnebo lim f(x)=A-x+ B.

Plati, ze
A= lim M (resp. A = lim Lx))

T—00 T T——00 T

B = lim (f(z) — A ) (resp.B: lim (f(:v)—A-:):)).

Tr—00 r——00

Pii vySetfovani pribéhu zadané funkce f(z) zkoumame vlastnosti popsané v predchozich
definicich a poznamkéach, spolu s nékterymi diive zavedenymi pojmy. Aplikujeme tak nasle-
dujici postup:
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1. Zjistujeme D(f), hledame nulové body (tj. takova z, pro kterd f(x) = 0), prisecik
s osou y (tj. f(0)), urcujeme, kdy je funkce kladna, zaporna, a hleddme body nespoji-
tosti funkce f.

2. VySetiujeme funkci f'(x). Hleddme D(f’), nulové body a intervaly, kde je funkce f’(x)
kladné (tj. f(x) je rostouci) a kde zaporna (tj. f(z) je klesajici).

3. Vysettujeme funkci f”(x). Hleddme nulové body a intervaly, kde je funkce f”(x) kladnéa
(tj. f(x) je konvexni) a kde zadporna (tj. f(x) je konkavni). Ovéfujeme, zda je néktery
z dfive nalezenych stacionarnich bodu lokalnim extrémem funkce f(x).

4. Hledame asymptoty funkce f, a to asymptoty bez smérnice a asymptoty se smérnici.

5. Vykreslujeme graf funkce f(z).

Piiklad 2.48: Vysetiete priubéh funkce f(z) =z - es.

Reseni:

Budeme prochazet pravé uvedeny postup, pricemz budeme vyuzivat moznosti Maple 14.

1. Defini¢ni obor funkce vidime na prvni pohled z jejiho predpisu. Funkce neni definovana
pouze v bodé nula, tedy D(f) = R\ {0}. K nalezeni nulovych bodi a intervald, kde je
funkce kladn4, resp. zadpornd, vyuzijeme piikaz solve’. V tomto piipadé vsak piikaz
zadné teseni nenajde. Musime jej proto urcit ,sami“. Vyraz er je pro libovolna z
kladny, z ¢ehoz plyne, Zze f(x) > 0 pro z > 0 a f(x) < 0 pro < 0. Pro nalezeni
nespojitosti pouzijeme piikaz discont.

1 Znameénka:
f(x) =x-e”
solve( f(x) < 0)
Warning, sclutions mav have been lost
Nulove body:

solve( f(x) = 0)

solve( f(x) =0, x) Warning, sclutions mav have been lost

Prusecik s osou y :
Neni. Funkee f{x) neni
definovana v bodé 0.

Body nespojitosti:

discom[x- c?:x] = {0}

Obrdzek 2.43: Reseni piikladu 2.48 — bod 1.

2. Vypocteme f'(z). Defini¢ni obor prvni derivace je stejny jako u pivodni funkce, tedy
D(f") = R\ {0}. Dale pouzijeme piikaz solve. Nyni jiz dostavame vSechny pozado-
vané vysledky od Maple. Pro nalezeni stacionarnich bodt je mozné téz pouzit pri-
kaz extrema vypisujici funkéni hodnoty ve stacionarnich bodech. Prvnim parametrem
prikazu je vyraz, jehoz stacionarni body hleddme, druhym parametrem je mnozina
omezujicich podminek (kdyz zadné nejsou, uvedeme prazdné slozené zavorky). Dalsim
parametrem je nezavisle proménnd zadané funkce a poslednim ¢tvrtym parametrem je
nazev proménnné (v apostrofech), do niz se ulozi stacionarni body — viz obrazek 2.44.

"Upozornéme, Ze piikaz solve mé jednu ,nepifjemnou“ vlastnost: v p¥ipadech, kdy nenalezne 7adné
feSeni, na vystup nic nevypise a prejde na dalsi radek.
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Nulové body:

solve(derl=0,x)

1

Prvni derivace je kladna (tj. funkee f je rostouei):

solve(derl > 0,x)

Prvni derivace je zaporna (tj. funkee f je klesajici):

solve(derl < 0,x)
RealRange( Open(0), Open(1))

Extréemy:

extremal f(x), { },x'bod")
{e}
bod
{{x=1}}

3. Vypocéteme f”(z) a do tfetice pouzijeme piikaz solve, ktery podobné jako poprvé
nezvladne vypocitat zkoumané nerovnosti. Jelikoz je vyraz er vzdy kladny, mtizeme
nerovnosti zjednodusit a hledat pouze znaménka vyrazu 3. Vyhodnocenim druhé de-

Obrdzek 2.44: Reseni piikladu 2.48 — bod 2.

rivace ve stacionarnim bodé x = 1 zjistime, Ze se jedna o lokalni minimum.

a3

&

der? i= 5 f(x)
dx

Nulove body:

solve(der2=0, x)

Druha derivace je kladna (tj. funkee f je konvexni):

solve(der? > 0, x)
Warning, solutions mav have been lost

mh’e(xg >0, x)
RealRange( Open(0), o)

Druha derivace je zaporna (tj. funkee f je konkavni):

solve(der? < 0, x)
Warning, solutions mav have been lost

mfve(xS < 0, xj
RealRange( - oo, Open(0) )

Extréemy:

eval(der2, x=1)

4. Pocitame diive uvedené limity a zjistujeme, Ze zadand funkce mé asymptotu se smérnici

Obrdzek 2.45: Reseni prikladu 2.48 — bod 3.

tvaru y = x + 1 a asyptotu bez smérnice v bodé x = 0 (obrazek 2.46).
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Se smernicn: Bez smernice:

Piedpokladime, e smérnice ma rovnici y=4A-x + B. | Oéekavat ji miizeme pouze v bodé nespojitosti.
Jeji obeeny tvarjex=K, K € K.

= fim LX)
4, = Jim, = m f(x) = o
1 x—0
A= lim f(x) lim f(x)=0
27 s ole x v =0
1

1
B, = 1_1‘111_1 (fl:r] —Az-x)
1

Asvmptota se smérnici bude jedna (. bude stejna pro
x —® aprox — - @), Bude mit tvary=x+ 1.

Obrdzek 2.46: Reseni piikladu 2.48 — bod 4.

5. Vykreslime graf funkce f(z). Pouzijeme k tomu piikaz plot, jemuZ nastavime néko-
lik nepovinnych parametri pro lepsi vzhled. Do grafu vykreslime zadanou funkci f
(Cervené) a asymptotu se smérnici y = x + 1 (zelené ¢arkované). Parametr discont
nastavime na true, aby byla spravné zobrazena nespojitost funkce f.

plot([ f(x),x+1].x=-3 .3,y=-5..10, color= [ red, green],
linestyle= [ solid, dash], thickness= [ 3, 2], discont= true)
10 4

Obrdzek 2.47: Reseni piikladu 2.48 — bod 5.
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Piiklad 2.49: Vysetfete priibéh funkce f(z) = 5.

Reseni:

1. Defini¢ni obor funkce f je celd mnozina redlnych cisel, tj. D(f) = R. K nalezeni
nulovych bodu a intervald, kde je funkce kladna, resp. zaporna, vyuzijeme klasicky
prikaz solve. Pro nalezeni nespojitosti pouzijeme opét prikaz discont.

flx) = — X . Znaménka:
© solve( f(x) < 0)
RealRange( - oo, Open(0) )
Nulove body:
solve( f(x) =0,x) solve( f(x) > 0)
0 RealRange( Open(0), o)
Prusecik s osou y Body nespojitosti:
(0
/() 0 discont( f(x).x)=1{}

Obrdzek 2.48: Reseni piikladu 2.49 — bod 1.

2. Postupujeme zcela analogicky pfedchozimu piikladu. D(f") = R

derl = dif{x) Prvni derivace je kladna (tj. funkee f je rostouci):
X

| \ 2 solve(der] > 0,x)
— =k RealRange( Open( -1), Open(1))

By

Sl (P41)

Prvni derivace je zaporna (tj. funkee f je klesajici):
Nulove body: solve(derl < 0,x)
RealRange( - o, Open( -1) ), RealRange( Open( 1), o)

solve(derl =0, x)
-1.1 Extrémy:

extremal f(x), { }.x'body")

{{x=-1}, {x=1}}

| =
| =

body

Obrdzek 2.49: Reseni piikladu 2.49 — bod 2.

3. Opét postupujeme stejné jako v prikladu 2.48. Tentokrat vsak ziskdvame nulové body
druhé derivace zadané funkce. Jak vidime z intervaltl konvexity a konkavity, vsechny
tfi ziskané body jsou body inflexni. Stacionarni body jsou dva, bod x = 1 je lokdlnim
maximem funkce f a bod r = —1 jejim lokdlnim minimem.
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der2i= 4 _f(x)
dx
_ 6x _+ 8x -
2 - 2
(¥+1)  (F+1)
Nulove body:
solve(der?2 =0, x)
0,/3.-/3

Druha derivace je kladna (tj. funkee f je konvexni):

solve(der? = 0, x)
RealRange( Open( -,/ 3 ), Open(0) ), RealRange( Open( /3 ), @)

Druha derivace je zaporna (tj. funkee f je konkavni):

solve(der? < 0, x)
RealRange( - @, Open( -/3 ) ), RealRange( Open(0). Open(,/3 ) )

Extréemy:

eval(der2,x=1)

IxJ|»—t

eval(derZ, x=-1)

h.;'l|»—L

Obrdzek 2.50: Reseni prikladu 2.49 — bod 3.

4. Urc¢ime asymptoty se smérnici a bez smérnice.

Se smernici:

A = lim L)
1 (e
0
4, = lim L)
- X —»-oo X
0

Predpokladame, 7e smérnice ma rovnici y=4-x + B. |Funkce je spojitd na celé mnoZiné R, a nema

Asymptota se smérnici bude jedna (tj. bude stejna pro
x — @ aprox — - ®). Bude mit tvar y=0.

Bez smernice:

tak asymptotu bez smérnice.

Obrdzek 2.51: Reseni piikladu 2.49 — bod 4.
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5. Vykreslime graf funkce f(x).

plot([ f(x),0].x=-10..10,y=-2 .2, color= [ red, green]|.
linestyle= [ solid, dash], thickness=[3,3])
2_

Obrdzek 2.52: Regeni piikladu 2.49 — bod 5.

Priklad 2.50: Vysetiete pribéh funkee:

(a) f(z) = (2% —1)3, (d) f(z) = sin(x) + =,
(b) Jo) = 2. In |z #0
(€) fla) =2, () 7o) = {0 =0

P1i vysetfovani pribéhu funkce nam mohou dale pomoci nékteré prikazy nachéazejici se
v baliku Student [Calculus1]. Predstavme si alespon nékolik z nich. Pfikaz FunctionChart
zobrazi graf funkce (zadané jako vyraz) s vyznacenim vyznamnych boda a funkénich vlast-
nosti. Na obrazku 2.53 je zobrazen graf funkce f(z) z ptikladu 2.48. Jsou v ném znazornény
extrémni a limitni body, monotonie funkce a konvexita s konkavitou. Pokud chceme zanést
do grafu méné informaci (pro vétsi prehlednost), miuzeme naptiklad vypnout zobrazovani
konvexity a konkavity nastavenim concavity = [].

Diky dal$imu piikazu, Asymptotes, ziskdme asymptoty funkce (zadané systému jako
vyraz) se smérnici 1 bez smérnice. Pouziti na funkcich z prikladi 2.48 a 2.49 ilustruje obrazek
2.54.

Do baliku Student [Calculus1] déle néalezi ptikazy CriticalPoints pro hledéani stacio-
narnich bodi, ExtremePoints pro hledani extrémi, InflectionPoints pro hledani inflex-
nich bodi, Roots pro hledani kofenti a dalsi. Vice v napovédé k baliku Student [Calculusi].
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with ( Student| Calculusl]) :
1

FunctioﬁChart[x- e’ .-3.3. slope= color( red,
blue), pointoptions = | symbolsize= 15, color

= black])

On the interval [ 3, 3], a chart of f{x) =x e;

1

F unct.iomChart[x-cx .3 .3, concavity=[ |, slope
= color(red, blue) , pointoptions = | symbolsize= 15,

color=black))

On the interval [ -3, 3], a chart of f{x) =x e*

Obrdzek 2.53: Pouziti prikazu FunctionChart z baliku Student [Calculus1].

with(Student| Caleulusl |) :

1
Asymprotes [x- e’ . x]

Asymptotes 2x . X
x+1

[y=x+1.x=0]

Obrdazek 2.54: Pouziti piikazu Asymptotes z baliku Student [Calculusi].

2.7 Integral funkce

2.7.1 Neurcity integral

Definice 2.19: Rekneme, %e funkce F(z) je na intervalu I primitiond funkei k f(x), jestlize

pro vSechna z € I plati F'(x) = f(z).

Poznamka 2.17: Ke kazdé funkci f(z) spojité na I existuje na intervalu I nekonecné

mnoho primitivnich funkeci lisicich se o tzv. integracni konstantu.

Definice 2.20: Mnozinu v8ech primitivnich funkei k funkei f(z) nazyvame neurcity inte-

/ f(z) de.

gral a znacime
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Poznamka 2.18: Nechf F(x) je primitivni k funkei f(x). Pak plati:

/f(:c) de = F(z)+ C,
kde C € R je integracni konstanta.

V systému Maple mame opét nékolik moznosti, jak spocitat integral ze zadané funkce,
presnéji Teceno, jak k této funkci urcit funkci primitivni. Systém Maple totiz k vysledkim
nepfidava integra¢ni konstantu (resp. ji poklada standardné rovnu 0), coz musime mit stale
na pameti.

Pii vypoctu mizeme vyuzit symbol pro integrovani z palety Expression, piikaz int,
jehoz parametry jsou vyraz, ktery chceme integrovat, a proménna podle niz integrujeme.
Nakonec mtzeme zapsat vyraz do dokumentu, kliknout na néj pravym tlacitkem mysi a z
kontextové nabidky zvolit Integrate a néasledné proménnou, podle niz chceme integrovat
(viz obrazek 2.55).

jxn dx

n+1
X

fm(xn: r)

nt+1

n+1
X

n+1

y integrate wrt x
X

Obrazek 2.55: Vypocet primitivni funkce.

K vypoctu integralt se nejcastéji pouzivaji 2 zakladni metody - metoda per partes a sub-
stitucni metoda.

Poznamka 2.19: Metoda per partes vychézi z pravidla pro derivaci soucinu. Jeji predpis
pro funkce u(z) a v(x) (které maji na daném intervalu spojité derivace) vypada néasledovné:

Substituéni metoda poskytuje FeSeni pro integraci slozené funkce. Jestlize F'(x) je primitivni
funkci k f(z) a funkce ¢(z) ma derivaci v kazdém bodé svého defini¢niho oboru, pak plati:

/f(sf)(w)) @' () dr = /f(t) dt = F(t) = F(e(x))
pii substituci t = p(z).
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2.7.2 Metoda per partes

Systém Maple obsahuje balik s ndzvem IntegrationTools. Pro aplikaci metody per partes
slouzi pfikaz Parts majici dva parametry — integral, ktery chceme urcit, a funkci, jejiz
derivaci chceme pocitat (v poznamce 2.19 tomu odpovida funkce u(z)). Pro zapis integralu
se v tomto piipadé pouziva prikaz Int®, ktery vytvoii integral symbolicky a nevyhodnoti jej
(narozdil od piikazu int). Pro vyhodnoceni symbolicky zapsaného vyrazu mizeme pouZit
prikaz value.

Pfiklad 2.51: Pomoci metody per partes urcete [z -e® du.

Reseni: V systému Maple pouZijeme vyse popsané piikazy. Pii aplikaci metody per partes
méame vzdy vice moznosti®, jak volit funkci, ktera se bude derivovat. Nékteré moznosti vedou
k cili, jiné ne, jak je vidét i na tomto feseni (obrézek 2.56). Druhé volba funkce, ktera se méa
derivovat, vedla k jesté vypocetné naroc¢néjsimu integralu, nez byl v zadani.

Naéteni baliku IntegrationT ools:
with( IntegrationTools )
| Change, CollapseNested, Combine, Expand, ExpandMultiple,

Flip, GetIntegrand, GetOptions, GetParts, GetRange,
GetVariable, Parts, Split, StripOptions|

Cheeme integrovat po ¢astech integral:
X
Im(x- €. x)

[ X 3
Xe ax

Nejprve zvolme x jako funkei, kterd se ma derivovat:

Parrs(fm(x-cx, r) x)
xe — ( & "x)

Nyni zvolme funkei €' jako funkei, ktera se ma derivovat :
Parrs(fm(x- g, xc) \ E:x)

L 2 x | L 2 X 4

X € Tx e dx

Fa Fe

Vyhodnoceni prvné ziskaného vysledku:
value( %%)

X X
Xe —¢€

Obrdzek 2.56: ReSeni piikladu 2.51.

Piiklad 2.52: Pomoci metody per partes uréete [ 2 - sin(z) d.
Resenid: Aplikujeme stejny postup jako v predchozim piikladu'®. PfestoZe zvolime vhodné
funkci, ktera se bude derivovat, nedospéjeme hned k vysledku. Metodu per partes je tieba

8Pozor na to, ze Maple rozlisuje mala a velka pismenal!
9Ve skutecnosti jich je nekoneéné mnoho.
10Pouze nebudeme nacitat balik IntegrationTools, nebot jsme jej nacetli jiz diive.
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v nékterych pripadech aplikovat vicekrat, a toto je pravé jeden z nich. Takze metodu per
partes aplikujeme na ziskany vysledek jesté jednou a ziskdme hledané feseni (které opét
vyhodnotime piikazem value).

[= Im(xz-sin(x}: x:)

e sin(x) dx
Parz.s( i, xz)

-cos(x) o [ (-2xcos(x)) x)

Metodu per partes aplikujeme jeité jednou...

Parts ( %6, x)
2 . :
—cos(x) x” +2xsin(x) + | (-2sin(x)) dx
a pomoci piikazu value uréime vyslednou hodnotu integralu:

value( %)

-cos(x) e + 2 xsin(x) +2cos(x)

Obrdzek 2.57: ReSeni piikladu 2.52.

2.7.3 Substituéni metoda

Pro aplikaci substitucni metody slouzi piikaz Change, opét z baliku IntegrationTools.
Ptikaz ma dva parametry (zcela analogicky k piikazu Parts) — integral, ktery chceme ur¢it,
a substituci, jiz zamyslime pouzit.

Zavedenim substituce prejdeme k jiné proménné, v niz také obdrzime vysledek. Na zavér
se proto musime ,vratit“ k proménné pivodni, coz provedeme zavedenim téze substituce (na-
zpét) pomoci pitkazu subs. Piikaz subs m4 2 povinné parametry — substituce, jez hodlame
zavést, a vyraz, v némz budou substituce aplikovany*!.

Pfiklad 2.53: Pomoci substituéni metody urcete [ sin®(x) - cos(z) dx.

Reseni: Postupujeme analogicky jako v pfedchozich piikladech. Pokud jsme pii pfedchozi
praci se systémem Maple nenacetli balik IntegrationTools, je tfeba jej nacist. Zavedeme
substituci, ziskame ,tabulkovy“ integral, ktery vyhodnotime piikazem value, a dalsi substi-
tuci se vratime k ptivodni proménné.

P1i vypoctech integralii se uplatnuji i nekteré dalsi postupy jako naptiklad rozklad na
parcialni zlomky, pravidlo o integraci sou¢tu funkci, ¢i pravidlo o integraci funkce nasobené
konstantou (podrobnosti najdeme téz v ndpovédé systému). Pro rozklad na parcialni zlomky
je mozné pouzit jiz diive zminény piikaz convert s parametrem parfrac.

1Upozornéme na rozdil mezi piikazy Change a subs. Piikaz Change zavede substituci proménnych v za-
daném integralu, zatimco prikaz subs provede substituce v zadaném vyrazu.
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Im( sing(x] -cos(x), x) |

sin(x}s cos(x) dx

Pouzijeme substituéni metodu:

Change(]m( sin® (x)-cos(x), x) ,t=sin(x) )

| 33 fals

Pomoci pitkazu value uréime hodnotu ziskaného integralu:

value( %)
1 4
7!

a pomoci piikazu subs se vratime k pivodni proménné:

subs(t=sin(x), %)

vy sin(x}4

Obrdzek 2.58: Reeni prikladu 2.53.

Priklad 2.54: Pomoci vhodné metody (resp. vhodného postupu) urcete nasledujici inte-
graly. Prikazem int nasledné ovéifte spravnost vaseho vypoctu.

a) [ 252 da, (&) [ zmg 4o

(b) [¥e=Zta gy, (h) [z-VaZ+1 de,
(c) [(z=1)-(z—2) (x—3)dr, (i) [ cos®(z) du,
(@) J e=nymap 9 () Ja-In(x) da,
() [ =t du, (k) [arctan(z) dz,
£) [cos(5 -z +6) du, 1) [a®- e do

Jiz jsme se setkali s vyukovymi nastroji pro vypocet limit a derivaci. Podobny nastroj je
k dispozici i pro integrovani. Spustime jej z hlavni nabidky zvolenim Tools > Tutors > Cal-
culus — Single Variable > Integration Methods.... Maplet nas krok po kroku povede
vypoctem zadaného integralu, nabizi tradi¢né napovédu k jednotliviym kroktm a pravidla,
ktera je mozno pouzit (viz obrazek 2.59).

2.7.4 Urcity integral

Definice 2.21: Méjme funkei f(x), kterd je ohrani¢ena na uzavieném intervalu [a, b]. Roz-
délme interval [a,b] na n podintervali a oznacme toto déleni d. Délku i-tého podintervalu
(pro i = 1,2,...,n) i samotny podinterval oznac¢me stejnym symbolem Az;. Ozna¢me dale
m; infimum f(z) pro z € Ax; a M; supremum f(z) na tomtéz intervalu. Nyni definujeme
dolni integrdalni soucet predpisem:

n
i=1
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m Calculus 1 - Integration Methods ﬂ

File Edit Rule Definition Apply Rule  Understood Rules  Help

Enter a function
’VFunction Isin(x)’\Z Wariable Ix froml tol Skart |
Jsfnzxdx
(1.1 cos(2x) | dx
2 2
=Jde+ L s dr ¥ Show Hinks et Hint |
2 2
1 1
= —x+ |-=—cos(2x) dx
2 2 Canstant Identity
1 1
=gx7 JCOS(Q x) dx Constant Mulkiple Surn
1 1 1 () d Difference Power
= —X-— | — cosl i) au
2 212 Parts Partial Fractions
= Lx_ L JCOS( u) du Change Rewert
2 4
1 1 Siolve Rewrite
- ? x- I sinu) Exponential Matural Logarithm
- Lx_ L SH‘!(ZI) <krig= |l <hwperbolic > |
2 4 <arckrig> | <archyperbolic = |
Flip Jain Split
Unda | Mext Step | Clase |

Obrazek 2.59: Vyukovy nastroj pro pocitani integralt.

a horni integrdalni soucet predpisem:

i=1

Definice 2.22: Necht plati pfedpoklady a oznaceni definice 2.21. Nyni definujeme dolnd
integrdl jako supremum vSech dolnich integrélnich souctt (pro rizné déleni d), tj.:

/b fx) dv = sup s(d)

a horni integrdl jako infimum vSech hornich integralnich souc¢tt (pro rizna déleni d), tj.:

b

/f(:c) dr = iIC}fS(d).

a

Definice 2.23: Jestlize plati:

/b oy o= [ o) a

a
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pak fekneme, Ze ohrani¢end funkce f(x) je na intervalu [a,b] integrovatelnd (resp. mé ur-
¢ity integral). Spoleénou hodnotu z predchozi rovnosti nazyvame Riemannovym integralem
z funkce f(z) na intervalu [a,b] a znacime:

/f(ac) dx.

a

Poznamka 2.20: (Newtonova-Leibnizova formule) Jestlize je funkce f(x) na intervalu
[a, b] integrovatelnd, funkce F'(x) na intervalu [a, b] spojita a primitivni k f(z), pak plati:

b
[ @) da =P, = FO) - Fla).

K vypoctu urcitého integralu systém Maple nabizi pfeddefinovany symbol v paleté Ex-
pression. Je mozné pouzit i pfikaz int podobné jako pro neurcity integral s tim rozdilem, ze
nyni pii specifikaci proménné, podle niz integrujeme, uvadime i jeji rozsah (rozsah integrace).

I'HI[XE: x=1 ..5)

b
Jx-exchc
a
b b
e —fa—e+b
ifm(x-ex,x=a..b)

a a h h
e —ea—e +e b

Obrazek 2.60: Vypocet urcitého integralu.

Je samoziejmé mozné vyuzit i Newtonovy-Leibnizovy formule, pricemz si pomiizeme
prikazem unapply pro prevod vyrazu na funkci. Na tomto prikladu si mizeme v§imnout, ze
riznymi postupy je mozné dojit ke stejnému, ale jinak upravenému vysledku.

Pro geometrickou interpretaci ur¢itého integralu a nazorné zobrazeni diive definovanych
pojmu (dolni integralni soucdet, horni integralni soucet, ...) poskytuje systém Maple piikaz
RiemannSum 7z baliku Student [Calculus1]. Piikaz ma dva povinné argumenty, a to funkci,
jiz chceme integrovat, a interval, pres ktery chceme integrovat. Pokud zadame jen tyto pa-
rametry, piikaz vypocita integralni soucet pro funkéni hodnoty ve stfedech podintervalii
vzniklych rozdélenim pivodniho intervalu a vypise hodnotu tohoto souctu. K dispozici je
vsSak nékolik parametri, které miizeme nastavit.

Prvnim je parametr method urcujici, jakou metodou budou voleny funkéni hodnoty v pod-
intervalech vzniklych z rozdéleni ptivodniho intervalu. Pro dolni integralni soucet pouzijeme
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Obrazek 2.61: Vypocet urcitého integralu pomoci Newtonovy-Leibnizovy formule.

nastaveni method=lower, pro horni integralni soucet nastaveni method=upper (zakladni na-
staveni odpovida zapisu method=midpoint). Dal§im parametrem je output (vystup). Pro
nas jsou zajimavé zejména moznosti output=plot (zobrazi funkci v grafu i s délenim pivod-
niho intervalu a zdkladnimi informacemi) a output=animation (vytvoii animaci sestavajici
output=plot pro riizné jemnd déleni piivodniho intervalu)'?. Nakonec
uvedme jesté parametr partition specifikujici déleni ptivodniho intervalu. Parametru je
mozné piiradit ¢islo (v tom pfipadé se puvodni interval rozdéli na zadany pocet stejné vel-

z graft v pripadé

F:= unappf}'[]xz dx, x)

3
F(5) —F(1)
124
3
F:= unappf}'[jx-ex clx:x)
x—=(-1+x) ¢

F(b) —F(a)

a

|{—1+b}eb—{—1+a}e

kych intervali) nebo seznam bodt, v nichz se méa ptuvodni interval rozdélit.

with ( Student| Caleulusl]) :
RiemannSum( 2—7 L +1lx+ 9, x=0 .4, method= upper, outpur=pfox)

An Approximation of the Integral of
fix) = x*3- T 2+1 1¥x+0
on the Interval [0, 4]
Using an Upper Riemann Sum
Area: 41 54560000

144 —

A .

Partitions: 10

f{x)

Obrazek 2.62: Geometricka interpretace urcitého integralu — vykresleni.

12V animaci tak miZeme sledovat, jak se pro riizné jemna déleni ptvodniho intervalu méni hodnota

aproximace integralu.
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with ( Student| Caleulusi]) :
RiemannSum( x3 -7 x2 + 11-x+ 9, x=0 .4, method= lower, partition
=[0,05,06,005,23,2.4,253.6,3.9.4]. ompm=ammazmn)

An Approximation of the Integral of
fix) = x"3-T*x"2+1 1 *x+9
on the Interval [0, 4]
Using a Lower Riemann Sum
Arear 31 33605555

144 T
1294 7 . g
1/
104
2 ™,
6
4 —
2 -
D T T T 1
] 1 2 3 4
_2 .
_44
Partiti ons: 2

f{x)

Obrdzek 2.63: Geometricka interpretace urcitého integralu — animace.

Pokud nechceme pouzivat prikaz RiemannSum, je mozné vyuzit dalsi z nastroji systému
Maple, ktery nalezneme v menu zvolenim Tools > Tutors > Calculus — Single Variable
> Approximate Integration.... V tomto mapletu (obrazek 2.64) mtizeme zadat funkei,
interval, pocet podintervalti tohoto intervalu a zvolit metodu, ktera bude pouzita k vypoctu
urc¢itého integralu. Na vybér mame pritom i nékolik dalsich metod kromé Riemannovych
souctii. Maplet také nabizi srovnani provedené aproximace integralu a jeho skutecné hodnoty.
Presto tento nastroj postrada nékteré moznosti, které nam poskytuje prikaz RiemannSum.

Piiklad 2.55: Pomoci vhodné metody (resp. vhodného postupu) aplikované pomoci exis-
tujicich prikazt urcete nasledujici integraly. Prikazem int nasledné ovérte spravnost vaseho
vypoctu.

1 In(3)
(a) [arctan(z) dz, (d) 25— du,
0 In(2)
9 . 2
®) [ w2z do (e) [ - cos(r) dr,
0
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F1aCalculus 1 - Approximate Integration x|

File Help
B Flc-t Wfindom ~Entet a function, interval, and number of partitions
1 Fx) = [sin(x)
a=po b= IPi
& n=[t0
064 r Riemann Sums
" upper { lower = random
0.4+ " left % midpaint € right
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Bpproximatelrt(sin(=), 0. .Pi, 'partcition' = 10, 'method' = midpeire, 'partitiortype' = nomial, 'outpuae! = 'plet!, 'howeprions!' =
['£illed" = ['transparency'=.5]]]:

Obrdzek 2.64: Maplet pro ptiblizny vypocet urcitého integralu a jeho geometrické interpretace.

2.7.5 Aplikace urcitého integralu
Obsah plochy

Jiz z geometrické interpretace urcitého integralu vidime jednu z jeho moznych aplikaci pro
feSeni praktickych tloh, a tou je vypocet obsahu plochy vymezené dvéma (pfipadné i vice)
kiivkami.

Poznamka 2.21: Nechf f(z) je na intervalu [a, b] nezdpornd integrovatelna funkce. Pak
pro obsah S plochy vymezené funkei f(z), osou z a pfimkami 2 = a, x = b plati:

b
S = / f(z) dx.
Pokud je naopak funkce f(z) na tomto intervalu nekladnd, pak pro obsah S plochy vymezené
tymiz krivkami plati:
b
S=- / f(z) dx.

7 predchozi poznamky miizeme odvodit i jak pocitat obsah plochy v piipadé, kdy funkce
f(z) na intervalu [a, b] protind osu x (interval rozdélime na podintervaly, v nichz je funkce
nezapornd, a podintervaly, v nichZ je nekladna). Podobné mtizeme odvodit, ze pro vypocet

obsahu S plochy vymezené funkcemi f(x),g(x) (f(z) > g(z)), a pfimkami z = a, x = b
plati:

5= / (f(z) - g(x)) de.
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Piiklad 2.56: Urcete obsah plochy vymezené kiivkami 22 a 3.

Reseni: V zadani piikladu neni zminén interval, na kterém se plocha nachazi, nebot in-
terval ur¢i samotné k¥ivky 22 a 22 protinajici se pravé ve dvou bodech. Soufadnice priiseciki
na ose x tvori hledané body a a b. Priseciky zadanych funkci zjistime napi. prikazem solve.
Poté stacéi pouze ,dosadit do vzorecku“!3. Plochu, jejiz obsah po¢itame, miizeme zobrazit téz
graficky. K vybarveni plochy mezi funkcemi vyuzijeme ptikaz transform z baliku plottools.
Definujeme si zobrazeni 2 — 3, které s pomoci piikazu transform vykreslujeme ,vyplnéné
(filled) od kiivky z* ke kiivce 2%“ (viz obrazek 2.65).

Sofve{xz =X )

0.0,1

1
S5

pl = pfaz( [x{ X ]_. x=0..1, color="NavyBlue", thickness = 2) :
[ = plottools| transform | ( (x,¥) —>[x_. v+ x3]) :

p2 = pfaz(x2 - x3, x=0..1, filled= true, color= cyan) :

plots[ display| ([ p1,f(p2) ])
1_

0.5
0.6+
0.4

0.2+

Obrdzek 2.65: ReSeni prikladu 2.56.

Funkce je mozné zadavat téZ parametricky, a to napiiklad rovnicemi x = ¢(t),
y=1(t),t € [a,].

13Jesté je tieba védét, kterd ze zadanjch funkci je na ziskaném intervalu ,vétsic.

76



Poznamka 2.22: Necht je funkce f zadana rovnicemi

x=p(t),y =1(t),t € [a,b], pficemz funkce ¢(t),1(t) jsou spojité pro t € [«, []. Je-li p(t)
ryze monotonni a ma spojitou derivaci na [a, b], pficemz ¢(a) = a, () = b, pak pro obsah
S plochy vymezené funkci f(z), osou z a pfimkami z = a, x = b plati:

S = / (1) - (1) di].

«

Priklad 2.57: Urcete obsah plochy vymezené osou x a funkci zadanou rovnicemi
x=1t—sin(t),y =1 —cos(t),t € [0,2 - ].

Reseni: Funkce x = ¢ —sin(t) je na [0,2- 7] ryze monotonni a m4 spojitou derivaci, takze
miizeme vyuzit predchozi poznamku. Pii vykreslovani plochy se nyni obejdeme bez piikazu
transform, pouze vyuzijeme atributu filled, jenz nastavime na hodnotu true. Tim dosdh-
neme vykresleni plochy pod kfivkou funkce az k ose x. Pro pfehlednéjsi zobrazeni vytvoiime
dva grafické objekty, které pomoci ptfikazu display vykreslime do jednoho obrazku. Sou-
Casné nastavime atribut scaling na hodnotu constrained, abychom meéli na obou osach
stejné métitko (a graf funkce tak nebyl zkresleny).

2

S=J {l—cos{r]}-%{r—sin{z}}dr
0
5=

L¥%)

T

(3=

pl :==plot([t—sin(t). 1 — cos(t),t=0.2-x|, scaling= constrained.

color = "NavyBlue", thickness=2) :

p2 :=plot([t—sin(z).1 —cos(z),2=0..
filled = true, color= cyan) :

plots[ display] ([ pl.p2])

b2

-1t|, scaling= constrained,

Obrdzek 2.66: Reseni ptikladu 2.57.

Priklad 2.58: Urcete obsah plochy ohranic¢ené kiivkami:

(a) y=4— 22, y =22 (d) y=tan(z),y=0,2 =1,
(b) y:x?)ay:_x?y:l;

— e — e 7 :2
() y=22 o= (6) y=e"y=e"y



Priklad 2.59: Urcete obsah plochy ohranicené:

(a) funkei y = 2% — 2 -z + 2, jeji tetnou v bodé [3, 5] a soufadnymi osami,
(b) funkci y = z* a tefnou v bodé x = 1,

(c) parabolou y = 2 — 6 - x + 8 a tetnami v bodech [1,3] a [4,0].

Priklad 2.60: Urcete obsah plochy ohrani¢ené osou x a kiivkou zadanou parametricky:
(a) 2 =312, y=3-t—t3t € [-V3,V3,
(b) =2 (t—sin(t)),y =2 (1 —cos(t)),t € [0,2 - 7],
(c) x =3-sin®(t), y = 3-cos®(t),t € 0, 7).

Priklad 2.61: Odvodte vzorec pro obsah kruhu o poloméru r.

Délka oblouku krivky

Poznamka 2.23: Necht mé funkce f(x) spojitou derivaci na intervalu [a, b]. Pak pro délku
kiivky [ funkce f(z) od bodu a k bodu b plati:

l:/\/1+(f’(:c))2 iz

Poznamka 2.24: Necht je funkce f zaddna parametricky rovnicemi z = ¢(t),y = (t),t €
[, ], pficemz funkce ¢(t),1(t) maji spojité derivace pro t € |«, 5]. Pak pro délku kiivky [

funkce f od a k (§ plati:
B
1= [Vw®r+we)

Piiklad 2.62: Urcete délku kiivky funkce y = In(z) mezi body = =1 a x = 10.
Reseni: Funkce (In(x))’ = % je spojitéd na [1,10], miZeme tedy vyuZzit pozndmky 2.23
(obréazek 2.67).

Piiklad 2.63: Urcete délku kiivky zadané parametricky rovnicemi x = cos3(t), y = sin®(¢),
te|0,2-m.

Reseni: Funkce cos®(t), sin®(t) maji na intervalu [0, 2 - 7] spojité derivace, takze mfizeme
vyuzit poznamky 2.24 (obrazek 2.68).

Priklad 2.64: Urcete délku kiivky:

3

(a) y* = 2® na intervalu [0, 1],

(b) y = <% na intervalu [—1, 1],
(c) y= sm( ) na intervalu [0, 7],
)

(d) y = sin®(z) na intervalu [0, 7].
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10

1

4 e

—In(x

dx

}]h dx

I=-J2 + arctanh[ % \.ff?] +4 101 — arctanh[ ﬁ V101 ]
evalf (%)
[=0.417201566
plot(ln(x),x=1..10, color="NavyBlue", thickness=2)
2_
151
1_
051
i/ — —— —— .
1 2 3 4 5 & T & & 10

T ..J'C]: color="NavyBlue", thickness=2 )
1

pi’or( [ ccs{x}sr sin{x]{ x

Obrdzek 2.68: Reseni prikladu 2.63.
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Priklad 2.65: Urcete délku kiivky zadané parametricky:
(a) z=1% y=t— L, tc[0,V3
(b) z =t-cos(t), y=1t-sin(t), t € [0,4 - 7],

(c¢)  =cos(t) +t-sin(t), y = sin(t) —t - cos(t), t € [0,2 - 7.

Priklad 2.66: Odvodte vzorec pro délku kruznice o poloméru r.

Objem rotac¢niho télesa

Poznamka 2.25: Necht je funkce f(z) spojitd a nezapornéd na intervalu [a,b]. Pak ro-
tacni téleso vzniklé rotaci kiivocarého lichobéznika ohrani¢eného shora funkei f(x), osou z
a pfimkami x = a, x = b kolem osy x ma objem V:

V:wl/F@Mm

a

Poznamka 2.26: Necht je funkce f zadana parametricky rovnicemi x = p(t),y = ¥(t),t €
[, B], pficemz funkce o(t) mé spojitou derivaci pro t € [a, 3] a funkce () je spojité
a nezaporn pro t € [«, §]. Pak pro objem V rotacniho télesa vzniklého rotaci oblasti z €
[o(a), o(B)] ay € [0,1(t)] kolem osy z plati:

B

Ver. / B 9] dt.

«

Priklad 2.67: Vypoctéte objem télesa, které vznikne rotaci oblasti ohrani¢ené kiivkami
y =22, y =2 — 22 kolem osy z.

Reseni: Objem budeme pocitat podobné, jako kdyZ pocitame obsah plochy vymezené
dvéma krivkami. Pfesnéji feceno: vypocteme objem rota¢niho télesa, které vznikne rotaci
funkce y = 2 — 22 kolem osy z, a od néj ode¢teme objem télesa, které vznikne rotaci funkce
y = 2 kolem osy x. Jelikoz obé funkce splituji pfedpoklady poznadmky 2.25, miize k vy-
poc¢tu objemu pouzit uvedeny vztah. V systému Maple miizeme jednak vykreslit zadanou
oblast, kterd ma rotovat kolem osy z, jednak mtzeme vyuzit ptikazu plot3d pro vykreslo-
vani trojrozmérnych grafti. Nastavenim parametru coords=cylindrical vytvofime rotacni
téleso vzniklé rotaci kolem jedné z os. Dale nastavujeme parametry jako tihel, o néjz ma za-
dand (resp. zadané) funkce rotovat, a interval oblasti. P¥ikazu display nakonec nastavime
parametr orientation pro ndzornéjsi zobrazeni (pootoceni grafu), obrazek 2.69.

Poznamka 2.27: Mgjme funkci zadanou parametricky rovnicemi x = f(t),y = g(t),z =
h(t),t € [a, §]. Pak téleso vzniklé rotaci této funkce kolem osy z je popsdno parametricky
rovnicemi = = f(t),y = \/g(t)? + h(t)? - cos(s),z = /g(t)? + h(t)? - sin(s),t € [, (],s €
0,2 - 7).
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2 2 = R 2 2 = 2. =
V=J'C-J (2—.&:2) dr _E'j (XE) dr P pi’oz.?d([_ x:x]:ﬁ 0.2-mx=-1.1,
-1 -1 axes = frame, coords = cylindrical ) :

16 plots| display]( p, orientation= [ 90, 0, 120])

2 2 3 3
pl = pi’m[ [x 2—x ], x=-—- .~ color="NavyBlue", zhz’ckne.s.s=2] :

f:= plottools| xran.sfbrm]( (x.¥) — [1: y+ rz]) :

p? :=pi’az(2 -2 xzrx=—1 .1, filled= true, co!or=cyan) : o
plots| display] ([ pl1.f(p2) 1)

Obrdzek 2.69: ReSeni prikladu 2.67.

Priklad 2.68: Vypoctéte objem télesa, které vznikne rotaci plochy vymezené kiivkou za-
danou parametricky rovnicemi x =t —sin(t),y = 1 —cos(t),t € [0,2 - 7] a osou x kolem této
0sy.

Reseni: Zadana kiivka spliiuje predpoklady poznamky 2.26. Vypocet objemu tedy pro-
vedeme dosazenim do prislusného vzorce. V systému Maple opét vykreslime zadanou oblast,
ktera ma rotovat kolem osy x, a poté i ziskané téleso pomoci piikazu plot3d. Ptitom vy-
uzijeme poznamky 2.27. Podobné jako v predchozim prikladu pouzijeme piikaz display
s nastavenim parametru orientation pro nézornéjsi zobrazeni (pootoceni grafu), obrazek

2.70.

Priklad 2.69: Urcete objem télesa vzniklého rotaci plochy ohranicené zadanymi kfivkami
kolem osy z:

(a) y* =z, y =27 () y=z,y=1,y=2
(b) y =0,z =0, y=sin(x), z =T, (d) 22 +y* =4, 2+y=2.

Priklad 2.70: Urcete objem télesa, které vznikne rotaci plochy ohranicené kiivkou zada-
nou parametricky a osou x kolem této osy:

() v=t, y=t-5, te0,v3]
(b r=3- Sin3<t)7 y=3- COS3(t)7 te [_%7 %],

)
(c) x =sin®(t), y = 1 — cos(t), t € [0, 7],
)
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2m 21 d pi=plot3d([t —sin(z), (1 —cos(t))-cos(s), (1 —cos(t)) -sin(s) ].
V=J'c-[ (1 —cos(t)) -|—=— (t—sin(z))|dt 5=0.2-mt=0. 2% axes=frame, labels=["x","y", "z"]) :
0 dr plots| display] ( p, orientation= [ 90, 0, 160])

pl = plot([t —sin(t),1 —cos(t),t=0.2-1], scaling
= constrained, color = "NavyBlue', thickness=2) :

p2 =plot([t —sin(t),1 —cos(t),t=0.2-1], scaling
= constrained, filled= true, color= cyan) :

plots[ display] ([ pl.p2])

2

15 .

1

0.5 ——

o T T T T T T x z

Obrdzek 2.70: Reeni prikladu 2.68.

Priklad 2.71: Odvodte vzorec pro objem koule o poloméru r.
Priklad 2.72: Odvodte vzorec pro objem valce o poloméru podstavy r a vysce valce v.
Priklad 2.73: Odvodte vzorec pro objem kuZzele o poloméru podstavy r a vysce kuzele v.

Obsah plasté rotac¢niho télesa

Poznamka 2.28: Necht je funkce f(z) spojitd a nezdporna na intervalu [a,b] a mé zde
spojitou derivaci. Pak pro obsah S rota¢ni plochy vzniklé rotaci kiivky y = f(z) kolem osy
x plati:

S=2.7- /f 1+ (f@) d

Poznamka 2.29: Necht je funkce f zaddna parametricky rovnicemi x = p(t),y = ¥(t),t €
la, 3], pficemz funkce o(t) a ¥ (t) maji spojité derivace pro t € [a, 3] a funkce (1) je
nezapornd pro t € [«, 3]. Pak pro obsah S rota¢ni plochy vzniklé rotaci grafu funkce f kolem
osy x plati:

—w/w (1) + (V/(1))* d

Priklad 2.74: Vypoctéte obsah plasté rotacniho kuzele, ktery vznikne rotaci funkce y = x
pro x € [0, 3] kolem osy .

Reseni: Jelikoz plati vSechny pfedpoklady poznamky 2.28, staéi dosadit do uvedeného
vzorce (obrazek 2.71).
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3

S=2-E-J x [ 1+ [%(r}]z dx -

— - 3 d 3 2 d .3
0 Smon/T S—2.rc.J sin (I]-‘/[E(cos (!))] + [E(sm {x]]] dr

pi= pforj’d(x_. 6=0.2-m x=0.3, ares=frame,
coords = cylindrical, labels= [ "x","y", "2"]) : 3 3 3

plots[ display] ( p. orientation= [ 90, 0, 120]) p= pfozSd( [cos (r).sin”(t) -cos(s), sin” (1) -sin(s) ]:52 0.2-m
t=0 .. T, axes= frame, labels=["x", "v", "z"]) :

plots| display] ( p. orientation= [ =90, 0, 20])

N LR A R A |
-1 -0.3 0 [ 1-0350051

X z

Obrdzek 2.71: Reseni piikladu 2.74. Obrdzek 2.72: Reeni piikladu 2.75.

Priklad 2.75: Vypoctéte obsah plasté télesa, které vznikne rotaci kiivky zadanou para-
metricky rovnicemi x = cos?(t),y = sin®(t),t € [0, 7] kolem osy z.

Reseni: Zadana kiivka spliiuje vSechny pfedpoklady pozndmky 2.29. PouZijeme proto
ptislusny vztah pro vypocet obsahu plasté (obrazek 2.72).

Priklad 2.76: Urcete obsah plasté télesa vzniklého rotaci plochy ohrani¢ené zadanymi
kiivkami kolem osy x:

Priklad 2.77: Urcete obsah plasté télesa, které vznikne rotaci plochy ohranic¢ené krivkou
zadanou parametricky a osou x kolem této osy:

)=t y=t—"L2 tc[0,V3]
x=3-sin’(t), y = 3-cos’(t), t € [-F, 3],

)
(c) z =sin®(t), y =1 —cos(t), t € [0, 7],
)
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Priklad 2.78:

Odvodte vzorec pro povrch koule o poloméru r.

Priklad 2.79: Odvodte vzorec pro povrch véalce o poloméru podstavy r a vysce valce v.

K predeslym aplikacim urc¢itého integralu poskytuje systém Maple nékolik nastrojt z ba-
liku Student [Calculusl]. Tyto néstroje je mozné pouzivat jednak jako ptikazy prislusné
knihovny (baliku) nebo je spoustét jako maplety z hlavniho menu (Tools > Tutors >
Calculus — Single Variable). Jmenovité jde o Arc Length (délka kfivky), Surface of
Revolution (obsah plasté rotacniho télesa) a Volume of Revolution (objem rota¢niho
télesa). P¥i pouziti prikazii mtizeme mimo jiné specifikovat parametr output urcujici, zda pfi-
kaz vypiSe vyslednou hodnotu, vzorec s integralem nebo vykresli obrazek (v pfipadé piikazu
VolumeOfRevolution je k dispozici i animace). Maplet po zadani predpisu funkce a integrac-
nich mezi provede vypocet odpovidajiciho integralu, ktery doprovodi grafickym zobrazenim.
Obréazek 2.73 ukazuje maplet pro vypocet délky kiivky.

E'E Calculus 1 - Arc Length

File Help

~ Plot Window

\

I

L L\Lh =% =1 3 O
i i L L

[

Calor Legend For Plot

Fizc
integrand

arc length function

~Enter a function and an interval [a,b]

fix) =

a=[-2

—arc Length

Display I

Plot Options |

Close |

~ Maple Command

ArcLengthix*t, - &,

Vgiem!'=[-&. .. &,

-4

4.89], 'coordinates'=rartesian, 'oobpart'='plak'] s

Obrazek 2.73: Pomocny nastroj pro vypocet délky krivky.

2.7.6 Nevlastni integral

Definice 2.24: Necht je funkce f(x) integrovatelné v kazdém intervalu [a, t], kde a < t < b,

a necht je f(z) neohranicend v levém okoli bodu b. Existuje-li vlastni limita lim
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b
pak Fekneme, Ze integral [ f(z) da konverguje, a klademe

t

b
/f(a:) dx = tlir& f(z) dx.

b
Pokud zminén4 limita neexistuje nebo je nevlastni, fikdme, ze integral [ f(z) dz diverguje.
a

Poznamka 2.30: V pfipadé neohranicenosti funkce f(z) na intervalu [a,b] v pravém okoli

b
bodu a definujeme integral [ f(z) dx analogicky.

Priklad 2.80: Urcete dz.

1
1

[t

Reseni: V systému Maple obdrzime feSeni automaticky pouhjm zaddnim integralu a pro-

ﬁ) neni v bodé 1 spojita

vedenim prikazu. Musime si vSak uvédomit, ze zadana funkce
a na intervalu [0, 1] ohrani¢end! Spravné bychom se tedy méli o ziskaném vysledku presvédcit

urcenim limity z definice 2.24.

arcsin(b)

arcsin( 1)

u|.—.
]

Obrdzek 2.74: Reseni ptikladu 2.80.

1
Priklad 2.81: Urcete [z -In(z) du.
0

Poznamka 2.31: Pokud je funkce f(z) neohranicend na intervalu [a,b] v pravém okoli
bodu a i v levém okoli bodu b, rozdélime interval [a, b] libovolnym bodem ¢ € (a,b), ¢imz
prejdeme k pfipadiim popsanym v definici 2.24 a poznamce 2.30.

Definice 2.25: Necht je funkce f(z) integrovatelnd v kazdém intervalu [a,b], kde a < b.
b

Existuje-li vlastni limita blim [ f(z) dz, pak Fekneme, Ze integrdl [ f(z) dx konverguje,
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a klademe

b—o00

7f(x) do = lim/bf(x) dz.

Neexistuje-li zminénd vlastni limita, fikame, Ze integral [ f(z) dz diverguje.
a

b
Poznamka 2.32: Analogicky definujeme nevlastni integral [ f(z) dz. Je-li funkce f inte-

—0o0
0
grovatelnd na kazdém omezeném intervalu, pak Fekneme Ze integral [ f(z) dx konverguje,
— 00

jestlize pro néjaké a € R konverguji oba nevlastni integraly [ f(z) dz, [ f(z) dz a klademe

7f(95) dx = /af(x) dx+7f(x) dr.

[e.9]

Priklad 2.82: Urdete [ &5 du.
2
Reseni: V systému Maple obdrzime FeSeni opét automaticky pouhym zadanim integralu
a provedenim ptikazu. Jako v pfedchozim pripadé bychom si vSak méli uvédomit, zda existuje
b
vlastni limita blggo ‘2[ I—IQ dx. Pti vypoctu limity Maple zahlasi, ze neumi urcit, jestli b < 0.

Je mozné mu ,pomoci“ zavedenim predpokladu, ze b > 0, pomoci piikazu assume (obrazek
2.75).

o=

limJ L&
b—»ooj X

Warning, unable to determine if O
is between 2 and b; try to use
assumptions or use the
AllSolutions option

1

2

assume(b > 0)

b
tim “ L,clx}
oo 2

2

0| —

Obrdzek 2.75: ReSeni prikladu 2.82.

Priklad 2.83: Urcete nasledujici integrély:
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o0

(a) lf\/iE du, (c) jfosin(ﬁ) dr,

o0

(b) | 7= dr, (d) [ 2 da,
—00 0

Doposud jsme se setkali pouze s ptiklady, kdy Maple umi nalézt symbolické feSeni (pii
pouziti ,standardnich“ funkei). Jsou vsak pfipady, kdy Maple zavadi funkce nové ¢i symbo-
lické feSeni nenalezne. Pokud Maple zahrne do vysledku novou funkci, najdeme jeji predpis
v napoveédé. Napiiklad na obrazku 2.76 je v TeSeni zahrnuta tzv. chybova funkce erf (x)

s predpisem
2. ( J et dt)
0

erf(z) = Nz

Jestlize Maple nenalezne symbolické Teseni, vypiSe nami zadany piikaz jako vysledek.
V piipadé urcitého integralu muzeme hledat numerické feseni, a to bud pfidanim nepo-
vinného parametru numeric piikazu int, nebo pouzitim piikazu evalf na integral zadany
ptikazem Int!4. Numerickych metod pro vypodet uréitého integralu nabizi Maple né&kolik.
Mezi nimi je mozné volit specifikaci parametru method (vice v napovédé systému).

. 2
J‘e dx fm(e Yox=0.1, nume}‘ic)
1 — 0.7468241328
— 4 ® erf(x) 2
2 eva{f(fm(e ,x=0 1))
0.7468241328
2
J‘e_Jk In(x) dx
[e n(x) dx i
1, fm(e_xk-ln(x]: x=0..1, numeric, method= _Dexp)
[ ey -0.9059404763
0
1 — -
Serf(l)yxw eva{f(fm(e n(x),x=0..1, method= _Gguad))
X - -0.9059404763
2
J‘ e -In(x) dx
0
I o
[ e ln(x) dx
0

Obrazek 2.76: Symbolickd a numericka integrace.

14Upozornéme na rozdil v zadani evalf(Int(..)) a evalf(int(...)). Prvni moZnost vede na nume-
rické feseni zadaného integralu, v druhém pripadé je nejprve vyhodnocen integral symbolicky pfikazem int
a nasledné vysledek preveden na numerickou hodnotu piikazem evalf.
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3 Matematicka analyza s Maple v R"

Ackoli v sobé nazev kapitoly obsahuje prostor R”, ¢asto se budeme omezovat na funkce dvou
proménnych, tedy prostor R?, pro néjZz mame v systému Maple grafickou podporu.

3.1 Funkce vice proménnych

3.1.1 Definice funkce vice proménnych

Funkci vice proménnych definujeme v systému Maple zcela analogicky k funkci jedné pro-
ménné (viz 2.2.1). V prostiedi Standard Worksheet pouzivame tytéz postupy, pouze ,prida-
vame“ promeénné.

flry) =+ +y /(0.1)
(ry) =+ !
g(0,1)
g=(xy) >xX +y !
(x. m"l—}\’j-l-v h(0.1)
LT undefined
h(-1.1)
h == (x,v) —piecewise(x < 0,-x, x-y < 0,-y, undefined) 1
(x.y) —piecewise(x < 0, -x,xy < 0, -y, undefined)  |h(1,-1)
1

Obrazek 3.1: Definice funkce dvou proménnych.

3.1.2 Vykresleni funkce dvou proménnych

V zavéru predchozi kapitoly jsme se jiz setkali s pfikazem plot3d pro vykreslovani trojroz-
meérnych graf. V systému Maple mame tedy moznost vykreslovat funkce dvou proménnych,
a to opét podobnymi postupy jako v piipadé funkce jedné proménné. Prvni zpiisob nabizi
kliknuti pravym tla¢itkem na funkeci (resp. vyraz) dvou proménnych v dokumentu a zvoleni
Plots > 3-D Plot se specifikaci proménnych. Dalsi moznost poskytuje pomocnik zvany
PlotBuilder a nakonec mame k dispozici jiz zminény pfikaz plot3d.

Narozdil od vykreslovani funkci jedné proménné Maple nyni v grafu standardné nezobra-
zuje soutadnicové osy. Pokud je chceme zobrazit (a na vybér mame z nékolika typtu: normal,
boxed, framed), je tfeba pfi tvorbé grafu specifikovat parametr axes. Graf je mozné upra-
vovat i po jeho vytvoreni kliknutim pravého tlac¢itka mysi a volenim pozadovanych parametrii
grafu z kontextové nabidky. Kliknutim na graf a pfidrzenim levého tlacitka mysi mizeme
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14

fi=(xpz) ﬁpiecmt'ise(x <0AYy<0Az< D,xz_.x-y-z)

X, V., z) = piecewise| x < (0 and 1'<Oandz<0‘x{xvz
(x.».2) —=p ( ) L X7, X)

f:: {-'f:}'.-z: H_."L’} _>x2 +}'2 +zu—v
(x. 0z, u,v) —o? -I-}'2 +zu—v
£(1,2.3.4.5)

12

Obrazek 3.2: Definice funkce vice proménnych.

s grafem funkce otacet podle pohybti mysi, pfipadné provadét dalsi upravy, které si predem
vybereme v kontextové listé, resp. kontextovém menu.

Rozdil mezi pfikazy plot a plot3d je také v povinnosti specifikovat rozsah nezavisle
proménnych. Zatimco u piikazu plot se pouzije standardni interval [—10, 10] pfi nezadani
rozsahu, prikaz plot3d zadani rozsahu vyzaduje pro obé€ nezavisle proménné, jinak se ne-
provede a vypise chybové hlaseni.

Stejné jako v pripadé funkce jedné proménné musime i zde myslet na to, jak ma graf
funkce vypadat a pfipadné vyzkouSet riznéd nastaveni parametri (tj. napf. rozsahil neza-
visle proménnych), abychom dostali ndzorny graf. Néktera zobrazeni mohou velmi zkreslovat
(resp. zobrazovat graf funkce chybné).

Systém Maple kvili efektivité (rychlosti) vykreslovani po¢itd funkéni hodnoty! jen v ,né-
kolika“ bodech. Graf byva zpravidla rozdélen na ¢tvercovou sit bodi, v nichZ je spocitana
odpovidajici (funkéni) hodnota. Parametry sité se pro rtizné typy grafi 1isi, napiiklad pro
piikaz plot3d je standardné pouzita sit 25x25 bodt, pro piikaz implicitplot sif 26x26
bodu atp. Zbylé body grafu jsou ziskané linearni (rovinnou) interpolaci.

Pokud chceme po systému presnéjsi zobrazeni, mame nékolik moznosti. Prvni je omezeni
rozsahtl nezavisle proménnych (viz obrazek 3.4). Mizeme také nastavit parametr numpoints
urc¢ujici, v kolika bodech bude vypocitana (funkéni) hodnota. Dalsi mozZnosti je nastavit ex-
plicitné sit poc¢itanych bodi pomoci parametru gridlines. Ten specifikujeme dvojici v hra-
natych zavorkach: [pocet bodl na ose z, pocet bodt na ose y|*.

Ve skute¢nosti nemusi jit jen o funkéni hodnoty, vykreslovat mtzeme napiiklad i hodnoty vyhovujici
néjaké rovnosti (nerovnosti).

2Ptikazu implicitplot je mozné navic nastavit parametr gridrefine, ktery ,zjemiiuje“ sit pocitanych
bodu. Standardni nastaveni je 0. Nastaveni na hodnotu 1 (zjednoduSené) znamend, Ze misto jedné (funkéni)
hodnoty v daném misté sité budou urceny dvé funkéni hodnoty. Pfi dalsim zvySovani hodnoty parametru
gridrefine se vzdy rekurzivné pocitaji dvé nové (funkéni) hodnoty misto jedné predchézejici. Vice informaci
nalezneme v napovédé k prikazu implicitplot.
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pfoz.?d(xz +yx=-5.5,y=-5.5 axes= narmaf)

-,

pfar.?d(xz +yx=-5.5,y=-5.5, axes =ﬁ‘amed)

pfoz.?d(xz +yx=-5

Obrazek 3.3: Vykresleni funkce dvou proménnych pomoci ptikazu plot3d.

pfor.?d[ L,x=—5 S5,y=-5.5, are.5'=ﬁ‘amed]

Xy

& 107!
6.2 107!
4. 107!
2. 107!
-4 lll..ll 3 -4
-2 e -1
0 s
. R .\
7R 2
434

pfoz.ﬁ‘d[ L_. x=-3.3,y=-3.3, ax:es=ﬁ‘amed]

Xy

Obrazek 3.4: Ukazka rtznych nastaveni pfikazu plot3d.
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pfor.?d[ L:x=—5 .5, y=-5 .5, axes=framed, pfor.?d[ L_. x=-5.5,y=-5.5, axes= framed,

x.}l x.}:

grid=[40,40] ] HUMpoTnts = IDODJ

Obrazek 3.5: Ukazka dalsich nastaveni prikazu plot3d pro presnéjsi vykresleni.

3.1.3 Defini¢ni obor funkce dvou proménnych

Systém Maple nam dava moznosti, jak zakreslit do grafu dvourozmérnou (pfipadné i t¥iroz-
mérnou) oblast. K zakresleni dvourozmérné oblasti zadané implicitné (rovnosti ¢i nerovnosti)
slouzi prikaz implicitplot z baliku plots. Pokud chceme zadanou oblast vyplnit, nastavime
parametr filled na hodnotu true.

Pro vykresleni oblasti vymezenych vice nerovnostmi (resp. rovnostmi) je nutné pouzit jiny
postup (naptiklad takovy, ktery jsme pouzivali k vykreslovani ploch v sekei 2.7.5). Pokud je
oblast vymezena linedrnimi nerovnostmi, je mozné pouzit piikaz inequal z baliku plots.

Pfiklad 3.1: Nakreslete oblast A = {(z,y) € R? : 22 + 3y < 1}.
Reseni: Pouzijeme piikaz implicitplot, kterému navic specifikujeme i parametr view
pro rozsah soufadnych os® (obrézek 3.6).

Priklad 3.2: Nakreslete oblast A = {(z,y) € R?: |z| + |y| < 1}.

Reseni: Pravé v tomto piipadé se projevi nedostateny pocet generovaych bodi pro
vykresleni zadané oblasti. Vyuzijeme proto parametru gridrefine, ktery poskytuje ptikaz
implicitplot (obrazek 3.7).

Priklad 3.3: Nakreslete oblast A = {(z,y) e R?* : 2 >0,y > 0,z +y < 1}.

Reseni: Pozadovana oblast je zaddna tfemi nerovnostmi, pficemz vSechny jsou linedrni.
Vyuzijeme proto ptfikazu inequal. Piikaz ma nékolik nepovinnych parametrii, v nichz mu-
zeme napfiiklad specifikovat barvu, kterou budou vykreslovany body pat¥ici (resp. nepatfici)
do zadané mnoziny (oblasti) nebo hrani¢ni body (obrazek 3.8).

3Neplést s nastavenim rozsahu nezavisle proménnych!
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2 2
pfam[fmpficiz;:rfm]{f +y <1,x=-2.2,y=-2.2 view=[-2.2,-2.2],
coloring = [ cvan, white|, filled = true, thiciness = 2)
2 —
Fowaler
_Iz _tl 0 i 2I
2
LSRN
-2
Obrdzek 3.6: Reeni piikladu 3.1.
2.-2.2

plots| implicitplot] (x| + M < 1.x=-2.2,y=-2.2

2.view=[ -2

-y

coloring = [ cyan, white]., filled= true, thlc]mess—l gridrefine= 6]

2_

=

e

]!‘

Obrazek 3.7:

Reseni piikladu 3.2.
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plots| inequal | ({0 € x, 0 <y x+y<1},x=-1.2,y=-1.2, optionsfeasible
= (color= cyan), optionsexcluded= ( color=white), labels=["x", "v"])
. 2 —_

Obrdzek 3.8: Reseni piikladu 3.3.

Priklad 3.4: Nakreslete oblast:

={(z,y) eR*: 0 <z <y <1},

yeR?: (z—2)2 + 9y > 1},

JER?:z < 2?4+ 9% <1},

)ER?: 1< |z| + |y| < 2}

Vykreslovani dvourozmérnych oblasti vyuzijeme pii urcovani defini¢niho oboru funkce

dvou proménnych. Systém Maple neméa zadny néastroj pro nalezeni defini¢niho oboru funkce,
nic nam vsak nebrani vyuzit jej pii podilohéch vedoucich k hledanému teseni.

Priklad 3.5: Urcete defini¢ni obor funkce f(z,y) = \/<x2 + @ - 1) (224 y*—6-12)

a zakreslete jej v roviné.
Reseni: Vyraz pod odmocninou musi byt nezaporny, tj.

— 92)2
(x2+%—1) . (a:2+y2—6-33) > 0.
Ptedchozi nerovnost se nam rozpadne na 2 ptipady, které bychom dale upravovali. V tuto
chvili vSak jiz mtzeme vyuzit ptrikazu implicitplot a piislusnou oblast — defini¢ni obor
funkce f(z,y) — rovnou vykreslit. Opét je nutné specifikovat néktery z parametri ,kvality*
zobrazeni, pouZijeme proto napiiklad znovu parametr gridrefine (obrézek 3.9).
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2)"

plots[ implicitplot] [ { ¥ + r=2) _ 1] . (xz +y2 - G-x) = 0,x=-2.7.y=-4.5,

coloring = [ cyan, white], filled = true, thickness = 2, gridrefine=3 ]

5_

Obrdzek 3.9: Regeni piikladu 3.5.

Priklad 3.6: U nésledujicich funkci urcéete jejich defini¢ni obor a zobrazte jej v rovineé:

(a) f(z,y) =/1—a2—4-y2 (d) f(z,y) = arccos(;1;),
(b) f(x,y) = /sin(z? +y?), (e) flx,y)=vV1—a2+/1—1y2
(c) f(z,y) =In(z +y), ) f(z,y) =In(z-In(y — x)).

V systému Maple je mozné vykreslovat téz vrstevnice funkci dvou proménnych, tj. mno-
ziny bodt se stejnou funkéni hodnotou. Slouzi k tomu pfikaz contourplot, pfipadné je
mozné vrstevnice zakreslit do grafu funkce nastavenim parametru style prikazu plot3d na
hodnotu patchcontour (lze nastavit i dodateéné v kontextové listé ¢i kontextovém menu).

Prikaziim contourplot a plot3d muzeme dale zadat parametr contours urcujici, kolik
vrstevnic se zobrazi?, pifipadné jaké vrstevnice (tj. vrstevnice jakych funkénich hodnot)®.

Priklad 3.7: Zobrazte vrstevnice nasledujicich funkci:

(a) f(x.y) = 2%~ 7, (&) fley) =2,

4zadame pfirozené ¢islo
5zadame seznam funkénich hodnot
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plots| comourpfar](d e +y2 L, x=-5_5,y=-5 ..5) pfor.?d(d X +y2 ,x=-5.5,y=-5 .5, style= patchcontour, axe.s=ﬁ‘ame)

Obrazek 3.10: Zobrazeni vrstevnic funkce dvou proménnych.

3.2 Limita a spojitost funkce vice proménnych

3.2.1 Limita funkce

Definice 3.1: Rekneme, 7e funkce f(z,y) ma v bodé [zg, 1] € R? limitu L € R, jestlize
ke kazdému ¢ > 0 existuje § > 0 tak, Ze pro vSechny [z, y| spliujici |z — x¢| < 6, |y —yo| <6
a [x,y] # [zo,yo] plati | f(z,y) — L| < &, a piSeme

lim  f(z,y) = L.

(z,y)—(x0,y0)

Poznamka 3.1: Analogicky k vlastnim a nevlastnim bodim a limitam definujeme tyto
body i v prostoru R?. Limita se nazyva nevlastni, jestliZe je rovna co nebo —oo. V opa¢ném
pripadé se nazyva vlastni. Nevlastni bod je bod s alespori jednou soufadnici rovnou oo nebo
—00, tj. bod typu [a, +00] nebo [£o00, al, kde a € R U {—o0, o0}.

Poznamka 3.2: Taktéz analogicky definujeme ptislusné pojmy v prostoru dimenze vétsi
nez 2.

Poznamka 3.3: Zasadni rozdil mezi limitou funkce jedné proménné a limitou funkce dvou
proménnych spociva v okoli limitnitho bodu a tedy sméru pfiblizovani k limitnimu bodu.
U funkce jedné proménné se blizime pouze po jedné pfimce (a to zleva nebo zprava). Naproti
tomu u funkce dvou (a vice) proménnych se k limitnimu bodu blizime po riznych ptimkach,
parabolach ¢i jinych mnozinach. Pokud v daném bodé limita existuje, nesmi zalezet na cesté,
po jaké se k tomuto bodu priblizujeme.

V systému Maple mame moznost pocitat limity funkei dvou (i vice) proménnych. Neméame
k tomu vsak jiz symbol v paleté Expression, a tak musime pouzit prikaz 1imit. Ptikaz po-
uzivame jediny, limitni bod zapiSeme do slozenych zavorek. Pokud bychom pouzili piikaz
dvakrat za sebou vzdy pro jednu proménnou, tj. napt. 1imit (1imit (£ (x),x=a),y=b), ne-
pocitali bychom dfive definovanou limitu — k limitnimu bodu se totiz v tomto ptipadé blizime
pouze ve dvou smérech (nejprve po ose = a nasledné po ose y).
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h’m;’r(xz-y, {x= 1,y=2})

[ o]

1 P
hmir[ 7’ {x=0,y 0}]
undefined

Limita funkce t¥i proménnych
h’m;’r(xz-y +z {x=1,y=2,2z=3} )

Bl

Obrdzek 3.11: Vypocet limity funkce vice proménnych.

Systém Maple limitu v mnohych pfipadech neumi uré¢it, i kdyz limita existuje. Casto je
proto vhodnéjsi pouzit ,klasicky“ zptisob urceni limity a Maple pouzit jako pomocnika pii
diléich vypoctech a pro vykresleni funkce (vyrazu) v blizkosti limitniho bodu (pro vysloveni
hypotézy o existenci limity a jeji hodnoté). Pokud je mozné do vyrazu, jehoz limitu pocitame,
dosadit, feseni je trividlni. Pokud pii dosazeni dostavame neurcity vyraz typu ,,g“ nebo 2%,
upravujeme puvodni vyraz, abychom do néj mohli ,dosadit®. Nejbéznéjsimi tipravami jsou
roz$ifeni zlomkt, pouziti (souc¢tovych) vzorct ¢i substituce.

Klicova je otazka, zda limita vibec existuje. Pokud ocekavame, ze zadany vyraz nema
limitu, je moZzné vyuzit pfiblizovani k limitnimu bodu z riznych sméru (tj. napf. po riznych
pfimkach, po pfimkéach a po paraboléach, ...). Pokud dostaneme rizné vysledky (limity),
limita neexistuje. Casto je vyuzivdna transformace do polarnich soufadnic a nésledné pii-
blizovani se k limitnimu bodu po kruznicich. V tomto pfipadé je nutné mit na paméti,
ze vyslednd limita nesmi zaviset na thlu (¢) a ze p¥iblizovani se po kruznici je opét pouze
jeden z moznych zptisobti ptiblizovani se k limitnimu bodu! Nicméné existuje tvrzeni, které
nam za jistych predpokladi dovoli uréit limitu funkce (vyrazu) pouzitim jen této metody.

Poznamka 3.4: Plati-li pro funkci f(x,y) po transformaci do polarnich soufadnic

lim  f(z,y) = lim A(r) - g(y),

(z,y)—(z0,y0) r—0+

pricemz
lim h(r) =0 a g(¢) je ohranic¢end pro ¢ € [0,2 - ),

r—0t

pak
lim  f(z,y) =0.

(z,y)—(x0,y0)

Priklad 3.8: Urlete lim
(x,y)—(0,0)

Reseni: Pravé v tomto piipadé od systému Maple obdrzime chybné feseni.

Jiz prvni pohled ndm napovidé, ze by limita méla existovat a méla byt rovna co. K urceni
limity musime vyjit z definice nevlastni limity. Potfebujeme ukazat, ze pro libovolné velké
M € R existuje § > 0 tak, ze pro v8echna [z, y] splijici |z| < 6, |y| < § a [z,y] # [0, 0] plati
flz,y) > M.

1
2 +y2 .
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Pouziti systemu Maple k vypoétu limity:
limit| — L —. {x=0.y=0}
Xty
undefined

pi’az.?d[ > 1 —.x=-3.3,y=-3 .3, axes=frame, view=[ -3 .3,-3 .3, 0 6]]
Xty

Obrazek 3.12: Pokus o ziskani feseni prikladu 3.8 v Maple.

1
2:|M|
lz| < 0, |y| < & a [x,y] # [0,0] nyni plati: 22 +y? < 262 = ﬁ Z toho uz vidime, Ze
skutecéné f(x,y) > M pro tato [z,y], a tedy

Méjme proto libovolné, ale pevné M € R. Polozme § = Pro [z,y] spliujici

E

- 1
lim — =
(2,4)—(0,0) 2 + 2

Piiklad 3.9: Urdete lim 5
(z,)—(0,0) * Y

Reseni: Od systému Maple neziskdme feseni. Nejprve musime ,,odhadnout®, zda limita
existuje a pokud ano, ¢emu je rovna. Z toho vyvodime postup, jakym vyslovenou hypotézu
dokézat. Diky tvaru zadani nemusime uvazovat nad zménami znamének, funkéni hodnoty
jsou vzdy nezaporné. Kdyz se budou x a y blizit k nule, budou ,,velmi mala“. Pritom pro
lz| < 1aly| <1 plati 22 + y? > 22 - y* a podil ¢itatele a jmenovatele bude tim mensi, ¢im
mensi (v absolutni hodnoté) budou z a y. To nés privadi na myslenku, Ze limita existuje a je
rovna nule.

Nyni bychom mohli opét postupovat podle definice. Vzali bychom libovolné, ale pevné e
a k nému bychom ,vytvorili“ ¢ tak, abychom splnili pfedpoklady definice 3.1 pro L = 0.

Zkusme vsak k vypoctu limity pouzit transformaci do polarnich soufadnic, tzn. provést
substituci: [z,y] = [r - cos(p),r - sin(y)].

Ziskali jsme (viz obréazek 3.13) vysledek tvaru r2-cos?(ip) -sin?(p). Aplikaci poznamky 3.4
dostavame h(r) =12 a g(p) = cos?(p) - sin?(p). Plati, ze lirél+ h(r) =0 a g(¢) je ohranicend

2

pro ¢ € [0,2 - 7). Tedy
72 g2

im —2 =
(2,y)—(0,0) T2 + 72

Priklad 3.10: Urcete ( l)irrzo 0 ;22452 piimo z definice limity.
aj’y - b
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Pouziti systému Maple k vypoctu limity: Ba?
22 plot3d| ———-,x=-3.3,y=-3 .3, axes = frame, view=[-3 .3,-3 .3,0 .6]
i’imiz[ﬁ: {x=0,=0} X +y
X+
22
i’imiz[ ;C u -, {x=0,y=0}
Xty

Transformace do polarnich souradnic:

2 2
.mb.s[{x=r-ccs(®}:}'=f'5in(®}}: f — 5
X4y

()

# cos(q) si:rl{cp}2
2 2 2 . 2
rrcos(q)” +rsin(g)”

Zjednoduseni:
simplify( %)

= cos{®}25in{cp}2

Obrdzek 3.13: Reseni piikladu 3.9.

Priklad 3.11: Urcete:

z—2y

(&) (04)—(00) FFHY’

(e li L

m )
) (w,y)L(O,O) Vaity?

b lim ﬁ—'y, .
()(w,y)—>(070) iyt (f lim %fy)
. (2,9)—(0,2)

1m
(2,9)—(0,0)
(d) lim L (g) lim YR
(z,9)—(1,1) V22 +y? (zy)—(00) =Y

(©) £,

3.2.2 Spojitost funkce

Definice 3.2: Rekneme, Ze funkce f(z,y) je spojitd v bodé [xq,70] € R2, jestlize ma
v tomto bodé vlastni limitu a plati

lim x,y) = f(xo, o).
(x’y)q(w)f( y) = f(xo,Yo)

V systému Maple méame pro hledani bodi nespojitosti funkce jedné proménné piikaz
discont. Ten vSak ,funguje“ jen pro funkce jedné proménné. Pro funkce vice proménnych
mizeme vyuzit prikazu singular hledajiciho tzv. singularity. Jeho pouzitim pak mutzeme
odhalit nékteré body nespojitosti. Pfikaz singular méa vSak nékolik ,nedostatki“ (resp.
somezeni“), takze je vhodnéjsi hledat nespojitosti ,klasicky“ a Maple vyuzivat k diléim
ukoltim.

Priklad 3.12: Je funkce
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spojita na celém R2?
Resend: V pifkladu 3.11.(b) pilny ¢tenéi zjistil, ze funkce f(z,y) nema v bodé [0, 0] limitu.
Podle definice 3.2 proto f(z,y) neni v tomto bodé spojita.

Priklad 3.13: Urcete body nespojitosti u nasledujicich funkei:

(@) f(z.9) = s
(b) f(.y) =sin ().
(¢) f(z,y) = arccos (%),

(d) f(z,y) =In|l—a® -7,

LAy [y #10,0]

© f(x’y):{o [y = [0,0]

Piiklad 3.14: Urcete C' € R tak, aby byla nésledujici funkce spojita v bodé [0, 0]:

VeV [a,y) #00,0]

B W “ o O,
(a) f( ,y)—{o o [zy] =10,0]

3.3 Parcialni derivace funkce vice proménnych

Definice 3.3: Necht je funkce f(x,y) definovana v bodé [zg,yo] a né&jakém jeho okoli.
Polozme ¢(x) = f(x, o). Existuje-li derivace funkce p(z) v bodé zy, nazyvame tuto derivaci

parcidlni derivaci funkce f(z,y) podle proménné = v bodé [z, yo] a znacime f/(zo,yo) (resp.

9f(z0,%0) )
ox :

Poznamka 3.5: Pfedchozi definici mizeme zapsat nasledovné:

fa/:(l‘o, yo) — xh_{go f(fl?, yOJ); : iél’o, yo).

Pozndmka 3.6:  Analogicky definujeme f; (2o, yo) <resp. %‘;’y(’)) ¢i parcialni derivace funkci

vice proménnych.

V systému Maple mame nékolik moZnosti, jak uréovat parcidlni derivace funkei (vyrazi).
Jednak mame v paleté Expression jiz preddefinované symboly pro derivaci (% f, a% ), Vy-
uzit mizeme téz pirikaz diff fungujici pro vyrazy libovolného poc¢tu proménnych. Mizeme
téz zapsat vyraz (funkci) do dokumentu, kliknout pravym tlac¢itkem mysi a z kontextové na-
bidky zvolit Differentiate a proménnou, podle niz chceme derivovat. Oproti derivaci funkce
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jedné proménné neni mozné nyni pouzivat apostrof jako symbol pro derivaci. Respektive to
mozné je, ale apostrof ma vyznam parcialni derivace podle proménné z, takze miizeme timto
zpusobem derivovat pouze podle této proménné.

Stale musime mit na paméti rozdil mezi funkei a vyrazem (jak to ,vnima“ Maple, ktery
vét§inou pracuje s vyrazem). Pro derivovani funkei z pohledu systému Maple (tj. funkénich
operatoril) mame piikaz D (s nimz jsme se setkali jiz v pfipadé funkci jedné proménné, viz
sekce 2.5). Na obréazku 3.14 vidime, Ze vysledek pouziti piikazu D mtze byt ponékud matouci
(viz vysledek piikazu D[2] (g), kde by bylo vhodnéjsi obdrzet (x,y)->1). Pfikaz D totiz vzdy
vraci opét funkei (funkéni operator).

g:=(xy) —>x2-|—y D[1](g)
) (%) —2x
(x.y)—=x +y
d
5y &%) D[2](g)
* 1
2x
%gl{ X, ¥) p differentiate w.rt. 1 (x.y) —>2x
2x
diff (g(x.¥).x) P differentiate wort. 2' 1
2x
g{ X, }') differentiate wrt x’ 2y
D[1](g)(3)
o 6
d
oy g(x.)
” 1 D[2](g) (3)
1
d
1, &)
1
diff (g(x.y).¥)
1
( ) differentiate wrt v
gy >

Obrazek 3.14: Vypocet parcidlni derivace v Maple.

Poznamka 3.7: Podobné jako v pripadé derivace funkce jedné proménné ma svij geome-
tricky vyznam i parcialni derivace funkce dvou proménnych. Také parcidlni derivace funkce
f(z,y) v bodé& [xg,yo] je smérnici teény k funkci f(z,y), a to v bodé [z, o, f(x0, y0)]. Ta-
kovych tecen je vsak nekoneéné mnoho. Konkrétné parcidlni derivace funkce f(z,y) podle
proménné x je smérnici te¢ny ke kiivce vzniklé jako prisecik grafu funkce f(z,y) a ro-
viny y = yo. Podobné parcidlni derivace funkce f(x,y) podle proménné y je smérnici tecny
ke kiivce vzniklé jako prusecik grafu funkce f(z,y) a roviny z = x.

Tvrzeni pozndmky 3.7 nyni zobrazime graficky. Na pomoc si vezmeme funkci f(x,y) =
2?2 +9? a budeme pocitat jeji parcidlni derivaci v bodé [—1, 1] podle proménné x. Podle zmi-
néné poznamky je tato parcialni derivace smérnici tetny v bodé [—1, 1, 2] ke kfivce vzniklé
jako prusecik funkce f(x,y) a roviny y = 1. Pro vykresleni funkce f(x,y) pouZijeme jiz
znamy piikaz plot3d. Pro vykresleni roviny y = 1 pouzijeme piikaz implicitplot3d k vy-
kreslovani objektti v t¥irozmérném prostoru zadanych implicitné. Nasledné vykreslime tecnu
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k funkci f(x,y) (jejiz smérnici uréuje parcialni derivace) piikazem spacecurve pro vykres-
lovani prostorovych kiivek zadanych parametricky.

Rovnice te¢ny je dana rovnici z = k- x + ¢, pricemz hodnota k je pravé parcialni derivace
funkce f(z,y) v bodé [—1,1] a je tedy rovna —2. Bod ¢ jiz dopo¢itdme dosazenim bodu
dotyku ([—1, 1, 2]) teény k funkei f(z,y). Nakonec do grafu jesté pro ndzornost zaneseme bod
dotyku pomoci prikazu pointplot3d. VSe vykreslime najednou prikazem display a ziskdme
obrazek 3.15°.

2 2
(ry)—=x +)

pl == plot3d( f(x, y),x=-3 .3, y=-3 .3, axes=framed) :

p2 = plots| implicitplot3d|([y=1],x=-3 .3,y=-3 .3,z=
-1..16, axes= frame, color =white) :

p3 = plots| spacecurve] ([t,1.-2-1],t=-3 .1, axes= frame,
color= blue, thickness=3) :

p4 = plots[ pointplot3d | ( {[ -1, 1, 2]}, axes= framed, color
=red, symbolsize=20) :

plots[display](pl, p2. p3, p4)

Obrdzek 3.15: Geometricky vyznam parcialni derivace.

Definice 3.4: Nechf bod [z¢,yo] patii do defini¢nitho oboru parcidlni derivace funkce
f(z,y). Existuje-li parcidlni derivace funkce f.(x¢,yo) podle proménné = v bodé [z, yo],
nazyvame tuto derivaci parcidlni derivaci 2. fadu funkce f(z,y) v bodé [xg,yo] podle pro-

meénné x a znacime
an(.To, ?JO))

"
fxa: (x07 yO) <resp. Or2

6Vsechny pouzité piikazy kromé piikazu plot3d nalezi baliku plots, ktery je potifeba nacist pied jejich
pouzitim (pfipadné pouzivat spolu s volanim piislusného baliku).
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Existuje-li parcidlni derivace funkce f!(xg, o) podle proménné y v bodé [xg, yo|, nazyvame
tuto derivaci smiSenou parcialni derivaci 2. fadu funkce f(x,y) v bodé [xo, o] a znacime

62f(xo,yo)> ‘

fay (@0, 40) (Hﬁp- 920y

Poznamka 3.8: Analogicky definujeme ,zbylé* parcidlni derivace 2. fddu a parcialni de-
rivace vyssich radi.

V systému Maple postupujeme pri zadavani parcialnich derivaci vyssich fadd podobné,
jak tomu bylo u derivaci vyssich fada v piipadé funkce jedné proménné.

= (% 2) —>ln(x2 +}'2 +22)
(x,»2) —>ln(x2 +}'2 +22)
oo f(x32) D[1](f)
b y
2x {x,y,z}—> 9 4-;{ 2
2,2 12 iyt
x +y +z
& ,
ol ) D[1](D[1](f) )
2 — 4‘; {x’y’z)_} 2 22 2 2 4’;{ 742
_352-|-J/'2‘|'2'2 (_752+y2+22)2 EREE (x‘-l—y“-l—z”)
diff (f(xy.2).x)
2x
Ayt D[1](D[2](£) )
diff (£ (x,312), %, %) 7 (32) = -
2 B 4 (« +)" +2°)
x"_l_y"_l_z" (‘.{21—}'2"'22)‘-
af;a»ﬂx’y’z) D[2](D[1](f)) .
' e (xy2) ==
- 4xy 5 [xh+yh+z*)h
(x2+}'2+22)
aiff (f(xy.z).x.y)
B 4xy D[2](D[2](f))
2 2 212 2 4y
3 2 3 (x.yz) = — 2 7 N
4y +2) £ Yyt (P44

Obrazek 3.16: Parcialni derivace vyssich fadd funkci vice proménnych.

Poznamka 3.9: (Schwarzova véta) Nechf ma funkce f(z,y) spojité smiSené parcidlni de-

rivace fy, a f,, v bodé [ro,yo]. Pak plati:

fg/:/y(xm ?JO) = f;/m(foa ?JO)

Priklad 3.15: Urcete vSechny parcialni derivace 1. a 2. fadu u nésledujicich funkei:
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() fla.y) =22 y+1n(2). © fla.y)=a,

Y

(b) flz,y) = (z*-y+y)°, (d) flz,y) =2 -y-In(z+y).

Piiklad 3.16: Urcete vSechny parcialni derivace 1. fadu funkce f(z,y) v bodé A:

(a) fla,y) =In (o + /a7 4?), A=[1.2),

(b) f(z,y) = (1+]log,(2))°, A= [e,e],

(¢) f(z,y)=1In (:13+ %), A=1,2].

3.3.1 Smérové derivace

Definice 3.5: Nechf f je funkce n proménnych, X = [x1,9,...,2,] vnitini bod D(f)
au = (uy,us, ..., u,) vektor. Necht p(t) = f(X +¢-u). Ma-li funkce ¢(t) derivaci v bodé
t = 0, nazyvame ji derivaci funkce f v bodé X ve sméru vektoru u nebo také smerovou
derivact funkce f a oznacujeme ji f, (X). Tedy:

F1(X) = Tim p(t) — ¢(0)

w t—0 t t—0 t

Smérové derivace muzeme pocitat bud rovnou z definice nebo vyuzijeme piikaz baliku
Student [MultivariateCalculus] s ndzvem DirectionalDerivative.

Priklad 3.17: Vypoctéte smérovou derivaci funkce f(z,y) = 2% + y* v bodé [—2,2] ve
sméru vektoru u = (3,5).

Reseni: Vyuzijeme piikazu DirectionalDerivative, ktery mé 3 povinné parametry —
vyraz, bod, v némz hleddme smérovou derivaci, a pfislusny smér (obrazek 3.17).

with ( Student| MultivariateCalculus]) :

Di}'eczmnafDe}'ﬂ’am’e(xz -I—yz: [x¥]=[-2.2].[3.5] )
I
— /34
17 ¥

Obrdzek 3.17: Reeni prikladu 3.17.

Systém Maple nabizi dale maplet s nazvem Directional Derivative, ktery miizeme
spustit z hlavni nabidky: Tools > Tutors > Calculus - Multi-Variable > Directional
Derivatives. ... Maplet pro zadanou funkci, bod a smér vypocita smérovou derivaci a zobrazi
ji graficky spolu s funkci a te¢nou rovinou v daném bodé. V mapletu je dale mozné zobra-
zit animaci sestavajici ze smérovych derivaci v riznych smérech ve stejném bodé (ukazku
poskytuje obrazek 3.18).
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F1aMultivariate Calculus - Directional Derivative x|

File Help
 Plot Window
— Opkions
f= Ix"2+y"2
Paint:
[ oI 1=[lz .k ]
Direction:
(@ . ]
o # of Frames: IID
X
Walues
’7 ackual Value II.S?ZD

Display I Animate Plak Options Close

DirecticnalDeriwvatiwe( =*i+y* i, [=, v] = [-&, &1, [2, 51, cwpue = plexl:

~ Maple Command

Obrdzek 3.18: Maplet zobrazujici smérové derivace.

Priklad 3.18: Urcete smérovou derivaci funkce

[

(a) f(x,y) = arctan(x - y) v bodé [1, 1] ve sméru vektoru u = (%=, g),

(b) f(x,y) =1In(e” + e¥) v bodé [0, 0] ve sméru vektoru u = (cos(a), sin(a)).

3.3.2 Diferencial

Definice 3.6: Rekneme, 7e funkce f(z,y) je diferencovatelnd v bodé [wo, yo], jestlize exis-
tuji redlna cisla A, B tak, ze

(1=(00) N

Linearni funkce A - h + B - k proménnych h, k se nazyva (totalni) diferencidl funkce v bodé
(%0, yo] & znadi se df (zo, yo)(h, k), resp. df (o, Yo)-

= 0.

Poznamka 3.10: Je-li funkce f(x,y) diferencovatelnd v bodé [xg, o], pak mé v tomto
bodé parcidlni derivace a plati A = f}(zo,%0), B = f, (%0, %), tj-

df (w0, y0) = fr(z0,%0) - I+ £, (20, %0) - k.
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Poznamka 3.11: Tecné rovina k funkei f(z,y) v bodé T = [xo, yo, f (%0, Yo)] ma tvar

z = f(w0,90) + [ (%0, %0) - (x — z0) + £, (0, %0) - (¥ — %o)-

Podobné jako v pripadé funkce jedné proménné vyuzivame diferencial k vypoctim od-
hadt funkénich hodnot v okoli bodu, v némz funkéni hodnotu zname. I tady pochopitelné
plati, ze samotny systém Maple urc¢i funkéni hodnotu presnéji. Pfesto jej mutzeme vyuzit
k dil¢im vypoctiim a kontrole presnosti ziskanych aproximaci.

Priklad 3.19: Urcete priblizné: 1/1.023 + 1.973.
Re$eni: Budeme uvaZzovat funkci f(z,y) = v/23 + y*. Aproximaci ziskdme podle vztahu:

f(@o+h,yo+k) = f(zo,y0) +df (0, yo) = f(w0, yo) + fo(wo, o) - (x —20) + £, (0, Y0) - (¥ — Yo)-

V naSem ptipadé: [zg,v0] = [1,2], [z,y] = [1.02,1.97]. Systém Maple vyuZijeme k vypoctu
parcidlnich derivaci v pfislusnych bodech a celkovému souc¢tu vypoctenych hodnot (obrazek
3.19).

der x = —f(x,¥)
X

3 o
2
2 \fx3+y3

der y =~ f(x,3)

er yi= X, ¥

p— a}' = a

R
2
2 \fx3+y3

S presnosti na 10 mist: \f“l 1.02° +1.97° =2.950691614

Piiblizné pomoci diferencialu: \;'f 1.02° +197 =~
ex-‘a{f‘( \.'If 1P +2° + eval(der x, {x=1,y=2})-(1.02—1)
)

+eval(der y, {x=1,y=2})-(1.97 -2 )
2.950000000

Obrdzek 3.19: Reeni prikladu 3.19.
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Priklad 3.20: Urcete priblizné:

(a) 3.05999 (c) arctan(gg2),
(b) v/3.05 - cos(62°), (d) log,(4.01-0.97%).

Piiklad 3.21: Urcete rovnici te¢né roviny k funkei f(z,y) = /1 — 22 — y? v bodé [\/ig, \/ig, \/ig]
a rovinu i s funkci vykreslete.

Resend: Vyjdeme z poznamky 3.11. V Maple vykreslime funkci f(z,y) i te¢nou rovinu
pomoci piikazu plot3d (v némz nastavime parametr prihlednosti — transparency — pro
vétsi prehlednost), navic doplnime i bod dotyku teéné roviny pfikazem pointplot3d z baliku

plots (obrazek 3.20).

fley) = 1- 2 ploss[display](pl, p2, p3)
{.Tf _}'h _*\f'll 1 — _TE _}.2
1 1
Hx.yv) = N
(%) f[ o J?J

d N T T A A
+evaf[af{x,}),[x a’?:} *{?H [x q]
[ 1 1 1

+ evaf[ L),

Y

t(x.y)

pl == plot3d(f(x.y),x=-1.1,y=-1 .1, axes = framed,
color= blue, numpoints = 1000) :
p2 == plot3d(t(x,¥),x=0..0.98, y=0 ..0.9, axes = frame,
color= yellow, transparency=0.95) :
] 1 1 1
3 1= plots| pointplot3d , .
p3 = plots[ pointp ]H BEE

W

, axes

= framed, color = red, symbolsize = 20] :

Obrdzek 3.20: Reseni prikladu 3.21.

Priklad 3.22: Urcete rovnici tecné roviny a rovinu i s funkci vykreslete pro:
(a) funkci f(z,y) = 2* + y* v bodé [2, —1, 5],
(b) funkci f(z,y) =2*+2-2% -y —x-y+x v bodé [1,0,2],
(c) funkei f(z,y) = In(z?* + y?) v bodé [2, 1,In(5)],

(d) funkei f(z,y) = e* ¥ v bodé [0,0, 1].
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3.3.3 Taylortv polynom

Definice 3.7: Necht n € NU {0} a f(z,y) funkce majici v bodé [z, yo] € R? a néjakém
jeho okoli spojité parcialni derivace az do fadu n. Polynom

T)(x,y) = f(x0,50) + g_i(iﬁ'o,yo) (= 20) + g_;;(%,yo) (¥ — yo)

"‘l‘ <ﬂ(l’oyyo) Sz —x0)? 42 ] (z0,%0) - (x — 20) - (¥ — Yo) + g_yé(ilfo;yo) (y — y0)2)

2! \ 0x? 0x0y
1 ~— /n o"f i ;
+---+H'j§0 (T)W(xo’y‘)) (@ —0)" ™ - (y — wo)’

se nazyva Tayloriv polynom stupné n funkce f(x,y) v bodé [zg, yo]. Funkei
Rl(z,y) = T)(x,y) = f(z.y)
fikdme Tayloriv zbytek a cely vyraz
T(,y) + B(,9)

nazyvame Taylorovym vzorcem.

Podobné jako v jednorozmérném piipadé existuje i nyni , predpis“ pro R/ (z,y), ktery ndm
fekne, ,jak dobrou“ aproximaci dané funkce f(z,y) je polynom T (x,). My jej potiebovat
nebudeme, a proto ¢tenéfe pouze odkdZzeme na dalsi literaturu (napt. [2]).

V systému Maple slouzi k ziskani Taylorova polynomu funkce vice proménnych piikaz
mtaylor. Pfikaz ma 2 povinné parametry, a to vyraz (funkéni pfedpis) a seznam proménnych
s pripadnou specifikaci bodu, v némz mé byt polynom rozvinut. Pokud bod nespecifikujeme,
bude pouzit nulovy bod. Mzeme si dale vSimnout, zZe narozdil od pfikazu taylor v jednoroz-
mérném piipadé nyni ziskdme ,,pouze* Taylortiv polynom (bez chybového ¢lenu). Stejné jako
drive vyuzivame k nastaveni fadu chybového ¢lenu systémovou proménnou Order, pripadné
tfeti (nepovinny) parametr piikazu mtaylor (viz obrazek 3.21).

Priklad 3.23: Urcete Tayloruv polynom pro
(a) funkei f(z,y) = { v bodé [1,1],

(b) funkei f(z,y) = ZTS(Z) v bodé [0, 7],

(c) funkci f(z,y) = sin(x + y) v bodé [0, 0] tak, aby byl chybovy ¢len Fadu 9,
(d) funkei f(z,y,2) = (cos(z 4+ y)) - z v bodé [0, 0, 0].

Priklad 3.24: Pomoci Taylorova polynomu urcete piiblizné:
(a) v/1.023 4+ 1.973,
(b) v/3.05 - cos(62°),

102)

)
(c) arctan(ggs
)

(d) log,(4.01-0.97%).
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( ):2+,1'2
mtaylor\ e L[x=1,p=1]
10 2

E42e (x—1) 426 (y—1) 43 (x—1) +4& (v—1) (x—1) +3¢ (y—1)° te (x—1) +6¢ (v

—D(x=1) +6 (y=1) x—1}+13—052 y—1) +16—952(7c—1}4+?:3—02 y—1) (x—1)" +9¢ (»
v 4
—1}2(_xc—1}2+‘3—052(;,-—1}3(x—1}+16—952 y—1) +15—3¢2(x—1} +13—932(1,-—1}(;{—1}“l

) 2 ) 2 ) 4 2 5
+lOcL(y—l}h(x—1}3-I—lOch(}'—l}S(x—1}L+13—9€(y—1}4(x—1}+15—3€(y—1})
2,.2
miayior( &, [x])
22 4 22 4
1+x +y T +yx +5y

):2+1'2
mrmfor( . [x vl 10)
1 6 1 24 1 42 1 ﬁ 1 1 1 -1-4 1 ﬁ 2 1 8

1 ].
?C ]f 7( 'L?C 'L 6’( ¥ 21’( 6 435 6'L?C 4'!; 6 41

Obrazek 3.21: Vypis Taylorova polynomu funkce dvou proménnych.

3.4 Extrémy funkce vice proménnych

3.4.1 Lokalni extrémy
Definice 3.8: Necht p: R" x R” — R je funkce, pro niz pro libovolnd X,Y, Z € R" plati:
(a) p(X,Y) =0,
(b) p(X,)Y)=0& X =Y,
(¢) p(X,Y) = p(Y, X),
(d) p(X,2Z) < p(X,Y) + p(Y, Z).

Takovou funkci nazyvame metrikou (resp. vzdalenosti) v R™. Pomoci metriky definujeme e-
okoli bodu X € R" jako mnozinu O.(X) = {Y € R" | p(X,Y) < ¢}. V pfipadé¢, ze hodnota
€ neni podstatna, mluvime pouze o okoli bodu X.

Definice 3.9: Rekneme, Ze funkce f : R” — R nabyva v bodé X* € R" lokdlniho mazima,
jestlize existuje okoli bodu X* takové, ze pro v8echna X z tohoto okoli plati: f(X) < f(X™).
Je-li uvedend nerovnost ostra, mluvime o ostrém lokdlnim mazimu.

Poznamka 3.12: Zcela analogicky definujeme (ostré) lokdlni minimum. Minima a maxima
souhrnné nazyvame extremy.

Priklad 3.25: Napiste definici lokdlniho minima.

Definice 3.10: M¢jme funkci f : R — R. Bod X* € R" nazveme staciondrnim bodem
funkce f, jestlize v bodé X* existuji vSechny parcialni derivace funkce f a plati:

of
ox;

(X*)=0 pro i=1,..,n.
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Poznamka 3.13: Funkce f : R” — R mtze mit lokalni extrém pouze ve svém stacionarnim
bodé nebo v bodé, kde alesponi jedna z parcidlnich derivaci neexistuje [2].

Poznamka 3.14: Nyni se omezime pouze na funkce dvou proménnych. Necht mé funkce
f(z,y) v okoli bodu [z, yo] spojité parcialni derivace druhého fadu. Oznac¢me
(70, Y0) f:gy(x(b Yo)
Hy = f.(%0, %), Hy =
{,;(:co,yo) f;/y(%,yo)

Pak:
e Kdyz Hy > 0, mé funkce f(z,y) v bodé [xg, yo] ostry lokdlni extrém.

(a) Pokud navic Hy > 0, pak je v bodé [z, yo| lokdlni minimum.

(b) Pokud navic H; < 0, pak je v bodé [xg, yo] lokalni maximum.
e Kdy7z Hy < 0, nema funkce f(x,y) v bodé [z, yo] lokalni extrém.
e Kdyz Hy = 0, neumime o existenci extrému timto zptisobem rozhodnout.

Matici druhych derivaci funkce f(z,y), jejiz determinant jsme oznacili Hy, nazyvame Hes-
sovou matict, jeji determinant, Hs, oznacujeme jako hessidn.

V systému Maple je opét nékolik cest, po nichz mizeme dospét k lokalnim extrémim
zadané funkce. K dispozici mame nékolik piikazi, které nam mohou pomoci pii diléim vy-
poctu, pripadné i nalezeni ne€kterého z extrémil, zadny prikaz vsak obecné nedokaze najit
vsechny lokalni extrémy. Nejuniverzaln€jsi cesta je projit vyse popsany postup, ktery zname
z prednasky. Systém Maple pritom miZzeme vyuzit k vykresleni zadané funkce, vypoctu par-
cidlnich derivaci (pfipadné rovnou k vypoc¢tu stacionarnich bodi pomoci piikazu extrema),
vypoc¢tu Hessovy matice ¢i jejiho determinantu. K vypoctu Hessovy matice slouzi piikaz
Hessian z baliku VectorCalculus. Pro vypocet determinantu je urcen piikaz Determinant
z baliku LinearAlgebra.

Priklad 3.26: Najdéte lokdlni extrémy funkce f(x,y) = (z —2)® + (y — 3)® + 5.

Reseni: Vyuzijeme piikaz extrema k nalezeni stacionarnich bodi. Nésledné vypocitame
Hessovu matici piikazem Hessian a jeji determinant pfikazem Determinant. Na zakladé
poznamky 3.14 pak rozhodneme o lokalnich extrémech (obrazek 3.22).

Priklad 3.27: Najdéte lokdlni extrémy funkce f(x,y) = (y — 3)? — (z — 2)? + 5.

Reseni: Postupujeme zcela analogicky k pfedchozimu piikladu. Vyuzijeme opét pitkaz
extrema k nalezeni stacionarnich bodti, pfikaz Hessian k vypoctu Hessovy matice a ptrikaz
Determinant k urceni jejiho determinantu. Na zakladé poznamky 3.14 pak rozhodneme
o lokalnich extrémech (obrazek 3.23).

224y

Priklad 3.28: Najdéte lokalni extrémy funkce f(z,y) =x-y-e =2

Reseni: Postupujeme opét stejné. Nyni ziskdvame vic stacionarnich bodii, pro néz musime
vyhodnotit Hessovu matici a jeji determinant. Pfi tom si ,pomiizeme® ptikazem eval a na-
rozdil od pfedchozich prikladi nacteme prikazem with potiebné baliky pro prikazy Hessian
a Determinant (obrazek 3.24).
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Stacionarni body:
extrema( f(x.y). { }, {x. ¥}, bod")

bod

Staciondrni bod je: [x.v]=[2.3].

Hessova matice:

H := VeetorCaleulus[ Hessian|( f (x, ¥), [x.¥])
20
02

Prvni prvek Hessovy matice (druha derivace f{x,y) podle x):

H(1.1)

[ ]

Determinant Hessovy matice:

LinearAlgebra[ Determinant | (H)
4

Bod [2.3] je lokalnim minimem funkce f{x,y).

Obrdzek 3.22: Reseni piikladu 3.26.

Stacionarni body:
extrema( f(x.y), { }: {x.y}.bod")
{5}

bod
{{x=2,p=3}}

Stacionarni bod je: [x.v]=[2.3].

Hessova matice:

[ 3]

H := VectorCalculus[ Hessian|( f (x, ¥), [%¥])
0
2

|

)

Determinant Hessovy matice:

LinearAlgebra[ Determinant | (H)
-4

Determinant Hessovy matice je zdporny =+bod [2,3] neni
lokalnim extrémem funkee f{x,3).

Obrdzek 3.23: Reseni prikladu 3.27.

110




plot3d(f(x.y),x=-4 .4, y=-4 4, aves= framed,
numpoints = 1000)

Stacionarni body:

extremal f(x.y), { }. {x.y}.body’)
{ _e_l: e_l}

body

{{x=-Ly=-1}. {x=-1y=1}, {x=0,p=0},
{x=1Ly=-1}, {x=1,p=1}}

with( VectorCalculus) :
with( LinearAlgebra) :

Stacionarni body: [-1.-1], [1.-1], [-1.1]. [1.1]. [0.0].

Hessova matice:
H := Hessian(f(x. ). [x.¥]) :

Bod [-1.-1]

Determinant(eval(H, {x=-1,y=-1}))
4(eh)’

é’i’df[H[l: l)- {X:—l:_}':_l})

Bod [1,-1]
Determinant(eval( H, {x=1,y=-1}))
4 (e_l)h
eval(H(1,1), {x=1,y=-1})
2!
Bod [-1.1]

Determinant(eval(H, {x=-1,y=1}))
4 (5_1)~
eval(H(1,1), {x=-1,y=1})

251

Bod [1.1]
Determinant(eval( H, {x=1,y=1}))

4(5_1)2
eval(H(1,1), {x=1,y=1})
-1

_‘)c

-

Bod [0.0]
Determinant(eval( H, {x=0,y=0}))
-1

Lokélni minima: [1.-1], [-1,1].

Lokalni maxima: [-1.-1], [1,1].

Obrdzek 3.24: Reseni ptikladu 3.28.

Jak jsme zminili diive, v systému Maple jsou i nékteré prikazy hledajici extrémy funkeci.
Jednd se predevsim o prikazy minimize a maximize pro nalezeni globalniho minima c¢i
maxima (symbolicky). Stejné piikazy, ovSem s velkymi pocatenimi pismeny, tj. Minimize
aMaximize z baliku Optimization, hledaji globalni extrémy numericky. Vsem zminénym pii-
kaziim je mozné nastavit omezujici podminky, a hledat tak absolutni extrémy na dané mno-
ziné (vice v dalsi ¢asti kapitoly). Mizeme také vyuzit mapletu s ndzvem Optimization, ktery
vyvolame napftiklad z hlavniho menu zvolenim Tools > Assistants > Optimization....
Na vybér mame nékolik metod, kterymi je extrém hledan, tlacitkem Solve vypiSeme feseni,
tlacitkem Plot jej zobrazime graficky. Jeho ukazku s nalezenim globalniho minima funkce
f(x,y) = 2% + y* poskytuje obrazek 3.25.

Piiklad 3.29: Najdéte lokalni extrémy funkce f(x,y) = /22 + y2.

Reseni: Postupujeme stale stejné. V tomto ptripadé vsak nenalezneme zadné stacionarni
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[32 Optimization Plotter x|
[12 Optimization Assistant x|
[-Solver [-Problem
(% Local Default Objective Function Edit
) Linear: Yarigble Types
2 }2
™ Quadratic
" Morlinear |Default M
Constraints and Bounds Edit
" Least Squares  |Defaul -
| Cptions
£ Minitrize £ Maximize
Feasibility Talsrance el
Initial Yalues Clear Edit
l— 0100 0.10
luti —
Optimality, Tolerance: jdeFaul:
pimeliy bjective walue: 0 range of [ | = 0.1 ot extrema at 0
wro
Iteration Limit default yeo Range of |y | = 0.1 Lot extrema at 0
P ok Range of objective values = [default . Jdefault extrema of 0
™ Plot Using Problem Domain
On Qut, Return [Salution - tep [ sebe | et | ou | Done

Obrazek 3.25: Optimization maplet.

body. Jiz z grafu funkce je na prvni pohled vidét, Ze funkce m4 lokalni minimum v bodé [0, 0],
v némz neexistuje parcidlni derivace. Existenci minima miizeme ovérit vysetfenim lokalniho
chovani funkce v okoli tohoto bodu nebo vyuzitim piikazu minimize. Piikaz volany s jednim
parametrem vypise pouze hodnotu minima. Abychom ziskali i jeho polohu, priddme druhy
nepovinny parametr location (obrazek 3.26).

= (ny) =X +)
7.7

2
Ly)—=yx +y
o W o

plot3d( f(x,¥),x=-3.3,y=-3 .3, axes= frame)

Stacionarni body:
extrema( f(x,y). { }, {x.y}.'bod")
bod

bod

Stacionarni body nejsou.

V bodé [0.0] viak neexistuje parcidlni derivace:

d
L fx)
X
[+

ewf[aif(x:y), {x=0,y=0})

Error, numeric exception: division by zero

Pouziti prikazu minimize:
miimize( f(x, v). location)
0, {[{x=0,y=0}.0]}

Vbede [0,0] je globilni (a tedy i lokalni) minimum funkce fix,p).

Obrdzek 3.26: Reeni prikladu 3.29.
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Priklad 3.30: Najdéte lokalni extrémy funkce:

(a) f(:v,y)=$3+y3—3:l?y,

(b) flz,y)=a"=3-2> y+3-y—y°,

(c) flz,y) =2y -In(2®+y?),

(d) fla,y) = (@ +y?)-e =V,

(e) flz,y) =3 -2 =2-2-\/y+y—8-x+12

() fz,y) =y - Vitaot+o-Vy+1,

(8 fl@,y)=3—V22+y2+2-/(z—2)2+ (y — 3)2

3.4.2 Absolutni extrémy

Definice 3.11: Mgjme funkci f : R — R a mnozinu M C D(f). Rekneme, ze bod X* € M
je bodem absolutniho maxima funkce f na mnoziné M, jestlize pro vsechna X z mnoziny M
plati: f(X) < f(X*). Je-li uvedend nerovnost ostra pro vSechna X # X*, mluvime o ostrém
absolutnim maximu.

Poznamka 3.15: Zcela analogicky definujeme (ostré) absolutni minimum. Misto pojmu
absolutni minimum (maximum, extrém) pouzivame nékdy termin globdlni minimum (maxi-
mum, extrém).

Priklad 3.31: NapisSte definici absolutniho minima.

Definice 3.12: Bod X € R” nazveme bodem wuzavéru mnoziny M C R", jestlize pro
libovolné e plati: O.(X) N M # . Mnozina viech bodl uzavéru mnoziny M se nazyva
uzdvér mnoziny M a znaéi se M. Mnozinu M nazveme uzavienou, jestlize M = M.

Poznamka 3.16: Necht je mnoZina M uzavienéd a ohranicené a funkce f na mnoziné M
spojita. Pak f nabyva absolutnich extrémi na mnoziné M bud v bodech lokélnich extrémi
patiicich do mnoziny M nebo v nékterém hrani¢nim bodé mnoziny M.

Pti hledani absolutnich extrémi miizeme v systému Maple vyuzivat tytéz ptrikazy jako pri
hledani extrému lokalnich, pficemz specifikujeme navic i mnozinu, na niz extrémy hledame.
Ma to vsak sva omezeni. Piikazu extrema mizeme zadat omezujici podminky pouze ve tvaru
rovnosti. Pfikaztim minimize a maximize je mozné zadat omezeni ve tvaru rozsahi (inter-
valtl) jednotlivych proménnych. Vice moZnosti ndm nabizi piikazy Minimize a Maximize
z baliku Optimization hledajici extrémy numericky a maplet Optimization (viz obrazek
3.25), u nichz muzeme zadavat omezeni i ve tvaru neostrych nerovnosti.

Priklad 3.32: Najdéte absolutni extrémy funkce f(x,y) = z?> —3*> +4 na mnoZiné
M: 2%+ 92 < 1.

Reseni: Nejprve vykreslime zadanou funkci i s vyznadenim hranice mnoZiny M, které
provedeme prikazem spacecurve. Nasledné proveérime lokdlni extrémy prikazem extrema
s naslednym vyhodnocenim determinantu Hessovy matice. Tymz prikazem najdeme extrémy
funkce na hranici mnoziny M (obrazek 3.27).
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fi=(xy) — xz_]} +4 Stacionarni body na celém D(f}:
8 : s extrema(f(x,), { }» {xy}bod")

(x,3) = =37 +4 : e
{4}

. bod
Definice vykresleni funkee ?
pl = plot3d(f(x y),x=-15.15,y=-1.5.1.5, axes
= framed, orientation=[ 71, 56]) :

{{x=0,y=0}}

Stacionarni bod je: [x.v]=[0.0].
Definice vykresleni hranice mnoziny M .
Hessova matice:

p2 i= plots[ spacecurve] [ cos(2), sin(1).f (cos(1), H = VectorCalculus| Hessian|( f (x. ), [ ¥])
!

sin(t)) ],t=0..2-x, color = black, thickness=3) :

2
0

Vykresleni pfedchoziho do jednoho grafu
plots[ display]({pl.p2}.labels=[x.y.2]);
Determinant Hessovy matice:

LinearAlgebral| Determinant] (H)
-4

Bod [0,0] neni lokdlnim extrémem funkce f{x,3).

Stacionarni body na hranici mnoziny M:
extrema( f(x,v). {' +* =1}, {x.y},body")
3.5}
body
[{x=-1y=0}. {x=0.y= -1}, {x=0.y=1}. {x=1,y=0}}

Absolutni minima: [0.-1], [0.1].

Absolutni maxima: [-1,0], [1,0].

Obrdzek 3.27: Reseni prikladu 3.32.

Priklad 3.33: Najdéte absolutni extrémy funkce f(x,y) = 2% + y?> +4 na mnoZiné
M: 2? +¢y? < 1.

Reseni: Postupujeme stejnym zpiisobem jako v pfedchozim piikladu. Zadana funkce mé
jeden lokélni extrém, ktery je soucasné i jejim globalnim minimem na mnoziné M. Absolut-
nich maxim je nekoneéné mnoho a jsou tvoreny hranici mnoziny M (obrazek 3.28).

Priklad 3.34: Najdéte absolutni extrémy funkce f(z,y) =2 +2-2-y—4-2— 8-y na
mnoziné M urcené primkami x =0,z =1,y =0,y = 2.

Reseni: K zakresleni hranice mnoziny M do zadané funkce potiebujeme nyni pouzit
4x ptikaz spacecurve (pro kazdou pfimku — resp. usecku, zvlast). Nasledné nalezneme
stacionarni bod funkce prikazem extrema. Tento stacionarni bod lezi mimo mnozinu M,
zadand funkce je v kazdém bodé diferencovatelna, absolutni extrémy tedy lezi na hranici
mnoziny M. Diky tvaru M (jedné se o obdélnik) ji mtizeme jednoduse vyjadfit pomoci dvou
intervali (rozsahtt pro proménné z a y). Presné toto omezeni je mozné zadévat piikazim
minimize a maximize, takZe je vyuZzijeme’ (obrazek 3.29).

"Pifkazy minimize a maximize v tomto pFipadé neprochdzi jen hranici mnoziny M, ale celou mnozinu
(coz nam ale nevadi). Pro jiny tvar mnoziny M, napf. trojuhelnik, ¢asto musime prochézet jednotlivé ¢asti
jeji hranice, tj. napf. jednotlivé tisecky (a hledat na nich extrém).
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fi=(xy) — e +}'2 +4 Stacionarni body na celém D(f):
extrema( £ (x.). { }, {x.y) bod")

(xy) = +37 +4 (4)

Definice vykresleni funkce bod
pl == plot3d(f(x,y),x=-1.5..1.5,y=-1.5 ..1.5, axes {{x=0,y=0}}
= framed, orientation=[ 71, 56]) :
Stacionarni bod je: [x.v]=[0.0].
Definice vykresleni hranice mnoziny M
p2 = plots| spacecurve|( [ cos(t), sin(t),f (cos(t), Hessova matice:
sin(r))],r=0.2-m, E:ofor= black, thickness=3) : H := VectorCalculus[ Hessian] (f(x,y), [x y])

20
02
Determinant Hessovy matice:
LinearAlgebra| Determinant] (H)

Vykresleni pfedchoziho do jednoho grafu
plots| display]({pl,p2}.labels=[x. y.z]);

Prvni prvek Hessovy matice (druha derivace f{x,y) podle x):
H(1.1)

2

Bod [0.0] je lokalnim minimem funkce fix,3).

Stacionarni body na hranici mnoziny M:
extremal f(x.y). {x’ +5" =1}, {x.y}.body")
{5}
body
[{x: _1.‘}':0}: {x: 1:}'20}: {x: 1 _}'2 :}':}']: [x:

~J1=27 =]

Absolutni minimum: [0,0].
Absolutni maxima: body na kruznici e +}'2 =1.

Obrdzek 3.28: Reseni prikladu 3.33.

Piiklad 3.35: Urcete absolutni extrémy funkce f(z,y) na mnoziné M:

I
8
_l_
=
<

Bl
IA
\'H
=
IA
\'H

Priklad 3.36: Najdéte kladna ¢isla z, y, z takova, ze vt +y+2z = 18 a - y- 2 je maximalni.
Reseni: Chceme maximimalizovat funkci f(x,y,2) = x - y - z. P¥itom m4 platit, Ze = +
y + z = 18. Tuto rovnost mizeme zahrnout rovnou do pfedpisu funkce, a ziskat tak funkci
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= (x,y) = “ + 2xy—4-x—8-y Stacionarni body na celem D(f}:
extrema( f(x,y), { }» {xy}bod")
{0}

{x:y]—>x2+2xy—4x—8y

Definice vykresleni funkce bod {{x=d,y=-2}}
pl i=plot3d( f(x,¥),x=-1.3,y=-1 .3, axes=framed) : X=hy= s

Definice vykresleni hranice mnoZiny M Stacionarni bod je: [x.y]=[4.-2]. Lezi viak mimo M.
p2 = plots| spacecurve|([1,0.f(1,0) ], t=0 ..1, color = black,

thickness=4): #y=0 Hranice mnoziny M:
3 = plots| spacecurve| ([ 0,1,/ (0,1) |, t=0 .2, color= black,

P m;zkneé[;z“ . x]:((;[ 610,21, ’ ’ minimize( f (x,¥),x=0..1,y=0..2, location)

p4 = plots[ spacecurve| ([ 1,t.f(1.t) ].t=0 .2, color= black, -16, {[ {x=0,y=2}. -16]}
thickness=4) : #x=1 maximize( f(x,v),x=0.1,y=0.2, location)

pJ = plots| spacecurve| ([ t,2.f(t,2) |.t=0..1, color = black, 0. {[{x=0,y=0},0]}
thickness=4) : #y=2

Vykresleni grafu: Absolutni minimum: [0,2].

plots[ display]( {pl.p2. p3.p4,p5}.labels= [x,y,z]): Absolutni maximum: [0,0].

Obrdzek 3.29: Reseni prikladu 3.34.

pouze dvou proménnych: z-y- (18 —y —x). Nové vzniklou funkci pfitom maximalizujeme pro
x € (0,18),y € (0,18),x + y < 18. Timto zapisem jsem zadanou tlohu pfevedli na klasické
hledani absolutniho maxima funkce, jak jsme jej fesili v predchozich prikladech. Tentokrat
dokonce nemusime ani vySetfovat funkéni hodnoty na hranici ,,omezujici“ mnoziny, nebot
omezujici podminky jsou ostré nerovnosti. Celkem ziskdvame, ze pozadovana kladna ¢isla
jsow: z =y = z = 6 (obrazek 3.30).

Priklad 3.37: Najdéte kladna ¢isla x, vy, z takova, Zze x-y-z = 64 a x+y -+ 2z je minimalni.

Priklad 3.38: Jakého nejmensiho ¢isla muze nabyt soucet tii kladnych ¢isel x, y, z, jestlize
pro né plati: x -y - 22 = 25007

Piiklad 3.39: Najdéte bod plochy z = x - y — 1, ktery je nejblize bodu [0, 0, 0].
Priklad 3.40: Urcete rovnici pfimky, pro niz plati, Ze ma od bodu [0,2],[1,3] a [2,5]
nejmensi soucet ¢tverctt (druhych mocnin) jejich vertikalnich vzdalenosti (tj. ve sméru osy

y) — tzv. metoda nejmensich ctverci.
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fi=(xy) 2 xpy (18 —x—y) Stacionarni body na celem D(f):
(x.3) —xy (18 —x—) extrema( f(x.7). { }. {xy}body")
{0,216}
Definice vykresleni funkee body
pl = plot3d(f(x,¥).x=0.18,y=0.18,view=[0.18,0..18, |{{x=0,y=0}, {x=0,y=18}, {x=6,y=6}, {x=18,
-1000 ..300], axes= framed) : y=0}}

Definice vykresleni hranice mnoZiny A/

p2 = plots| spacecurve] ([1,0,£ (£, 0) . =0 ..18, color= black, | Stacionarni bod uvnitf mnoziny M: [6.6].
thickness=4) : #x=0.18

p3 = plots| spacecurve| ([ 0,1.f(0,1) ], t=0 ..18, color= black,

thickness=4): #y=0.18 Hessova matice: ]
p4 = plots| spacecurve| ([, 18- t,f (1, 18- 1) |, r=10..18, color H = VectorCaleulus| Hessian] (f(x.). [x.»])
= black, thickness=4) : #x+y=I18 -2y 18—2x—2y
18—2x—2y -1x

Vykresleni grafin

lots| display 1.p2.p3.pd}):
plots[display] ({p1, 2. p3. p4}); Determinant Hessovy matice:

LinearAlgebra| Determinant] (eval(H, {x=6,y=6}))

108
Prvni prvek Hessovy matice (druha derivace f{x,y)
podle x):
eval(H(1,1), {x=6,y=6})

-12

Bod [6.6] je lokdlnim maximem leZicim uvniti M,
a tedy 1 absolutnim maximem.

Obrdzek 3.30: Reseni ptikladu 3.36.

3.5 Vicerozmérny integral

Poznamka 3.17: Méjme spojitou funkei f(z,y) na obdélniku [a, b] X [¢, d]. Pak jsou spojité
i funkce p(z) a ¥ (y) dané integraly:

o) = [ 1)y o o) = [ S v

Funkce p(z) a ¢ (y) tak mizeme integrovat znovu a ziskat:

/bw(w) dx:/b/df(:r,y) dy dz,
/dw(y) dy = /d/bf(x,y) dz dy.

Ptedeslé integraly nazyvame dvojndsobnymai integraly.
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Definice 3.13: Necht 7" = [a,b] X [¢,d] C R? a necht je funkce f(z,y) spojitd na T.
Dvojnygm integralem funkce f(x,y) pfes mnozinu 7' pak rozumime:

[ 1w va dy=/b/df<a:,y> dy da:zfd/bﬂx,y) dz dy

Definice 3.14: Uvazujme nyni oblast, jiz budeme fikat oblast zdkladni, definovanou jako
T = {(,y) € R | 2 € [a3, az),y € [s1(2), s2(2)]}, resp. T = {(w,y) € R | y € [by, bo],w €
[p1(y), p2(y)]}, pficemz funkce sq(x), s2(x),p1(y), p2(y) jsou spojité na intervalech [aq, as],
resp. [by, by]. Zékladni oblast ilustruje pro lepsi predstavu obréazek 3.31.

b2

1) . P2(v)

a a2
(a) (b)

Obrdzek 3.31: Zobrazeni zékladni oblasti (pfevzato z [4]).

Analogicky jako v predchozi definici nyni definujeme dvojny integrdl funkce f(x,y) ptes
mnozinu 7" jako:

az s2(z)

[ @@= [ [ 1wy ayas
T a1 s (z)
resp. //f(x,y) dr dy = /b2 7y)f(x,y) dz dy.
T b1 p1(y)

Poznamka 3.18: Sjednocenim koneéné mnoha zakladnich oblasti muzeme ziskat tzv. ele-
mentarni oblast (mnozinu) K (viz obrazek 3.32).

Poznamka 3.19: Castym krokem pii vypoctu integral@ je prohozeni pofadi integrace.
Musime mit na paméti, ze vnéjsi integral musi byt vzdy ten, ktery neobsahuje proménnou
ve svych mezich.

Definice 3.15: Uvazujme nyni zdkladni oblast T = {(z,y) € R* | € [ay,as],y €
[s1(x), s2(x)]}, pFicemz funkce s1(z), s2(x) jsou spojité na intervalu [a, as]. Definujme zd-
kladni téleso P = {(x,y,2) € R® | (z,y) € T,z € [hi(z,y), ha(z,y)]}-

Trojngm integralem funkce f(x,y, z) pfes mnozinu P nazyvame:
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y X=a X:b
D

o)
.

X

Obrdazek 3.32: Zobrazeni elementarni oblasti (pfevzato z [8]).

hQ(x ag S2 (.’L‘) h2($,y)

///f(x,y,Z)da: dy dz:// /’y)f(x,y,z) dz :/ / fx,y,2) dz dy da.
r T \n(ey)

a1 s1(x) ha(z,y)

V systému Maple zadavame vicenasobné integraly opakovanym pouzitim integracniho
symbolu z palety Expression, piikazu int ¢i vyvolanim kontextové nabidky dokumentu
(po kliknuti pravym tlacitkem mysi na pfedpis funkce) a zvolenim polozky Integrate spolu
se specifikaci integracni proménné (pouze pro neurcity integral).

Symboly z palety Symboly z palety
J‘J‘[x+y] dxdy j‘j‘j{x+}'+z}dxdydz
xzv-i— 1 Vx 1 x21'2+ ! Vxz+ —z xy
PR 2 2° 277
1.5 315
j J (x+y) dxdy j j J (x+y+2z)dxdydz
0-2 17072
12 36
Textove prikazy Textove prikazy

it mt(x +yx), ¥

mt( int( int(x + vy +2z,x),v).2)

12 12 12 12

bR ?}x ?‘{121—?} xz—l—?z Xy
mt(mt(x+yx=2.5),y=0.1) mt(mt(mt(x +y+z,x=2.5),y=0.1),z=1.3)

12 36
Kontextova nabidka Kontextova nabidka
integrate wrtx 1 2 integratewrtx 1 2 integrate wrt y
x+y 5X +xy xt+tytz—mm 53X +xy+zx
integrate wrty 1 2 1 2 1 2 1 2 integrate wrtz ] 2 1 2 1 2

— X y+7xy 5 X v+7xy +zxy——m 53X y2+7xyz+7z Xy

Obrazek 3.33: Vicenasobné integraly.

Pokud chceme do dokumentu zapsat vicendsobny integral symbolicky (a nevyhodnocovat
jej), pouzijeme piikaz Int. Dalsi moznost, jak zadat (uréity) vicendsobny integral (dvojny
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nebo trojny), poskytuje piikaz MultiInt z baliku Student [MultivariateCalculus]. Pii-
kaz MultiInt nabizi moznost vypisu integralu jako symbolu i jako integralu, ktery bude
y,rovnou“ vyhodnocen. Navic je mozné nechat vypsat kroky vypoctu integralu nastavenim
nepovinného parametru output na hodnotu steps. Dalsim nepovinnym parametrem, ktery
muzeme specifikovat, je parametr coordinates urcujici, v jakych souradnicich je integral
uveden. Na vybér mame podle dimenze integralu soufadnice kartézské (cartesian[x,y]
nebo cartesian[x,y,z]), polarni (polar[r,theta]), sférické (spherical[r,phi,thetal)
¢i cylindrické (cylindrical [r,theta,z]).

Student| MultivariateCalculus | | Multilnt] (3 X +3 3,-2, x=1 |with(Student] MultivariateCalculus]) :

A, y=-1.6, output = z'megraf)

.-’»:(uhifm{r: r=1.4,0=0 % coordinates = polar| r, theta],
6 4 , '; =
| Bx+ 33;) dxdy output = imeg?‘af]
-171
Lr
2 2 2" 4
Student| MultivariateCalculus | | Multilnt | (3 ¥ +3y.x=1 | [ JZarde
4, y=-1.6) o 1
1092 e
.-’L:(ufzifm[r: r=1.4,0=0 s coordinates = polar| r, theta | ]
Student| MultivariateCalculus | | Multilnt | {3 7 +3 }'2: x=1 21
A y=-1 .6, output = SIQPS) 2
6 4
[ | (3 x2 +3 },-2) dxdy Multilnt(r,r=0.7,0=0 .7, ¢ =0 .7, coordinates
-1 = spherical| r, phi, theta), output = integral)
6 T 3
_ | [ (x3 N 3}'2 x) dy l[] l[] |0 v sin(0) dr d0de
—1 x=1.4
6 Multilnt(r,r=0.7,0=0 .7, ¢ =0 .1, coordinates
= (63+9)) % — spheri :
. spherical[ r, phi, theta] )
_ 1 s
= (63y+3)) 2"
v=—1.6
2 2
1092 Int(Int(3%° 4+3)°.x=1.4),y=-1.6)

6 .4 2 2
|| (3 x +3 yh) dxdy
-171
im(fm(.? x2 + 3}—'2:x=l ..4):}'=—1 ..6)
1092

Obrdzek 3.34: Vicendsobné integraly s prikazy MultiInt a Int.

K pfevodiim mezi riznymi soufadnicovymi systémy mutzeme vyuzit prikaz changecoords,
ktery prevede zadany vyraz z kartézského systému souradnic do nami zvoleného. Pro dvojné
a trojné integraly je k dispozici piikaz baliku Student [MultivariateCalculus] s nazvem
ChangeOfVariables prevadéjici proménné mezi dfive vyjmenovanymi souradnicovymi sys-
témy. Pfikaz ma jednu ,slabinu“, a to, ze zpravidla neprevede integracni meze do novych
proménnych, coz musime tedy udélat sami.
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t:h4::!?1§_.)rer::cac:msa’.s(x2 -I—y2, [x ], polar, [r, 9])
2 2 2. 2
r cos(B] + sml:B)

chancrecoards(r -I—L -I-z [y z] Sphenca! [r 0. 8])
¥ sm((j)] cos(ﬁ] +r sm((j)] 5111(0] +r ::os[ch]2

changecoords(x2 + }'2 + 22: [x, . 2], eylindrical, [, 9, z] )

r cos[ﬁ]2 +7 si:rl[ﬁ]2 +7

— ¥ [x,»]. logarithmic)
y?) -2 arctan[ l]
x

m

changecoords(x

l:rl(x2 +

with( Student| MultivariateCalculus|]) :

ChangerVariabi’es(;’»{uhﬂm( *+ }'2: x=1.4,y=-1.6,

ouzpur=imeg?‘af) [carres;anx ,» polar e])
y=06 x=4
| Parae
y=-1"x=1

ChangerVariabfe.s(;’»{ufrﬂm( *+ }'2 + 22: x=1.4,y=-1.6,

z=0..3, output = imeg?‘ai’) R [ cartesian, ., .
z=3 yv=6 .x=4% ’
| l I [sin(©)] do dr d@
z=0"y=-1"x=1

R Sphericai'r_ N e] )

ChangerVariabfe.s[.-’»:[ufxﬂm[ X +y2 + 22, x=1.4y=-1.6,z

=0.3, output= z'meg?'ai’j: [cane.sianx s eylindrical . ]]
= ¥. 0.z

z=3 y=6
| | |

z=0"y=-1"x=1

x=4
(P+2) rordoce

Obrdzek 3.35: Transformace mezi soufadnicovymi systémy.

Priklad 3.41:

Stanovte meze dvojnasobného integralu

I= f(z,y)dz dy.
|

Integral néasledné zapiste i s témito mezemi pro integracni oblast:

(a) Q:0<zx<y<l1,

(b) Q:x<z?+y? <1,

(c) Q:1< =]+ |yl <2,
(d) € je A s vrcholy [1,0],[1,1],]0,0].

Resend: Pii stanovovani mezi nAm miize velmi pomoci obrazek. Nejprve si tedy zadanou
mnozinu 2 vzdy vykreslime a nasledné odvodime meze jednotlivych integralid. Vyuzijeme
pritom pfikazl inequal z baliku plots, transform z baliku plottools a implicitplot
z baliku plots, s nimiz jsme se jiz setkali pii vykreslovani oblasti a defini¢nich obori funkei

v sekci 3.1.3.

(a)

Z obrazku 3.36 mtizeme vyvodit 2 riizné (ekvivalentni) zapisy integra¢nich mezi:

L.L0Sy<L0<z<y,
2 0<z<L,z<y<1.

Celkem tak ziskdvame:

1

1= [[temas = [ [ 5

0

[rtes
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plots| nequal | ({0 < x, x <y y <1}, x=-1.2,y=-1 .2, optionsfeasible

= (color = cyan). optionsexcluded= ( color —uhzre}, fabefs— ["x"."v"])
2 —_
}‘ l

Obrdzek 3.36: Zobrazeni oblasti Q z pfikladu 3.41.(a)

=
|
()
ta
—
=

pl = plots[ implicitplot] ( [x2 +y2 = l]_. x=-4.4,y=-2.2, color plots[display](p1. p2. f(p3). g(p4). p3., view=[-2..2,
= black, thickness =2, gridr efne 3) ey

p2 —ploz.s[;mpfzcztpfoz]([x < + ] x=—4 A, y=-2.
thickness = 2, color=black, gridrefine= 3

)

p3 —pfoz[‘.l'l—x -/ %—[z—T] x=0.1, filled=true

color = cyanJ :

iq

f = piorzoofs[nansfo;m][ (x¥)

[T

pd: —ploz[—‘#l—x + %_[‘{_T] x=0..1, filled=true,

color =cyan | :

p3 ::ploz( L.J 11—+ 1 - ],x=—l .0, filled = true, color

= cyan) :

:= plottools| transform | [ (x¥)

Obrdzek 3.37: Zobrazeni oblasti §2 z prikladu 3.41.(b)

(b)

Z obrazku 3.37 muzeme vyvodit opét 2 rizné (ekvivalentni) zapisy integracnich mezi.
Dostavame vsak vyrazné komplikovan€jsi zapis nez v predchozim pripadé, a tak za-
pisme pouze jednu moznost (kterd je jednodussi):
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1. -1<2<0,—vV1—-22<y
0<z<l,—V1I—-22<y<-—

(c)

pl = plots[ implicitplot| ([ 1 = |x| + [ ].x=-4 .4, y=-2 ..

color=black, thickness=2, gridrefine=3) :

p2 = plots[ implicitplot| ([ |x| + [y <2].x=-4 .4, y=-2..

thickness =2, color=black, gridrefine=3) :
1 := plotrools| transform | ( (%) —>[x, y+x+ 1]) :
12 := plotteols| transform | ( (%, ¥) =[x y+x—1]):
3 = plotrools| transform | ( (x ¥) —>[x, y—x— 1]) :
4 := plottools| transform | ( (%, ¥) =[xy —x+1]):

p3 ==plot(1,x=-1..0, filled = true, color = cyan) :
p4 = plot(-1.x=0..1, filled = true, color = cyan) :
p3 =plot(-1.x=-1..0, filled = true, color = cyan) :
p6 = plot(1,x=20..1, filled = true, color = cyan) :

p7 = plots[ implicitplot| ( |x| + |y <2,x=-2.-1,y=-2
gridrefine =2, filled= true, coloring = [ evan, white]) :
p8 = plots| implicitplot| ( |x| + |y <2,x=1.2,y=-2..
gridrefine =2, filled= true, coloring = [ evan, white]) :

B

B

2

plots|display](pl, p2, f1 (,]03]:ﬂ(p4]:f3(p5]:f4(p6]:p7, P8,

view=[-3.3,-3.3]
3_

23

ol
]
by
L

Obrdzek 3.38: Zobrazeni oblasti €2 z piikladu 3.41.(c)

I v tomto pfipadé mame dvé (zdkladni) moznosti, jak zapsat integra¢ni meze. Pro
komplikovanost zapisu ukazme opét pouze jednu z moznosti. Dopliime, ze v pripadech,
kdy je oblast Q symetricka (kolem pocatku ¢i kolem nékteré z os) a podobné i zadana
funkce (vzhledem k ose z), poc¢itdme zpravidla integral pouze pro ¢ast oblasti (tj.
napf. jen pro jeden kvadrant) a vysledek vynasobime po¢tem odpovidajicich si ¢asti.
V tomto prikladu bychom tak mohli pocitat integral pouze pro oblast nalezici prvnimu
kvadrantu a vysledek vynésobit ¢tyfmi (pokud by funkce f(z,y) byla symetricka kolem

osy z).

1. 2<z< -1, - —-2<y<z+2,
—1<z<0,—rz—-2<y< -1 Uz+1<y<ar+2,

0<z<lz—-2<y<z—1U

1<x<2)x—-2<y<—o+2.
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Celkem tak ziskavame:

-1 z+2 0 —z—1
I—/ f:z:ydxdy—//fxy dyd:v—i—//f(x,y)dydx—i—
—2 —x—2 -1 —x—2

0 z+2 rz—1 1 —z+42

1
—|—//f(x,y)dydx+0/ f(z,y) dyd:c+//f(:r,y)dydx+

—1 z+1 r— 0 —x+1

2
2 —x+
+// (x,y) dy dz.

pl == plots| pointplot | ([[1.0],[1,1], [0, 0] ]. color=red,
symbolsize= 20, symbol = solidcircle) :

p2 = plots| implicitplot]( {x=1},x=0 .1, y=0 .1, thickness
=2, color = black) :

p3 == plot([0,x],x=0..1, thickness =2, color = black) :

p4 = plot( x, x=0..1, filled = true, color = cyan) :

plots| display] (pl.p2. p3. p4)

1_

Obrazek 3.39: Zobrazeni oblasti Q z piikladu 3.41.(d)

Z obréazku 3.39 vidime, Ze situace je velmi podobna pfipadu (a). MiZeme opét vyvodit
2 rizné (ekvivalentni) zépisy integra¢nich mezi:

2.0<y<ly<z <1
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Celkem tak ziskavame:
1 =z 11
1= [[temasdy= [ [ s dyar= [ [ Go.9) do ay
Q 0 0 0 vy

Priklad 3.42: Stanovte meze dvojnasobného integralu

I= f(z,y)dz dy.
J

Integral néasledné zapiste i s témito mezemi pro integracni oblast:
(a) Q:0<z+y<1Az>0Ay>0, (c) Q: x|+ |y| <3,

(b) Q:2?24+y*<1Az >0, (d) Qje A s vrcholy [2,1],[—2,1],[0,0].

Priklad 3.43: Vyjadrete zadané integraly v obraceném poradi integrace.

42 22
Offfwydydm (C)fffxydydx
3 00
2 2.z 1 22
b) [ [ f(z,y) dy dz, (d) Offf(x,y) dy dz.
0z 23

3.5.1 Geometricka aplikace dvojného integralu
Obsah rovinné oblasti

Poznamka 3.20: Necht Q C R? je rovinnd oblast. Plocha S oblasti Q je ddna vztahem

S://dxdy.
Q

Priklad 3.44: Urcete obsah oblasti €.
(a) € je ohranic¢end kiivkami y = % ay=3—2-uz,
(b) € je ohranicend pfimkamiy =z, y=2z—3,y=2ay=4.

Reseni:

V zadani neni specifikovano, jak mame obsah zadané oblasti hledat. Mohli bychom si
proto vzpomenout na aplikace urcitého integralu funkce jedné proménné a pocitat obsah
oblasti timto zptisobem. U nékterych oblasti je navic jednodussi i jiny zptsob nez pocitat
integraly (jednoduché ¢i dvojné). My si ukdZeme vypocet jak pomoci jednoduchého, tak
pomoci dvojného integralu.
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.sofve[i=3 - 2-_::]
x

=
0| —

pl = pfor{

= constrained, color= "Na\yBluc“] :

p2 = pi’oz[.’i —2x— %, x= % .1, filled = true, color = cyan} :

o)

f = plortools| transform | { (xyv)—

plots| display] (p1.f(p2))
-

It
050607080910
x

1 1 ]
= 3 —2-x]:x— 5 .1,y=1.2, scaling

pl = plot(x,x=2 .4, color="NavyBlue", thickness=2) : #y=x

p2 == plot(x — 3,x=35 .7, color="NavyBlue", thickness=2) : #y=x-3
p3 = plot(2,x=2 .5, color="NavyBlue", thickness=2) : #y=2

p4 = plot(4,x=4 .7, color="NavyBlue", thickness=2) : #y=4

p3 = plot(x — 2,x=2 .4, filled=true, color=cyan) :

p6 = plot(2,x=4 .35, filled= true, color = cyan) :

p7 = plot(7T —x.x=35 .7, filled= true, color=cyan) :

f1 = plottools| transform | ( (x,¥) =[xy +2]):

f2 = plottools| transform | ( (x,y) =[xy +x—3]):

plos[display] ({pl.p2.p3.p4}.f1(p3).f1(p6)./2(p7))
4n

354

1.5

Obrazek 3.40: Zobrazeni oblasti Q z pfikladu 3.44. Vlevo pfipad (a), vpravo pfipad (b).

(a) Pomoci jednoduchého integralu zvolime jednu proménnou, u niz zndme ¢iselné meze,
a ,odecitame od sebe® dvé funkce vymezujici zadanou oblast. U dvojného integralu
zapiseme zadanou oblast pouze v integrac¢nich mezich. Pozor na to, ze pii vypoctu dvoj-
nasobného integralu v systému Maple musime zadat funkci, ktera bude integrovana.
V ptipadé pocitani obsahi rovinnych oblasti podle poznamky 3.20 se v integralu zadna
funkce nevyskytuje, i kdyz ve skutecnosti integrujeme konstantni funkci f(z,y) = 1,
kterou také zadame do integralu v systému Maple.

1 1 3-2x
1
3-2x——|d 1 dy dx
| (3-2nmt)e ],
L Y
) 3 “1n(2 i
“In(2) + 0(2) +
Obrazek 3.41: Vypocet obsahu oblasti €2 z prikladu 3.44.(a)
(b)
4 4 y+3
(y+3-y)dy 1 dxdy
j y y) LJ x dy

2%y

Obrazek 3.42: Vypocet obsahu oblasti €2 z ptikladu 3.44.(b)
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Priklad 3.45: Urcete obsahy oblasti € z pfikladu 3.42 a obsahy oblasti tvofenych inte-
gra¢nimi mezemi v prikladu 3.43. U prikladu 3.43 vypoctem obsahu piislusné oblasti navic
ovérte rovnost integralt v zadani a v feSeni.

Priklad 3.46: Pomoci dvojného integralu urcete obsah kruhu o poloméru r.

Priklad 3.47: Pomoci dvojného integralu urcete obsah oblasti ohrani¢ené elipsou o délce
hlavni poloosy a a délce vedlejsi poloosy b.

Objem télesa

Poznamka 3.21: Necht f(x,y) je spojita funkce na mnoziné Q@ C R? a necht f(z,y) >0
pro viechna (z,y) € . Objem (kolmého) té&lesa T' C R?® ohrani¢eného zdola mnoZinou €2
a shora ¢asti grafu funkce f(z,y) je dan vztahem

V://f(x,y)dx dy.

Priklad 3.48: Urcete objem kolmého télesa ohrani¢eného:
(a) funkci f(z,y) = 2* + y* a mnozinou Q : |z| + |y| < 1,
(b) funkci f(z,y) =64 —2? arovinami 3-z+4-y=24,2=0,y=0a 2z =0.
Reseni:

(a) Nejprve v systému Maple zobrazime téleso, jehoZ objem pocitame, a jeho podstavu
(mnoZinu 2), abychom ziskali pfedstavu a snize odvodili meze dvojného integralu.
S mnozinou € (resp. jejimi variantami) jsme se uz nékolikrat setkali, takze by nam
nemélo ¢init problémy pfepsat ji do mezi pro proménné z a y. Kdyz si vsak uvédomime,
ze mnozina € je stiedové soumérna podle pocatku souradné soustavy (bodu [0,0,0])
a ze zadand funkce f(z,y) je symetrickd podle osy z, miZeme pocitat objem pouze
Casti télesa vyskytujici se v prvnim oktantu (tj. pro x,y,z > 0) a vysledek vynésobit
¢tyfmi (abychom ziskali objem celého télesa rozprostirajiciho se pfes ¢tyfi oktanty, pro
néz z > 0).

Pro meze odpovidajici prvnimu oktantu plati:
0<z<1l, 0<y<l—n.

(b) Opét zobrazime téleso, jehoz objem pocitame. Vykreslenim v8ech rovin (resp. funkei),
které se protinaji a téleso vytvari, mizeme ziskat graf, ktery neni prili§ prehledny.
Nastavovanim rtiznych nepovinnych parametrt vykreslovacich prikazii, mizeme docilit
prehlednéjsiho zobrazeni. Na obrazku 3.44 je ziskané téleso zobrazeno 2x: vlevo ,bez
vétsich uprav®, vpravo bylo dosazeno zobrazeni télesa ,bez zbytecnych car®, ovSsem za
cenu pouziti dalsich prikazi a nékterych ,trika“.

Na obrazku chybi zvlastni graf s podstavou télesa. Z grafu vpravo je vsak ihned videét,
ze podstavu tvori trojuhelnik vymezeni pifimkami x =0,y =0a 3 -2+ 4-y = 24. Pro
meze integralu proto plati:

0<z <8, 0§y§@.
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pl :proz.?d( 2 +1,'2.x=—l JlLy=-1 ..l.axes=ﬁ‘ame) : plots[ mmpliciplot] ([ + | < 1,x=-1.1,y=-1.1,
. o ([ R T g] - view=[ -2 .2,-2 ..2], coloring = [ cvan, white].
p2 = plots| spacecurve]| |x, 1 —x, x + (1 —x) |,x=0.1, filled = true, thickness= 1, gridrefine = 6)
color = black, axes = frame, thickness = 4) : 21
p3 = plots| spacecurve ( [xx -1, ¥ +(x— 1]2]: x=0.1,
color= black, axes = frame, thickness = 4) :
4 :=pfozs[5pacecun’e]([x: 1+x, X +(1+ x}g]:x=—1 .0, s
color = black, axes = frame, thickness = 4) :
pI :=pi’ozs[5pacecun’e]([x:—l — X, X + (-1 —x]z]:x=—1 .0,
color = black, axes = frame, thickness = 4) :
p6 = plots[ implicitplot3d]| ([ |x| +|y=1].x=-1.1,y=-1.1,z | - - . - - .
=0 ..1, axes = frame, numpoints = 3000, transparency=0.5): 2 & i ?
plots display](pl. p2. p3. p4. p3. p6)
-1
24
1 1—x ,
V=4-J J x‘+y“)dvchc
00
v 2
3
¥

Obrdzek 3.43: Reseni piikladu 3.48.(a)

Priklad 3.49: Urcete objem kolmého télesa ohrani¢eného:

(a) funkci f(z,y) =6—2-2—3-yarovinamiz=0,y=0az =0,

(b) funkci f(z,y) = x + 2 -y a podstavou vymezenou grafy funkci y =2 — 2% a y = |z|,

(c) funkei f(z,y) = e”"t¥” g kruhovou podstavou popsanou nerovnici 22 + 32 < 4,

(d) funkei f(z,y) = 5-22—2-2-y a trojihelnikovou podstavou vymezenou body [2, 0], [0, 1]
a [0, 0].

2
(e) funkei f(x,y) = <§> a podstavou vymezenou grafy funkci y = z,y = % a pfimkou

r = 2.

Priklad 3.50: Pomoci dvojného integralu urcete objem kvadru o rozmérech a, b, c.
Priklad 3.51: Pomoci dvojného integralu urcete objem koule o poloméru r.

Priklad 3.52: Pomoci dvojného integralu urcete objem vélce o poloméru podstavy r
a vysce v.
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pl = plot3d(64 — . x=0.8,y=0.6,

axes=ﬁ‘ame) :
p2 = plots| implicitplot3d|([3- x +4-¥
=24],x=0.8,y=0.6,z=0 .64, axes
= frame, transparency=0.2) :
p3 = plots[ implicitplot3d] ([ x=0].x=0
.8,y=0.6,z=0 .64, axes=frame) :
p4 = plots| impliciiplot3d] ([ y=0],x=0
.8,y=0.6,2z=0 .64, axes=frame) :
plots|display](pl. p2. p3. p4)

64 —x° dydx

F=1280

pl ==plor3d(64 —xz,x: 0..8,y=0 .6, axes=frame, grid=[ 80, 80]. .nyle:parchcomour) :
p2 = plots|implicitplot3d|([3- x + 4-y=24],x=0.8,y=0..6,2=0 ..64, axes = frame, grid
=[50, 50, 501, style= patchcontour) :
p3 = plots| implicitplot3d]( [ x=0],x=0.8,y=0.6,z=0 ..64, axes= frame) :
p4 = plots| implicitplot3d]([y=0],x=0..8,y=0.6,2=0 ..64, axes = frame, grid =50, 50,
24—-3-x—4-y
(245 +x—64) ]” _

501, style= patchcontour) :
B | )
(z +x2 —3-x—4-y—40) ]” i
|z +x2 +x— 64|
-2+ 64],x= 0 ..8, axes = frame, thickness = 3] :

|- 45 —3x—4.y— 40|
63 .
L 11 @es = frame, lhmr’mess=4} :

f1 := plottoals| transform | [ (xw2) ﬁ»[x, Y. z-max[O,

f2 = plottools| transform]| (x y z) = |x vy. z-max| 0,

/3 :—plazmals[zransfarm][ XV z)

— | x, ¥, Z'max [ 0,

( 24—-3x 3 X
p3 = plots| spacecurve)

%0, -11- 2 +63],x=
).p3.f3(p4). p3.p6)

p6 = plots| Spﬂcecune][
plots| display ] ( f1(p

Obrdzek 3.44: Reseni piikladu 3.48.(b)

Obsah plochy

Poznamka 3.22:

Necht jsou funkce f(z,y), fi(z,y), f,(x,y) spojité na mnoziné Q C R?.

Obsah plochy tvofené grafem funkce f(x,y) nad mnozinou  je ddn vztahem

+ (fi(x,y)" dz dy.

~ [[ i+ (e

Piiklad 3.53: Urcete obsah plochy tvofené grafem funkce f(z,y) nad mnozinou 2 z pfi-
kladu 3.48 v pfipadé (a) i (b).

Resent:

V obou ptipadech vyuzijeme poznamky 3.22, jiz dfive vypocitanych integrac¢nich mezi
a predpisu ohranicujici funkce.

Piiklad 3.54: Urcete obsah plochy tvofené grafem funkce f(z,y) nad podstavou télesa
z prikladu 3.49.

Priklad 3.55: Urcete obsah povrchu koule o poloméru r.
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f(xy) =%+ f(xy) =64 -
(xy) x4y (xy)—>64 =
1. 1-x P 2 P 7 4-3x
s=4 | ‘/1+[a—f(x:y)] gt | & T , — 7
00 x Y S= 1 [L E [L 31 dv
i JJ /+ axf(x:}} + a},f(x.-}} ly
00
1 dx
S=4 ‘,[—%ln(l-lﬂlxz)—%ln(l-lﬂlxz)x2 ) 127 3 ) 1
0 - S‘=Tln(2}+ 16 J 257 +?1ﬂ[?+¥\f2:‘7]
1 [ 2 1 [ 2
+5V5+8xy —8x ——/5+8x —8xx 1
2 2 +—
) 16
+Tln(2—2x+\;“5+8x3—8x)+1n(2—2x
evalf (%)
+\,-’5+8x3—8x)x3] ch,] 5=132.5103717
evalf( %)
§'=3.004625434

Obrdzek 3.45: Reseni pifkladu 3.53.(a) vlevo, feseni ptikladu 3.53.(b) vpravo.

Piiklad 3.56: Urdete obsah ¢asti plochy koule o rovnici 22 + 3? + 22 = 25 vymezené
rovinami z =2 a z = 4.

Integralni soucet

Jak jiz vime, geometrickym vyznamem dvojného integralu z funkce f(z,y) pfes mnozZinu §2
je objem télesa ohrani¢eného mnozinou €2, funkci f(x,y) a ,svislymi osami“. Tento objem
muzeme pocitat pfiblizné pomoci dolnich (resp. hornich, ...) integrélnich souc¢ti podobné,
jako jsme si to ukazovali v ptfipadé jedné proménné v sekci 2.7.4. Tentokrat pritom aproxi-
mujeme objem souctem objemt kvadri se ,zjemnujici se“ ¢tvercovou zakladnou a vyskou
spoctenou napt. z funkéni hodnoty ve stfedu ¢tverce — zakladny nebo v jednom z vrcholi.
K tomu nam poslouzi prikaz ApproximateInt z baliku Student [MultivariateCalculus].
Pouziti ptikazu ApproximatelInt je takika totozné s piikazem RiemannSum, s nimZ jsme se
diive setkali. Pfikazu opét povinné zadavame funkci, jiz chceme integrovat, a meze inte-
grace. I v tomto piipadé mizeme zadavat nepovinné parametry specifikujici typ integralniho
souctu, typ vystupu, rozdéleni integracnich interval a dalsi. Ukazku pouziti miizeme vidét
na obrazku 3.46.

Tak jako v ptripadé funkci jedné proménné, kde miizeme misto piikazu RiemannSum vyuzit
nastroje Approximate Integration spousténém napiiklad z hlavniho menu, mame k dis-
pozici analogicky néastroj i nyni. Opét mé nézev Approximate Integration a tentokrat jej
spustime napftiklad zvolenim Tools > Tutors > Calculus — Multi-Variable > Appro-
ximate Integration... v hlavnim menu (obrazek 3.47).
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with( Student| MultivariateCaleulus] ) : Approximatelnt(x-y, x=0 .5, y=0..5, output = plot, prismoptions
= [ color=yellow], axes = frame)

f:: {x_. _}'] —+ Xy An approximation of the integral of
, , fix, vy =x¥y
Xy)—=Xxy - -
( o } - over the region [0 .. 5,0 . 5]
using a midpoint Riemann sum
, — — — Actual value: 156.25
p!or.?d(f(x:}}: x=0.5,y=0..5, axes ﬁ‘ame} Approximate value: 156.25

ApproximateInt(x-y, x=0 .5, y=0..5, output = animation,
prismoptions = | color = yellow], method = lower, axes = frame)

An animation of approximations to the integral of
fix yh=x*y
over the region [0 5,0 .. 5]
using a lower Riemann sum
Actual value: 156.25

ApproximateInt(x-y, x=0 .5, y=0.5)
156.2500000

Obrdzek 3.46: Aproximace dvojného integralu pomoci integralnich soucti.

3.5.2 Geometricka aplikace trojného integralu
Objem télesa

Poznamka 3.23: Necht P je mnozina z definice 3.15 (obecné staci tzv. méritelnd mnozina).
Pro objem V' této mnoziny plati vztah

V:///d:cdydz.

P

Priklad 3.57: Urcete objem trojosého elipsoidu daného rovnici
N 2 2 2N\ 2
5+ )+ -
a b c

Reseni: Nejprve si elipsoid vykreslime pro né&jaké konkrétni hodnoty a,b, c. Na obrazku
3.48 jsou pouzity hodnoty a = 13,b = 8,¢ = 6. Nasledné musime odvodit jednotlivé meze
v trojném integralu. Za ,pocateéni“ proménnou vezméme x, pro niz tak plati: z € [—a, al.
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f1aMultivariate Calculus - Approsimate Integration x|

File Help

~ Plok indow

— Opkions
f= |><*y
ES = |0 e
b=k . F
Iy = |0 a0 |5
Partition; [ |5 , |5 1
Method:
" Midpaint {* Lower
" Upper " Random
Coordinate System;
{* Rectangular " Polar
Walues
Approximate Yalue IIUD.DU
Actual Value |156.25
i Display Animate Plot Options Close
~ Maple Command
ApprosimateIntl xfy, x = 0 .. &,y = 0 . & method = lower, coordinater T carbesian, partition = [5, 5],
output = plot) :

Obrdzek 3.47: Aproximace dvojného integralu — maplet.

Proménnou y vyjadiime pomoci proménné z jako: y € —\/ 1— (%)2, \/ 1-— (f)2 a nakonec

proménnou z pomoci zbylych proménnych jako: z € —\/1 — (§)2 — (%)2, \/1 — (§)2 — (%)2

2
plots| implicitplot3d] [ [ [ %] + [

¥

8

2 2
Z| = = b 1—
] +[6] 1]x 13 2 by

.13,y=-8 .8,z=-6 .6, axes = frame, scaling= constrained

Obrdzek 3.48: Reeni prikladu 3.57.
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Priklad 3.58: Pomoci trojného integralu urcete objem télesa z prikladu 3.48.
Priklad 3.59: Pomoci trojného integralu urcete objem kvadru o rozmeérech a, b, c.
Priklad 3.60: Pomoci trojného integralu urcete objem koule o poloméru r.

Priklad 3.61: Pomoci trojného integralu urcete objem véalce o poloméru podstavy r
a vysce v.

3.5.3 Transformace souradnic ve dvojném a trojném integralu

U skupiny integrali, kde pracujeme s kruhovymi, kulovymi ¢i valcovymi plochami, byva
vyhodna transformace do polarnich, sférickych ¢i cylindrickych souradnic.

Poznamka 3.24: (Transformace do polarnich soufadnic) Uvazujme dvojny integral

// f(z,y)dz dy.

Pro transformaci tohoto integralu do polarnich souradnic danych vztahy
x=r-cos(f), y=r-sin(h)

plati:

// Fay)dr dy = //f(r-cos(@),r~sin(9))~rdr a0,

kde r € [0,00),0 € [0,2 - 7].

Poznamka 3.25: (Transformace do sférickych soufadnic) Uvazujme trojny integral

///f(x,y, z)dx dy dz.

Pro transformaci tohoto integralu do sférickych soutadnic danych vztahy

x=r-cos(¢)-sin(f), y=r-sin(¢)- sin(h), z =r-cos(d)

///f(x’y’z)dx dy dz =

_ / / / F(r - cos(¢) - sin(8), r - sin(6) - sin(8), r - cos(8)) - sin(8) - 1> dr do d6,

plati:

kde r € [0,00),6 € [0,2- 7,0 € 0,2 - 7.

133



Poznamka 3.26: (Transformace do cylindrickych soufadnic) Uvazujme trojny inte-

gral
///f(x,y, z)dx dy dz.
971

Pro transformaci tohoto integralu do cylindrickych soufadnic danych vztahy

x=r-cos(d), y=r-sin(f), z ==z

[ #enmyar ayaz= [[[ 1-cos®).r-sin0). ) rar a0 a,

kde r € [0,00),0 € [0,2 - 7],z € R.

plati:

Priklad 3.62: Pouzitim transformace do polarnich souradnic urcete objem kolmého télesa
ohranic¢eného funkci f(z,y) = e®**v* a kruhovou podstavou popsanou nerovnici 22 + 2 < 4.

Reseni: Mtizeme vyuZit poznadmky 3.24 nebo zapsat dvojny integral pro kartézské soutad-
nice, ktery jsme jiz vytvorili v prikladu 3.49.(c), a pro transformaci do soufadnic polarnich
vyuzit pfikaz ChangeOfVariables (Ci piikaz changecoords). Provedme druhou moznost.

Integracni meze Maple nepfevede, musime je tak vytvorit sami. Podstavou télesa je kruh
o poloméru r = 2, coz vede na nésledujici meze: r € [0,2],0 € [0,2 - 7]. MiZeme pozorovat,
ze v porovnani s feSenim piikladu 3.49.(c) jsme tentokrat ziskali i analytické FeSeni.

Im(fm(ex2+32:y= - 4 - 4= X ):x=—2 ..2)
)

=2 y=J4-x2
d rdrde
=-2 1=—\."I4— 3
2 2m n
V—J‘J‘ ¢ rdod
0-0
V=-ntc'w
evalf (%)

F'=168.3835544

Obrdzek 3.49: ReSeni prikladu 3.62.

Priklad 3.63: Pouzitim transformace do polarnich soufadnic urc¢ete objem kolmého télesa

ohrani¢eného funkci f(z,y) = /1 — 22 —y? a kruhovou podstavou popsanou nerovnici
4y <1

Priklad 3.64: Vratte se k prikladtim 3.46, 3.51, 3.52, 3.60 a 3.61. P¥islusné vypocty nyni
provedte i v jiném systému soufadnic (tj. napf. polarnich, sférickych, ...) a vysledky porov-

nejte s piivodné ziskanymi.
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3.6 Nekonecné rady

Definice 3.16: Méjme funkci f : R — R. Jestlize D(f) = N, nazyvame tuto funkci
posloupnosti redlngjch ¢isel a znacime {a,}>2 ;.

Definice 3.17: Necht {a,}>°; je posloupnost redlnych ¢isel. Symbol

Zan nebo a;+as+ ... +a, + ..

n=1

nazyvame nekonecnou (¢iselnou) tadou. Posloupnost {s,}>2 ; definovanou predpisem
S1 =@y, Spg=a;+ag, .. S,=0ai+az+ ..+ ay,

nazyvame posloupnosti ¢dastecnych souctu této rady.

o
Definice 3.18: Existuje-li vlastni limita lim s, = s, fekneme, Ze fada > a, konverguje

n—oo

n=1
a ma soucet s.
oo
Neexistuje-li vlastni limita lim s,, Fekneme, 7Ze fada ) a, diverguje.
n—oo n=1

Poznamka 3.27: Divergenci fady mizeme jesté rozlisit na t¥i pripady:

e je-li lim s, = oo, fikame, ze fada diverguje k oo,

n—oo

e je-li lim s, = —oo, fikdme, Ze fada diverguje k —oo,

n—oo

e pokud nh_)n;o s, neexistuje, fikame, ze fada osciluje.

V systému Maple zaddavdme posloupnosti pomoci piikazu seq nebo pomoci kontextové
nabidky dokumentu. Piikaz seq je mozné pouzit nékolika riznymi zptisoby s ohledem na to,
jaké mu zadavame parametry. S vyjimkou jediného pripadu mu vzdy zadavame jako prvni
parametr n-ty ¢len posloupnosti a dalsim parametrem (dal$imi parametry) specifikujeme,
které ¢leny posloupnosti chceme vypsat (coz mizeme ucinit zadanim intervalu, zapisem
jediné hodnoty — pro jediny ¢len nebo vypisem ¢lent posloupnosti v seznamu).

V pripadé pouziti kontextové nabidky zadame do dokumentu n-ty clen posloupnosti,
klikneme na néj pravym tlacitkem a zvolime polozku Sequence spolu s itera¢ni promeén-
nou. V nasledné zobrazeném okénku navolime, které ¢leny posloupnosti chceme vypsat do
dokumentu. Pouziti kontextové nabidky ma vsak oproti prikazu seq mnoha omezeni.

Posloupnosti {a,} miZeme téz vykreslovat do grafi. Potfebujeme k tomu vytvofit dvo-
jice [n, a,], které nasledné zobrazime jako body piikazem plot. Pro vytvoreni dvojic [n, a,]
muzeme pochopitelné pouzit piikaz seq, vykresleni bodi je tfeba specifikovat parametrem
style nastavenym na hodnotu point (v pfikazu plot).

Nekone¢né fady (i konecné soucty) zadavame v Maple nékolika zpusoby. Jednak paleta
Expression nabizi preddefinovany symbol velkého feckého pismene sigma, k dispozici je
také prikaz sum a vyuZzit muZeme opét i kontextové nabidky dokumentu (i kdyZ trochu
,komplikované“). Piikaz sum méa dva parametry (n-ty ¢len fady a ,souctové“ meze). Po
provedeni piikaz vypiSe soucet fady (pokud jej umi urcit). Systém Maple nabizi téz piikaz
Sum s velkym pocateénim pismenem, jenz slouzi pro matematicky zapis fady s pouzitim
feckého pismene sigma. A pravé takovy zapis je mozné ziskat i pomoci kontextové nabidky,
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Seq(nz,n=0 ..10)
0.1.4,9. 16,25, 36, 49, 64, 81. 100

Seq[nzrn=k)
N
2
Jeq(nzrn=8)
64
Seq(nz,n in[1,3,5, ?])
1,9,25,49
7 sequence wrt.n ~
f——— 0,1.4.9,16, 25, 36, 49, 64, 81, 100

7 sequence wrtn

n——— 64

Obrdazek 3.50: Rizné moznosti vypsani ¢lenti posloupnosti.

dvojice == Seq( [n: ME]: n=10 ..10)
[0.0].[1,1]. [2.4].[3.9]. [4.16], [5,25], [6.36]. [7,49]. [8.64]. [.81], [ 10,100]
plot( [ dvojice], style = point, symbol = solideircle)
1004 [
304 *
.
60
.
40
L]
L]
20
L]
.
.
i * T T T T 1
0 2 4 f 3 10

Obrazek 3.51: Vykresleni ¢lenti posloupnosti.

kdyz do dokumetu zapiseme n-ty ¢len rady, klikneme na néj pravym tlacitkem mysi a zvolime
polozku Constructions > Sum > n. Dalsim kliknutim pravého tlacitka mysi (tentokrat na
matematicky zapis fady) a zvolenim Evaluate (from inert) ziskdme soucet fady (pokud
jej Maple umi urcit).

S tim, co jiz zname, nam nic nebrani ve vypsani posloupnosti ¢astecnych souctt. Tuto
posloupnost navic mizeme vykreslit, naptiklad spole¢né se souctem fady — viz obrazek 3.53.

Existuji nekone¢né fady, jejichz soucet Maple neumi uréit®. V takovych piipadech ani
nevypise, zda fada soufet mé (tj. zda konverguje) ¢i zda fada diverguje. V téchto situacich
musime konvergenci fady vysSetfit ,sami“ jinymi postupy, pricemz si samoziejmé mizeme
,pomahat systémem* pti dil¢ich krocich.

NN v

8V Maple 14 neexistuje piikaz, ktery by uspokojivé fesil limity posloupnosti realnjch ¢isel.
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o

(3-n+1)
1

3

Casteény soucet fady:

s 1

= (3n—2)-3n+1)

,n=l..00]

>

n=1

3n—2)

(3-n+l]

“"”[ {3-n—2)1-{3-n+1) ;=1 "5]

Matematicky zapis fady:

w
1 smwrtn N

~ 1 +L (3-n—2)-(3-n+1) n
3(3k+1) 3
1 . 9% = value( %
mm[ (3-n—2)1-(3-n+1)’”:1"k] s;fm[ G D) Gt 1,,00], % =value( %)
I SR 5 D S
3(3k+1) 3 = (3n—2)(3n+1) 3

Obrdzek 3.52:

Riizné moznosti zapisu nekoneénych (i koneénych) rad.

n

castecne_soucty ‘= seq| | n, z
i=1

n=1.25

1 2 3 4

—_ = - A —

[1: 4 ]: &3 7 l:[s: 10 :|:"L 13 ]

6 7 g 9

9| 7—[3—5{ 28
11 12 13
- i S

[11’ 34] 1-37 [13 40

15 16 17

— 16, 17, — |, | 18,

46 49 [ 52 [

20 20 1, 22 22

e ) [ a7

24

= il =

73 25, Tﬁ

(Bn—2) Bn+1)

soucty plot = plot( [ castecne_soucty], stvle=point, symbol = solidcircle,
1 symbolsize=20) :
(3-i—2)-(3-i41) soucet_rady plot = pi’oz[ %: n=0.25, color= blue, zhickne.s.s=2] :
plots| display] ( soucty_plot, soucet rady plot)
0.33—_ ......o.ccoooc
5 5 6 032 .® o®
16| [
10 10 031 o °
[ 3 31 4

0304 L ]

[ 14, % [ 15, 1
0.29 4

18 19 | e

19,

55 [ 58 0.28

[ 23, 70 [24’ 0.27 1
0.26
025 e , , ,

1] 5 10 15
kel

Obrazek 3.53: Vykresleni posloupnosti ¢asteénych souctit a souctu rady.

Priklad 3.65:

@) 3

1
. 1)°?
« m-(nt1)

Urcete soucty nasledujicich rad:

8

3=

(0) 3 &

S
Il
—
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Priklad 3.66: Urcete soucty nasledujicich rad:

(a) niz’il (VAT 2-2-vaT1+yn), (b) 3 arctan (51;).

n=1

Resent:
a) Systém Maple zadanou fadu seéist neumi. Uréime tedy ¢astecny soucet fady s pro
libovolné (pevné) k a nésledné provéfime existenci limity tohoto ¢asteéného souctu
pro k — oo. Céastecny soucet s, pritom odvodime na zékladé nékolika Easteénych
sou¢tti pro ruzné konkrétni numerické hodnoty. Zcela spravné bychom méli (naptiklad

matematickou indukei) dokézat, ze pravidlo, které vypozorujeme z nékterych (nejlépe
nékolika prvnich) ¢asteénych soucttt plati skuteéné pro libovolné k.

(

Naznacme proto takovy diikaz aspon nyni. Diky Maple vime, ze

10

S (Vat2-2-VatT+va) =1-v2-VII+VI2

S (VaFa-2 Vet i+ Vi) =1-VI-VI2+ Vi3,
S (Vat2-2-VatT+va) =1-v2- Vi3 +VId

Predpokladejme nyni, ze pro libovolné £ > 10 plati:

k

Z(W—Q-\/H—H—F\/ﬁ):1—\/5—\/16-4-14-\/1{:—1—2.

n=1
Pak plati:
k+3
Z(x/njt —2~\/n—|—1+\/ﬁ) = 1-V2—VE+1+VEk+2
n=1

- (\/k:—+3—2~wk+2+wk+1>
+ (\/k—+4—2-\/k+3+\/k:+2>
_|_

(\/k:+5—2-\/k:+4+\/k:+3>
= 1-V2—Vk+4+Vk+5.

Zjistili jsme tedy, ze pokud nase hypotéza plati pro libovolné k > 10, plati i pro k + 3.
JelikoZ vime, Ze vypozorovany vztah plati pro k € {10, 11,12}, pak musi nutné platit
pro zcela libovolné £ > 10.

(b) Systém Maple zadanou fadu secist opét neumi. Postupujeme totoZnym zptisobem jako
v predchozim prikladu. Opét je tfeba dokazat, ze vypozorovany vztah skutecné plati
pro libovolné k. V tomto piipadé to nechdvame na ¢tenaii (obrazek 3.54).

Casto se nam miize stat, ze neumime soucet fady uréit. V této situaci bychom presto
chtéli alesponi odpovéd na otazku, zda fada konverguje ¢i diverguje. Zabyvat se nyni budeme
fadami s nezdpornymi ¢leny, u nichZ plati, Ze bud konverguji nebo diverguji k nekonecnu.
Pro zjisténi, zda fada konverguje ¢i diverguje, mame nékolik rozhodovacich kritérii.
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o

(Jn+2 —2-Jn+l+\.*7) zarctan[ 17]
=1 n=1 -

n 2-n
2;(J”+2 _EJ”+l'+J;) E:mdm{ ljJ
n=1 n=1 2n
10 10
2 —2.
MEZl(\/n+_ 2yn+1 +n) ﬂ_mphﬁ[zmm[ 17]]
= 2.7
1-J2 =11 +y12 n=l -
11 arctan[ﬁj
zl[\/n+2 —2Jn+1 +Jn) . 1
n=
implify t
1—y2 —J12 +/13 samplify HZIE“"CM[ P ]J
12 11
(Vn+2z —2yn+1 +yn) mm[?]
n=1
12
1=V2 —y13 +/14 simplify zarctan[ lj
n=1 2-n
88 12
S (Jn¥2z —2yn+1 +Jn) mm[ﬁ]
n=1
88
1—\/?—\,89 V90 .simphﬁ'[zarctan[ l,
n=1 2-n"
88
J; Zrejme, ze: arctan[ g]
zl[\fn+2 —2/ntl4+/n)=1-J2
"= Je ziejmé, ze:
—JE+1 +/k+2 L reme .
1
t =arctan| ———
Amted}-': MTzlarc an[ 2.;12] arc an[ k+1]
Z1UH+2 —2/n+1 +n)= A tedy:
n= L]
, M~ T4 355 = =
klg)nmil—v-E—v-k+1+v-k+_)—1—\.-2 Zarctan 17 = lim a.r(:tan[—}C ]=LE
n=1 2.0 k—o k+1 4

Obrdzek 3.54: Reseni pifkladu 3.66. Cést (a) vlevo, ¢ast (b) vpravo.

Poznamka 3.28: (Srovnavaci kritérium) Méjme fady > a,, > b, s nezidpornymi
n=1 n=1

¢leny a necht a,, < b,, pro vSechna n € N. Pak plati:

e konverguje-li fada ) b,, konverguje i fada > a,,
n=1 n=1

e diverguje-li fada »_ a,, diverguje i fada Y b,.

n=1 n=1

o0 o0

Poznamka 3.29: (Limitni srovnavaci kritérium) Méjme fady > a,, Y b, s nezdpor-
n=1 n=1

nymi ¢leny a necht existuje
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Pak plati:

e je-li L < oo a konverguje-li fada Y b,, konverguje i fada >’ a,,

n=1 n=1

e je-li L > 0 a diverguje-li fada > b, diverguje i fada Y a,.

n=1 n=1

Poznamka 3.30: (Odmocninové kritérium) Necht > a, je fada s nezadpornymi cleny.

n=1
e Plati-li pro vSechna n € N: /a,, < g < 1, pak fada konverguje,

e existuje-li
lim /a, =g, kde ¢ € RU {—00, 00},

n—oo

pak pro ¢ < 1 fada konverguje, pro ¢ > 1 fada diverguje.

Poznamka 3.31: (Podilové kritérium) Necht > a, je fada s nezdpornymi ¢leny.
n=1
e Plati-li pro vSechna n € N: aZ—:l < q < 1, pak tfada konverguje, plati-li pro vSechna
n € N: #52 > 1, pak fada diverguje,

e existuje-li
. An+1
lim =q, kde ¢ € RU {—00, 00},

n—oo

pak pro ¢ < 1 rada konverguje, pro ¢ > 1 fada diverguje.

Poznamka 3.32: (Limitni Raabeovo kritérium) Necht )" a, je fada s nezdpornymi
n=1

¢leny a necht existuje

lim n - <1— an+1> =q, kde ¢ € RU {—00, 00},

n—oo Qan,

pak pro g > 1 rada konverguje, pro ¢ < 1 fada diverguje.

Poznamka 3.33: (Integralni kritérium) Necht je funkce f definovand na intervalu
[1,00), kterd je na tomto intervalu nezdporna a nerostouci. Necht f(n) = a, pro n € N.

Pak fada ) a, konverguje pravé tehdy, kdyz konverguje nevlastni integral

7f(a:) dx.
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Priklad 3.67: Rozhodnéte o konvergenci nasledujicich rad:

@ 3 b @ 3

o0 o0

(b) 3 sin (), © 3w

n

(© >

n
n=1 (3+% ) "
Resend:

o0
(a) Vyuzijeme srovnévaciho kritéria a toho, Ze fada ) % diverguje. JelikoZ pro vSechna
n=2

n € N\ {1} plati: % < @, podle srovnévaciho kritéria fada ﬁ diverguje.
n=2

o
(b) Nyni vyuzijeme limitniho srovnavaciho kritéria a znovu fady > %, kterd diverguje.
n=2

Jelikoz lim Si“E%) =, fada ) sin (”) diverguje.

n

n—oo  n ne1

(c) Opét budeme pocitat limitu, tentokrat v odmocninovém kritériu.

Jelikoz lim ,/—"~= = %, zadana fada konverguje.

(d) V tomto piipadé vyuzijeme podilového kritéria, resp. opét jeho limitni varianty.

(n+1)n+1
Jelikoz lim —“2— = e, zadana fada diverguje.

n—00 nr

(e) V poslednim piipadé pouzijeme integralni kritérium. Funkce f(z) = m je na inter-

valu [2,00) nezédporné a klesajici (pfedpoklady integralniho kritéria). Jelikoz

7f(l’) dr = oo,

fada ﬁ(n) diverguje. Pomocné vypocty v Maple k predeslym ptikladim ilustruje

obrazek 3.55.

Priklad 3.68: Rozhodnéte o konvergenci nasledujicich fad:

@ X (Vi-va=1). (@ T+ ) G
0) 3, 7t (©) 3 sin (). ) 3z,
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n=2 n=1ﬂ!
31 L
= 1n(n) n=1 !
o +1
Xi (n+1)”‘I
=" lig — (1)
M= n
o0 n
'
1 1 €
.sohe[ - < Tn () ]

RealRange( Open(1), «)

@ foz{ !
ZL p x-In(x)
n=11 9
o« 4
8_
sin{%] 74
lim ———— 1
—+ G0 L 6—
n ]
n 7
4_
3_
2_
1_
103 4 5 6 7 8 8 10
x
1
jx-ln{x}
) 2]

Obrazek 3.55: Pomocné vypocty k feSeni piikladu 3.67.

3.6.1 Absolutni konvergence rad

o

Definice 3.19: Nekonecnd fada ) a, se nazyva alternujict, jestlize pro vSechna n € N
n=1

plati: signum(a,1) = —signum(ay,).
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Poznamka 3.34: (Leibnizovo kritérium) Nechf a,, je nerostouci posloupnost kladnych

¢isel. Pak alternujici fada > (—1)""!- a, konverguje pravé tehdy, kdyZ plati lim a, = 0.
n=1 n—00

Alternujici fady zadavame systému stejnym zptisobem jako veskeré nekonecné fady. Jak
uvidime, systém Maple umi pocitat soucty alternujicich rad. V pripadech, kdy soucet rady
urc¢it nedokaze, ndm velmi pomuze vyse zminéné Leibnizovo kritérium konvergence.

Priklad 3.69: Rozhodnéte o konvergenci nésledujicich fad:

(=1 (b) 3 L (—1)m .

n=1

:I'—‘

e

@ >

Regeni:
(a) Systém Maple urci soucet zadané rady.

(b) V tomto ptipadé Maple soucet neurci, vyuzijeme proto Leibnizova kritéria, diky némuz
zjistime, Ze zadana rada diverguje.

(=]

3 (L) Z[JL]HW

In(2)

1
—_

Obrazek 3.56: Pomocné vypocty k feseni prikladu 3.69.

[o¢]
Definice 3.20: Rekneme, Ze nekonecnd fada Y a, konverquje absolutné, jestlize konver-
n=1

oo o0 oo
guje fada ) |a,|. Jestlize fada Y a, konverguje a fada > |a,| diverguje, fikame, ze fada

n=1 n=1 n=1
o0
> a, konverguje neabsolutné.
n=1

Poznamka 3.35: Konverguje-li fada ) |a,|, konverguje i fada Y a,. Diverguje-li fada

n=1 n=1

> an, pak diverguje také fada ) |a,]|.

n=1 n=1
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Priklad 3.70: Rozhodnéte o konvergenci a absolutni konvergenci nasledujicich rad:

(&) o0

(a) Y ln(1+2) (-, (b) > sy (D)™

n=1 n=2

Reseni:

(a) Systém Maple soucet zadané fady neurc¢i. Vyuzijeme proto Leibnizova kritéria, diky
némuz zjistime, ze zadana rada konverguje. K posouzeni absolutni konvergence jiz
miizeme vyuzit systému Maple. Zavér tedy je, ze zadana fada konverguje neabsolutné.

(b) Systém Maple neurci soucet ani jedné z fad. Pro posouzeni konvergence zadané rady
vyuzijeme Leibnizova kritéria, diky némuz zjistime, zZe zadana fada konverguje. Kon-
vergenci (resp. divergenci) fady absolutnich hodnot mtizeme ovéfit napf. integralnim
kritériem, coZ jsme provadéli jiz v ptikladu 3.67.(e), kde jsme zjistili, Ze tato fada
diverguje. Zavér tedy je, ze zadana fada konverguje neabsolutné.

S L 1yl S ; 13
;m[u H){ 1) ;122?’1'111{“) (-1)

ém[u%] 1y i (—1)’;

1 m —
Hli_r)nmln[1+?] .

Em[l +L] n= 1n(n)
n=1 1

o 3 1
n=2

nln(n)

Obrazek 3.57: Pomocné vypocty k feseni prikladu 3.70.

Priklad 3.71: Rozhodnéte o konvergenci a absolutni konvergenci nasledujicich rad:
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4 Chybové zpravy

V této kapitole si ukdzeme nejcastéjsi chyby pii praci se systémem Maple.

4.1 Chybové zpravy (Error Messages)

4.1.1 Math mode / Text mode

Jednou z prvnich chyb, kterych se uzivatelé c¢asto dopoustéji, je nevénovani dostatecné po-
zornosti piikazovému (matematickému) a textovému rezimu. Piikazovy (matematicky) rezim
(Math mode) slouzi k zépisu piikaz. Po kliknuti na kldvesu Enter dojde k jeho vyhod-
noceni. Textovy rezim slouzi k zapisu obycejného textu. Po kliknuti na klavesu Enter se
,pouze“ piesuneme na novy fadek. Casta a nékdy tézko odhalitelnd chyba je ,smichani
téchto dvou rezimu pii zapisu prikazu, kdy zpravidla ziskavame chybné vysledky. To, jestli
je cely piikaz zapsany v piikazovém (matematickém) rezimu, mizeme poznat z fontu pisma
(ale nemusi tomu tak nutné byt). Nejjistéji to pozndme umisténim kurzoru na piikaz, kdy
se objevi (nanestésti slabé viditelny) Sedy obdélnik tvofeny prerusovanou ¢arou vymezujici
znaky zapsané v pfikazovém (matematickém) rezimu — viz obréazek 4.1. U druhého piikazu ve
spravné varianté (vpravo) je kurzor umistén na ptikazu, mtzeme si tedy vS§imnout zminéného
prerusovaného obdélniku.

Chybné zadané piikazy (na prvni pohled neni poznat rozdil). | Spravne.

15+20 15420

20 35
sin[

]-COS(E]J-I-E

w|:.|

] -cos(m) + 2 sin[

w|r—|

(3]
—_

Obrazek 4.1: Chyby v pouziti matematického a textového rezimu.

4.1.2 Chybné argumenty prikazu

Dalsi velmi ¢astou chybou (ne-li nejéastéjsi) je Spatné zadani argumentt piikazt. Kazdy
piikaz ma definované pouziti. Vzdy mu musime nastavit povinné argumenty, mizeme pridat
volitelné (charakterizované slovickem optional). Argumenty musi byt zadany vzdy v tako-
vém tvaru, jaky je predepsany. Informace o tom, jak dany piikaz pouzit, jak specifikovat
argumenty ptikazu, které argumenty jsou povinné a které volitelné, nalezneme v napovédeé
systému Maple k pfislusnému piikazu. Nésleduje (na obrazku 4.2) pfehled chybovych zprav,
které Maple pfi Spatném zadani argumentti vypisuje.
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Chybné zadané piikazy.

1.sin([5])

Error, invalid input: sin expects its 1st argument,

%, to be of type algebraic, but received [5]

2. LinearAlgebra| Eigenvalues](2)

Error, (in LinearAlgebra:-Eigenvalues) invalid input:

LinearAlgebra:-Eigenvalues expects its 1lst argument,

A, to be of type Matrix(square) but received 2

3.s0lve(5-x—7-y=-9,3-x+y=35)
Error, invalid input: too many and/or wrong type of

arguments passed to solve; first unused argument is

3*x+y = 5

4. roots(sin(x) )
Errcor, (in roots) argumsent must be a2 polynomial over

an algebraic number field

5. simplify(|x-y].x=0)
Error, (in simplifyv/do) invalid simplification
command

6. simplify( |x-y|, assume=x)

Error, (in assuming) when 'assume’ Beceived
'last object, x, has no property'

7. simplify(Jx-y, {x > 0,y=0})

Error, (in unknown) inwalid input: numer expects its

1st argument, x, to be of type {set, list, algebraic}

but received 0 < x

8. convert % parfrac
(x-b)

Error, (in convert/parfrac)

Spravne.

1.sin(5)

2. LinearAlgebra| Eigenvalues|({{1,4)|{4, 1}))

3.solve( {5:x—T-y=-9.3-x+y=5})
{x=1,y=2}

4. roots(x)

5. simplify( |x-yl. {x=0})

6. simplify( |x-y|. assume(x :: 0) )
0

7. simplify([x-yl, {¥=0})
0

8. com’err[

ﬁ, parfrace, x]

1

sin(5)

o

[[0,1]]

0

b

x—b

+
(x—b)?

Obrazek 4.2: Chyby v zadavani argumenti prikazu.

4.1.3 Nespravné pouziti zavorek

V systému Maple mtizeme pouzivat vSechny typy zavorek, kazdy typ ma vSak jiny vyznam
a tedy jiné pouziti. Navic je tfeba davat pozor na pocet levych (otevirajicich) a pocet pravych
(uzavirajicich) zavorek. Vzdy, kdyZ se tyto poéty nerovnaji, systém vypiSe chybovou zpravu

Error, unable to match delimiters (obrazek 4.3).

4.1.4 Nespravné prirazeni

Systém Maple disponuje tzv. systémovymi proménnymi a prikazy. Jejich nazvy jsou chra-
néné, tj. do chranénych proménnych neni mozné prirazovat jiny typ hodnot, nez pro ktery
jsou urceny a nazvy piikazt neni mozné pouzivat jinak nez jako ptikazy s definovanym pouzi-
tim (tj. neni mozné si napt. vytvorit proménnou se stejnym nazvem jako néktery z piikazi).
To, jestli je néjaky nazev chranény ¢i nikoliv, je mozné zjistit prikazem type majicim dva
argumenty: nazev (jméno), u néjz chceme zjistit, zda je chranény, a argument protected
(ktery uz se nenastavuje na zadnou hodnotu) — viz obrazek 4.4.
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Chybné zadané piikazy. Spravné.
1.3)"2 1.372
Error, unable t 0
2.2-(3—-1( +4 )
Error, unable 2.2-(3-1(+4) 3
3. {sin(x-(x+1)),cos(x(x+1)),tan(x-(x+1)}
Error, unable to match delimiters |3 {sin(x(x+1)).cos(x-(x+1)).tan(x- (x+ 1))}
Ysin(x(x+ 1)), cos(x(x+ 1)), tan(x(x+ 1)} {eos(x (x+1)).sin(x(x+1)).tan(x (x+ 1))}
4. cos(r}
Error, unable to match delimiters
cos(mt 4. cos(r)
-1
5. cos(m]
Error, invalid interval 5. cos(m)
cos(x] -1
Obrdzek 4.3: Chyby v pouzivani zavorek.
Chybné zadané piikazy. Spravné.
1. Digits == 1 1. Digits :== 15
Error, invalid assignment to Digits 15
2. solve:=3 2. type(solve, protected)
Error, attempting to assign to "solve” true
which is protected
3.mt=35 3. typel int, protected)
Error, attempting to assign to “int’ true
which is protected
Obrdzek 4.4: Chyby v prifazovani hodnot do proménnych.
4.1.5 Déleni nulou

Kdyz se pfi tpravé zadaného vyrazu (piikazu) dostane Maple do situace, kdy ma délit nulou,
vypise zpravu Error, numeric exception: division by zero. Tato situace se miize prihodit

iu vyrazi (piikazi), u nichz to neoc¢ekavame (napf. u funkce In) — obrazek 4.5.

4.1.6

Pfi zépisu mocnin je mozné se setkat s nasledujicimi chybovymi zpravami (obrazek 4.6).

Nespravny zapis mocnin

4.1.7 Nespravné pouziti objektu

V systému Maple miizeme narazit také na chybovou zpravu Error, illegal use of an object
as a name. Ta se objevi vzdy, kdyz pouzijeme néjaky objekt, ktery neni jménem na misté,

kde systém jméno ocekava. Vyznam chyby bude nejlépe patrny z obrazku 4.7.
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T
tan| —
2
Error, (in tan) numeric exception: diwvisicon by zero
In(0)
Error, (in In) numeric exception: diviszion by zero
2
a —1
a=1:———
a—1
Error, numeric exception: division by zero

Obrazek 4.5: Vyhodnoceni vyrazu, v némz se déli nulou.

Chybné zadané pitkazy. Spravne.
Chybi zdklad mocniny.
1. ~2
Error, invalid power X 1. 372
2 9
Spatné uvedeny zaklad, ktery chceme umociiovat (je tam navic &arka).
2,32 2372
Error, invalid power - 9
Xz
V exponentu neni mozné pouZit <.
3.34( £2) 3.372
Error, invalid <= 9
Za pismenem b je mezera, chybi tak zdklad mocniny.
4.0 4
Error, invalid base b
B
Obrdzek 4.6: Nespravny zapis mocnin.
Chybné zadané piikazy. Spravné.
1.[a,b] = [5.6] 1. ab=56
Exrror, illegal i 2 name 5.6

2. seq(LI=1.5)

Error, illegal use of an cbject as 2 name
3. 1:=2 3. J=2
rror, illegal 1 object as 2 name

hl

Pismeno (velké) I je vyhrazeno pro imaginarni jednotku.
2. seq(,i=1.5)

1.2.3.4,5

()

Obrdzek 4.7: Nespravné pouziti objektu.
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4.1.8 Nespravné definice a pouziti funkci

Riznych chyb se mtizeme dopustit i pfi definici a pouziti funkce (obrazek 4.8).

Chybné zadané piikazy. Spravneé.
— 2 2
1. fi=x—x 1. fi=x—x
Error, invalid op 2
X—X
2. f(x) =—x 2. f(x) =+
Error, invalid 2
X—X
3. f=3—x 3. fr=x—3
Error, invalid x—3
4. f=x—@ _ 4 fi= i
Error, invalid arrow D'_’.'_J_E:_E’:_'_c_ik;re 2
5.g(x.y)
Error, invalid fur:c:i-:-‘r:____&_x_:_r_gu:nents 5. g(xy)
&(x%:2) g(x.y)

Obrdzek 4.8: Nespravné definice a pouziti funkci.

4.1.9 Chyby pri vykreslovani

Nésleduji chyby vyskytujici se pfi vykreslovani. Jako u kazdého prikazu musime dbat na
spravné uvedené argumenty i u prikazi pro vykreslovani funkei a vyrazi. Chyby uvedené na
obrazku 4.9 jsou zptisobeny predevsim nespravné uvedenym rozsahem proménné x.

4.1.10 Dalsi chyby

Na zavér chybovych zprav si ukazeme jesté t¥i chyby, s nimiz se Casto setkavame, obr. 4.10.

149



Chybné zadané piikazy.

1. plot(x,x=2..)
Error, (in plot) cannot

Spravne.

1. plot(x,x=2.5)
split rhs

for multiple assignment

2. plot(x,x=2.5)

2. plot(x,x=2.5)

Error, (in plot) unexpected option:

x =2.5

3. plot(x,x=2 .a) 3. plot(x,x=2.5)
Error, (in plot) expecting a real

constant as range endpoint but

received a

4. f(x) =x:plot( f,x=2.3)

Error, (in plot) expected a range
but received x = 2 5

3
4
3
2
2 3 4 3
X
3
4
3
2
2 3 4 5
x
3
4
3
2
2 3 4 5

Obrdzek 4.9: Chyby pii vykres

lovani.

Chybné zadané piikazy.

1. coffecr(xz —5x+2xy
Error, (in collect)

2)

cannot collect

£

2.f=2x
g(x) = unapply( f.x)

g(2)
Error, (in unapply)

x— unapply( f. x)

2x

variables must be unigque

and of type name

1.1

3” dx dy

00
Error, (in int) integration range or wvariable
must be provide

Spravneé.

1. coffecr(xz —5x+2-xy, x)
“+ (-5+2y)x

2. fi=2x

i

g = unapply( f,x
X

L=
e
-

2

g(2)

Obrazek 4.10: Dalsi chybové zpravy.
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4.2 Varovani (Warnings)

Kromé chybovych zprav vypisuje systém jesté tzv. varovani. Varovani miize signalizovat nasi
chybu (v zapisu piikazu), ale zpravidla informuje o diivodech, pro¢ nemiize systém zadany
ptikaz vyhodnotit (nékdy jej pfesto vyhodnoti). Pfi vypisu varovani s textem Warning,
solutions may have been lost je nutné preformulovat problém (zapsat ptikaz jinak, ne-
bot jej Maple nedokéze vyhodnotit). Ne vzdy je toto v8ak mozné, zpravidla mizeme jinou
formulaci problému dosahnout alespon ,,néjakych zlepseni®.

Varovani. Reseni.
2.x 5
1. V=J~J [:?] dydx 2x o2
= Y 1. assume{x>0]:V=J J [—] dydx
N v
x 1 y
Warning, unable to determine if Q0 is between ?

1/x and x; try to use assumptions or use the

AllSolutions option V==

9

V=-
4
b
2 1 1
2. dx 2. assume( a <1 <b): dx
 ¥a x—a

Warning, unable to determine if a is between 1 “In(1—a-) +In(b-—a-)

and b; try to use assumptions or use the
AllSolutions cption

b
1

XxX—a
!

dx

3. solve(sin(z) < 0)
3. solve(sin(x-y) <0) RealRange( Open( -1t). Open(0) )
Warning, solutions may have been lost

Obrdzek 4.11: Varovani.
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5 Navody k reseni prikladu

Priklad 1.2: Pro vlozeni zadaného vyrazu potiebujeme: sumacni symbol a symbol nekonecna.
Sumacni symbol nalezneme v paleté Expression, symbol nekonec¢na v palet¢ Common
Symbols. Zlomek miZzeme bud vzit také z palety Expression, nebo jej zapiSeme rucné
pomoci lomitka.

Priklad 1.3: Potfebujeme vlozit zlomek a mocninu (resp. exponent). Oboji najdeme v paleté
Expression. Mizeme také pouzit lomitko a ,strisku®.

Priklad 1.4: Opét vyuzijeme jiz diive zminénych palet. Pozor vsak na vkladani Eulerova
¢isla. To je nutné vzit z palety (resp. pouzit piikaz exp). Zapsané pismeno e z klavesnice
Maple bere jako ,,obycejné*“ pismeno (proménnou) e.

Priklad 1.6: K zadéani vyrazu potiebujeme ptikaz sqrt pro vloZeni odmocniny a ptikaz exp
pro vlozeni Eulerova ¢isla. Pfikaz mé jeden parametr, kterym je exponent Eulerova ¢isla (t;.
pro Eulerovo ¢islo samotné zadavame exp(1)). Vlozit Eulerovo ¢islo je mozné téz zapsanim
pismene e, vyvolanim funkce automatického dokoncovani a zvolenim polozky Exponential

e’.

Priklad 1.7: Nejrychlejsi zptisob je zadat do dokumentu ?sum, pfipadné zadat sum, umistit
kurzor na prikaz a stisknout klavesu F2.

Priklad 1.8: Je nékolik zpiisobt, jak to zjistit. Ziejmé nejrychlejsi je vyhledavat v napovédé
klicova slova matrix a vector, pripadné Linear Algebra.

Priklad 1.10: Pozor na rozdil mezi poctem platnych cifer a poc¢tem desetinnych mist.
Priklad 1.11: Kdyz zapisime néjaké cislo s desetinnou teckou, Maple jej automaticky bude
brat jako ¢islo v pohyblivé fadové carce a vypocty s nim bude zaokrouhlovat na pocet
platnych mist specifikovany proménnou Digits.

Priklad 1.13: Pouzijeme piikaz isolve.

Priklad 1.14: Pouzijeme piikaz isolve. Systém Maple vypise feseni s pouzitim konstant,
které jsou pfirozenymi ¢isly (bez nuly). Spravné vsak maji byt pouzity nezaporné celoéiselné
konstanty.

Piiklad 1.16: Resime jako soustavu nerovnic piikazem solve.

Priklad 1.17: Pouzijeme piikaz solve. Pro a = 0 bychom dostali linearni polynom.
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Ptiklad 1.18: Resime opét piikazem solve. Pozor, dana rovnice méa nekone¢né mnoho feeni.
Ptiklad 1.19: Resime jako soustavu rovnic piikazem solve.

Priklad 2.3: Pouzijeme zavedeni predpokladu: assuming.

Priklad 2.4: Pouzijeme prikaz simplify.

Priklad 2.5: Pouzijeme piikaz simplify.

Priklad 2.6: Pouzijeme piikaz factor.

Priklad 2.7: Pouzijeme piikaz simplify.

Priklad 2.8: Vyuzijeme piikazi simplify, factor a convert.

Priklad 2.12: Pro vSechna z € R plati: sin(x) € [—1,1].

Pitklad 2.13: Plati: f(z) = m—-5 a f(—2) = 55 Z toho méme: f(z) # f(—=),
f(z) # —f(—x) a tedy funkce neni suda, ani lichd. D(f) = R\ {2,3}, H(f) =R\ (—4,0].
Obor hodnot uré¢ime z toho, ze polynom x? —5-x + 6 nabyvé vsech kladnych hodnot (a proto
musi i funkce f(z)). Zminény polynom nabyva téz zapornych hodnot, a to na intervalu (2, 3),
pricemz tu nejmensi presné uprostied intervalu, tj. v bodé z = g Funkce f(z) v tomto bodé
naopak nabyva své nejvyssi hodnoty na intervalu (2, 3), a to hodnoty —4.

Z predeslého plyne, ze funkce neni ohranicena.

Piklad 2.14:
(a) f(z) =9 —a% f(—2) =9 — 22 = f(z) = sud4 funkee,
(b) f(z) = vz, f(—2) = v/—% = ani sudé, ani lich4,

() f(z) =1L, f(—z) = = = —f(x) = lich4 funkce.

)

Priklad 2.15:

(a) f(z) =2z, kde z € (0,1), r—92 .. <0
(b) f(z) = -L (f) flz) =42 . 0<z <1,
o z+1 ... z>1
(c) flz)=3+1,
(d) f(z) = e, (g) f(x) = arctan(z),
_Jrt2 o w2 JIn(=z) .. 2<0
(©) fle) = {x -2 ox>2 () flz) = {ln(x) o x>0

Piiklad 2.16: f(z) =23 —k -2+ 22, f(—x) = —(23+ k - 2?4+ 2 x). Z toho dostavame:
k=—-k=0.
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Priklad 2.17:

(a) Pro a # 0 se jedna o bijekci.
(b) Ano, je to bijekce.

(
d

)
)
c) Nejedna se o bijekci, funkce neni prosta.
) Ano, je to bijekce.

)

(e) Ano, je to bijekce.

Priklad 2.19:

Priklad 2.20: Kazda funkce osové symetrickd vzhledem k primce y = x je sama sobé inverzi.
To znamena, ze jich je dokonce nekone¢né mnoho.

Piiklad 2.22: g~*(z) = % - In(z). Legendu mtZzeme do grafu piidat nastavenim parametru
legend piikazu plot nebo kliknutim na graf a vybérem z kontextové nabidky.

Priklad 2.23: Pouzijeme piikaz animate. Funkce h(x) je klesajici pro a < 0, rostouci pro
a > 0 a konstantni pro a = 0.

Priklad 2.25: Vychéazime z definice 2.8, pouze se nyni priblizujeme k bodu z( zprava, t;j.
uvazujeme interval (xg, g + ).

Priklad 2.26: Vyjdeme z definic 2.9 a 2.10. Uvazujeme bod oo (resp. —oo) a chceme popsat
stav, kdy pro libovolné ,vysokou“ (resp. ,nizkou“) hodnotu M existuje hranice, nad niz
(resp. pod niz) pro vSechna z plati, ze funkéni hodnota f(x) je vétsi (resp. mensi) nez ona
ptvodné (libovolné) zvolena hodnota M.

Priklad 2.27: Maple zvladne urcit vSechny limity. Postupujeme tedy klasicky vyuzitim sym-
bolu pro pocitani limit z palety, kontextové nabidky nebo ptikazu limit.

Priklad 2.28:
(a) Zavedeme substituci y = 3.
(b) Vyuzijeme vzorce cos(z) = cos(£)? — sin(%)>.

(c) Rozsifime vyrazem vx? + 5 + 3.
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(d)
(e)

(f)

1

xT

a uvédomime si, Ze pro r — —oo je x = —V 2.

Rozsitime vyrazem
Zadany zlomek rozlozime na soucet dvou zlomki a zavedeme substituci v = —z. Dal-
$imi drobnymi Gpravami umime rozhodnout, kam se ktery vyraz (zlomek) limitné blizi

pro u — o0.

VyuZijeme vzorce sin(2 - t) = 2 - sin(¢) - cos(t) a platnosti liH(l) Smmﬁ =1

Priklad 2.29:

(a)

(b)

Staci dat priklad takika jakékoli ,rozumné“ funkce definované na néjakém neprazdném
intervalu — viz definice 2.7.

Vychézime z 2.10. Je tfeba dat pfiklad funkce f(z), jejiz hodnoty se blizi néjakému
koneénému ¢islu pro  — oo (resp. x — —o0). Mohla by néco takového spliiovat néjaka
polynomiélni, mocninnd, exponencialni, ¢i goniometricka funkce?

Taktka ,opacny“ pfipad k predeslému. Hledame funkci f(x), kterd pro néjaké ko-
necné velké = ,roste nade vSechny meze“ (resp. ,klesd pod vSechny meze“). Mohla
by néco takového splnovat néjaka polynomialni, mocninna, exponencialni, ¢i goniome-
tricka funkce?

Nyni chceme najit funkci f(x), jejiz hodnoty se blizi co (resp. —o0) pro & — oo (resp.
x — —o00). Opét je na misté stejna otdzka: spliiuje toto néjaka polynomidlni, mocninna,
exponencialni, ¢i goniometricka funkce?

Musime spojit vSechny pfedeslé body. Na bod (a) mizeme zapomenout. Pokud splnime
vsechny ostatni, bude splnéna i tato podminka. Jedno mozné teseni je najit funkci
spliiujici (b) a (d) — takovou funkci jste jiz mozna dokonce nasli — a zkombinovat ji (tj.
napf. vynasobit) s funkei spliiujici bod (c).

Priklad 2.31:

(a)

(b)
(c)

Musime se obejit bez systému Maple, jelikoz ptikaz discont neumi hledat nespojitosti
u funkci definovanych po ¢astech. Podezielé body z nepojitosti jsou body 1 a 2. Musime
ovérit, zda v nich existuje limita a zda je rovna prislusné funkcni hodnoteé.

V tomto pripadé prikaz discont pracuje bezchybné.

Opét se musime obejit bez systému Maple. Postupujeme analogicky k feseni prikladu
2.30.

Priklad 2.32: Postupujeme analogicky k feseni prikladu 2.30. Hledani cisel ¢ a d vede na
soustavu dvou rovnic.

Piiklad 2.33: Jsou dvé hlavni moznosti, jak postupovat. Bud vzit zndmou funkci, které neni
spojita, ale vime, Ze mé limitu v kazdém bodé (na daném intervalu), nebo vzit funkeci spojitou
(ta mé limitu v kazdém bodé) a nespojitost ,vytvorit“, aniz bychom porusili existenci limity.

Priklad 2.34: Systém Maple zvladne urcit vsechny derivace. Ke spravné odpovédi je nutné
porozumét vypisu systému v piipadé (b). Symbol D tu znaci diferencialni operétor.
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Priklad 2.35: Je tfeba najit spojitou funkei f(x), pro niz by v néjakém bodé z, neexistovala
limita z definice 2.14: lim &=/ ¥ tomu, aby tato limita neexistovala, staci, aby se

T—0 T—x0
nerovnaly limity zleva a zprava, tedy aby platilo: lim %ﬁgcgo) #  lim

T—T0~ z—zot
musi vypadat funkce splnujici predchozi nerovnost?

Kdyz najdeme pravé popsanou funkci, je jiz jednoduché napt. definovanim po ¢astech
vytvorit funkei, kterd bude mit na daném intervalu libovolny pocet (a tedy i napf. rovny
dvéma) bodt, v nichz bude funkce spojita, ale nebude v nich mit derivaci.

f(ﬂﬁ)—f(wo). Jak
0

Tr—x

Priklad 2.36: Z poznamky 2.4 vime, ze smérnice tecny je rovna derivaci funkce v ptislusném
bodé. V rovnici tecny tak zbyva urcit pouze konstantni ¢len, jehoz hodnotu zjistime z toho,
7e teCna ma s funkci jeden spoleény bod.

Priklad 2.37: Jelikoz ma byt te¢na rovnobézné s néjakou primkou, musi mit stejnou smérnici.
Tedy pokud y = k-z-+¢ je rovnici tecny k funkci f(x) v bod€ x¢, pak musi platit k = f'(z¢) =
12 (nebot 12 je smérnice rovnobé&zné primky). Jelikoz f'(xq) = 3 - 29?, dostavame dva riizné
body x( a tedy dvé tecny.

Piiklad 2.38: Resime obdobné jako piedchozi piiklad. Smérnice zadané piimky je rovna —%.
My potiebujeme nyni smérnici kolmice. K tomu vyuzijeme linearni algebry, odkud vime, zZe
dva vektory jsou na sebe kolmé, jestlize je jejich skalarni soucin roven 0. Mame-li primky
y==k-xay=1I[-x, pak tyto jsou na sebe kolmé, jestlize 1 + k-l = 0. Z toho dostavame, ze
smérnice hledané kolmice je rovna 3, coz je tedy smérnice tecny. Tedy pokud y = k-x +q je
rovnici te¢ny k funkci f(z) v bodé xy, pak musi platit k = f’(x) = 3. Jelikoz f'(xq) = 3-z¢?,
dostavame opét dva rizné body xq a tedy dvé tecny.

Piklad 2.40: f(x) = /T, 70 = 49, h = 2.
Piiklad 2.41: f(x) = ¢z, 29 = 125, h = —2.
Piiklad 2.42: f(z) = 2%, 20 = 3, h = —0.05.

Priklad 2.43: Pouzijeme piikaz taylor pro bod z = 0 a ziskany vysledek pfevedeme na
polynom ptikazem convert.

Priklad 2.44: Pouzijeme ptikaz taylor pro bod x = 1. Proménnou Order nastavime na
hodnotu 5 a ziskany vysledek prevedeme na polynom piikazem convert.

Priklad 2.45: Pouzijeme piikaz taylor pro bod z = 2.

Priklad 2.47: Postupujeme analogicky k prikladu 2.46.

(a) Uvazujeme funkci e”, kterou rozvineme do Taylorova polynomu v bodé zo = 0, a hle-

dame aproximaci v bodé x = —1. Stejnym postupem jako v ptikladu 2.46 dospé&jeme
k tomu, Ze je pro pozadovanou presnost potieba nastavit proménnou Order na hodnotu
7.

(b) Uvazujeme funkci /z, kterou rozvineme do Taylorova polynomu v bodé zy, = 243,
a hleddme aproximaci v bodé z = 250. Nyni musime k odhadu velikosti Taylorova
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zbytku pouzit poznamku 2.7, nebot xy # 0. Tvar zbytku je pak nejjednodussi vyhod-
nocovat postupné pro n = 1,2, ..., nebot Maple neumi vyfesit pfisluSnou nerovnici.
Dostatecné n v tomto pripadé: n = 2.

Priklad 2.50:

(a)

(b)

Funkce f ma tfi stacionarni body, z nichz jediny je lokalni extrém, dalsi dva jsou body
inflexni. Funkce neméa zadnou asymptotu.

Funkce f méa dva stacionarni body, oba jsou lokalnimi extrémy. Funkce ma dale tii
inflexni body. Funkce neni definovana ve dvou bodech, v nichZz ma asymptoty bez
smérnice. Asymptoty se smérnici neexistuji. Aby Maple tento ptiklad spravné vytesil,
je potfeba nacist balik RealDomain.

Funkce ma dva stacionarni body, z nichz jeden je lokalni extrém, druhy je inflexnim
bodem. Funkce neni definovana v jediném bodé¢, v némz ma asymptotu bez smérnice.
Funkce ma také asymptotu se smérnici.

Funkce mé nekone¢né mnoho stacionarnich boda (na zjisténi tohoto v Maple je tieba
pouzit atribut allsolutions), vSechny jsou vSak inflexnimi body. Funkce mé i dalsi
inflexni body (vzdy uprostfed intervalu tvoreného stacionarnimi body). Funkce nem4
asymptotu bez smérnice ani asymptotu se smérnici. Opét pozor na vypocet systému
Maple — pti pocitani limit v nékterych pripadech vypisuje interval jako hodnotu limity
(limita vSak neexistuje).

Zasadni otazka v tomto prikladu je, zda je funkce f(x) spojita v bodé 0. Funkce mé tii
stacionarni body a vSechny jsou jejimi lokalnimi extrémy. Funkce méa dale dva inflexni
body a zadnou asymptotu (bez smérnice ¢i se smérnici).

Priklad 2.54:

Staci rozlozit na dva zlomky a urcit primo ze znalosti ,tabulkovych® integral.

Vyraz pod odmocninou je mozné upravit tak, aby se dala odmocnina odstranit (apli-
kovat). Poté uz se vysledek ur¢i podobné jako v pfedchozim piipadé.

Po roznasobeni je mozné integrovat kazdy clen zvIast.

Rozklad na parcialni zlomky.

Opét rozklad na parcialni zlomky. V tomto pripadé je vsak vyrazné pracnéjsi nez
predchozi, nebot jeden ze ziskanych parcidlnich zlomk je t¥eba dale upravit (rozlozit),
abychom integraci ziskali prirozeny logaritmus. Tim se nam vSak objevi dalsi zlomek,

u néjz je tieba rozpoznat, ze pfipomina derivaci funkce arkus tangens (arctan), jen je
potteba zlomek opét upravit do vhodného tvaru.

Zavedeme substitucit =5 -z + 6.
Zavedeme substituci ¢t = In(x).

Zavedeme substituci t = % + 1.
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(i) Resime metodou per partes, pii¢emz funkce, kterou budeme chtit derivovat bude

funkce 2. Maple pii pouziti pifkazu Parts vyuzije znalosti [ cos®(z) dz = cos(x)
1+cos(2-x)

sin(z) + 3 - x, k demuz dospéjeme uzitim vztahu cos?(z) = R Integral ziskany
metodou per partes je tieba rozlozit a na jeden z nich pouzit substitu¢ni metodu.
(j) Resfme metodou per partes. Funkci, kterou budeme derivovat, je funkce In(z).

(k) Resime opét metodou per partes. Funkci arctan(z) si zapiseme jako arctan(z)-1 a pravé
samotna funkce arctan(x) bude ta, kterou budeme derivovat.

(1) Resime nejprve substitu¢ni metodou polozenim ¢ = z2. Naslednd pouZijeme metodu
per partes, pricemz funkce, kterou budeme derivovat, bude funkce z.

Piiklad 2.55: Ve vsech pfipadech vyuzivame Newton-Leibnizovy formule.
(a) Resime metodou per partes.
(b) Zavedeme substituci z = 2.

c) Zavedeme substituci cos(z) = t.

eSime metodou per partes.

)
)
(c)
(d) Zavedeme substituci e* = t.
e) R
)

(
(f) Zavedeme nejprve substituci t = e* a naslednd u? =t — 1.

Priklad 2.58:

(a) Resime naprosto analogicky s pifkladem 2.56. Vysledek je: S = %ﬁ.

(b) Obsah zadané plochy je tfeba pocitat ,na dvakrat“. Nejprve se spoc¢itd obsah plochy
mezi kiivkami y = —x a y = 1 na intervalu [—1,0], nédsledné obsah plochy mezi
kiivkami y = 23 a y = 1 na intervalu [—1,0]. Vysledek je: S = 2

(c) Staci si uvédomit, mezi kterymi ¢dstmi kfivek lezi zadand plocha. Vysledek je: S = 3.

(d) Resime rovnou podle poznamky 2.21. Vysledek je: S = ln(2)

(e) Resime opét rozdélenim na dva urcité integraly. Vysledek je: S = 4 - In(2) — 2.
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pl = pi’oz( [4— xE: xz]: x=-2..2, color="NavyBlue", zhickne.s.s=2) :
f:= plottools| transform | ( (xy)— [1: v+ x:z]) :

2
p2 = pi’oz(-'l —2-x,x=-J2 ../2, filled= true, color= C'yan) :
plots[display] ([ pl.f(p2)])

Obrdazek 5.1: Zobrazeni plochy z ptikladu 2.58.(a).

pl = pi’oz(x{ x=-2..2, color = "NavyBlue", zhickne.s.s=2) :
p2 = plot( -x, x=-2 ..2, color="NavyBlue", thickness=2) :
p3 = plot(1,x=-2 .2, color="NavyBlue", thickness=2) :
f:= plottools| transform | ( (xy)— [x: y—x]) :
p4 = plot(1 + x,x=-1 .0, filled= true, color= cyan) :
g = plottools| transform | ( (x.y)— [1: v+ x:s]) :
pI = pi’oz(l - x3: x=0..1, filled= true, color= C'yan) :
plots[display] ([ pl. p2. p3.f(p4).g(p3)])

8 -

Obrazek 5.2: Zobrazeni plochy z pfikladu 2.58.(b).
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pl = pi’oz(x{ x=-2..2, color="NavyBlue", zhickne.s.s=2) :

p2 = plots| implicitplot| (}'2 =x,x=-2.2,y=-2..2, color="NavyBlue",
thickness=2 ) :

f:= plottools| transform | ( (x.y)— [1: y+ x:z]) :

p3 ;:pjg;(\f? — xE: x=0.1, filled= true, color= cyaﬂ) :
plots[ display](pl, p2.f(p3))

4 -

Obrdzek 5.3: Zobrazeni plochy z prikladu 2.58.(c).

pl = plot([tan(x),0],x=-2.2,y=-2..2, discont= true, color = "NavyBlue",
thickness=2) :

“J

p2 = plots| implicitplot| [x= % x=-2.2,y=-2.2, color="NavyBlue',

thickness =2 ] :

p3 = ploz[tan(x]: x=0 ..gﬁﬁ'ed= true, color= C'yan] :

plots[display] (pl, p2. p3)
2 -

Obrazek 5.4: Zobrazeni plochy z pfikladu 2.58.(d).
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pl —pfoz([e e :"] x=-2.2, coi’or="l\'av_x_=Blue":zhickne.s.s=2):
/= plottools| n‘an.sform]( y)— [1:: y+ e_x]) :

g = plottools| transform | ( (xy)— [ xny+ ex]) :

p2 = pi’oz(E - e_x:x=—ln(2] .0, filled= true, color= man) :

p3 :=pi’oz(2 —¢.x=0 An(2), filled= true, color= C}an) :
plots[display](pl.f(p2). g(p3))

b
=1
[

Obrdzek 5.5: Zobrazeni plochy z prikladu 2.58.(e).
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Priklad 2.59:

(a) Pomoci derivace musime uréit rovnici teény. Déle uz fesime analogicky k predchozim
prikladiim. Vysledek je: S = 2873.

pl = pj’oz( [x2 —2x+2,4x—17, O]: x=-2 .4, color="NavyBlue", thickness
=2) :

p2 = plots| implicitplot] (x=0,x=-2 .4, y=-15 .10, color = "NavyBlue",
thickness=2) :

p3 ::pi’oz[x2 —2-x+2,x=0 ..%:ﬁi'fed= true, coi’or=cyan] :
f:= plottools| transform | ( (x.y)— [x:y +4-x— 7]) :
pd ::pi’oz[x2 —6:x+9.x= % .3, filled= true, coi’or=cyan] :

plots[ display] (pl.p2, p3.f(p4))
10 5

b
=]
b
L
I

-10

Obrdzek 5.6: Zobrazeni plochy z pfikladu 2.59.(a).

(b) Opét musime uréit rovnici tecny a také jeji prisecik s funkci y = 3. Vysledek je:
S =2

4

(c) Nyni je tfeba urc¢it rovnice dvou tecen a jejich prusecik. Vysledek je: S = %.
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pl = pi’oz[ [xs: 3-x— 2]: x=—% .2, color ="NavyBlue", zhickne.s.s=2] :

f:= plottools| transform | ( (x.y)— [x:y +3-x— 2]) :

y
p2 ::pgm(x3 —3-x+2,x=-2.1, filled=true, color= C}'a?’i) :
plots[display] (pl.f(p2))

Obrdazek 5.7: Zobrazeni plochy z piikladu 2.59.(b).

pl :=pi’oz( [x2 —6-x+8-4x+7,2x— 8]: x=0..5, color = "NavyBlue",
zhickne.s.s=2) :

f:= plottools| transform | ( (xy)— [x: y—4-x+ 7]) :

g = plottools| transform | ( (x.v) =[xy +2:x—8]) :

pZ =:Pfox[x2 —2xt 1:.‘{:1 -

b3 |t

Lfilled=true, color=cyan | :

p3 = pi’oz[x2 —8-x+16,x= % .4, filled= true, color= cyan] :

plors[ display] (p1.f (p2), g(p3))

-10 4

Obrdzek 5.8: Zobrazeni plochy z prikladu 2.59.(c).
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Priklad 2.60: Ve vSech pripadech vyuzijeme poznamky 2.22:
(a) Vysledek je: S = %ﬁ

pl = pi’oz( [ 3 32: 3or— 33: t=-J3 ..\.*{?]: scaling= constrained, color
= "NavyBlue", zhickne.s.s=2) :

p2 = pi’oz( [ 3 32: 3or— 33: t=-J3 ..\.*{?]: scaling= constrained, filled= true,
color= C'yan) :

plots| display](pl.p2)

Obrdzek 5.9: Zobrazeni plochy z pfikladu 2.60.(a).

(b) Vysledek je: S =12 - .

pl =plot([2- (t—sin(1)),2-(1 —cos( t)),t=0.2-x]. scaling
= constrained, color = "NavyBlue', thickness=2) :

p2 =plot([2- (t—sin(1)),2-(1 —cos( t)),t=0.2-x]. scaling
= constrained, filled= true, color=cyan) :

plots| display](pl.p2)

Obrdzek 5.10: Zobrazeni plochy z ptikladu 2.60.(b).

(c) Vysledek je: S = 2L

Priklad 2.61: Je tfeba odvodit rovnici kruznice. Mame dvé moznosti — bud popsat ,horni“ po-
lovinu kruZnice vztahem y = v/r? — 22 a ,spodni“ polovinu kruznice vztahem y = —/r? — 22,
nebo kruznici popsat parametricky predpisem x = r - sin(t),y = r - cos(t),t € [0,2 - 7]. Na-
sledné vyuzijeme odpovidajiciho urcitého integralu. Pii pouziti prvniho postupu je v Maple
nutné pridat pii vypoctu integralu predpoklad, Ze r je nezédporné (redlné) ¢islo, abychom
dospéli k pozadovanému vysledku.
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pl = pi’oz( [ 3 -sins(z]: 3 -coss( t).t=0 ..J'c]: scaling= constrained, color
="NavyBlue", thickness = 2) :

p2 = pi’oz( [ 3 -sins(z]: 3 -coss( t).t=0 ..J'c]: scaling= constrained, filled
= true, color= cyan) :

plots| display](pl.p2)

Obrdzek 5.11: Zobrazeni plochy z ptikladu 2.60.(c).

Priklad 2.64: Ve vSech pripadech vyuzijeme poznamky 2.23.
2613 _ 16
(a) 1= — %

-1 2'62+64+1~(62—1)

i = 2.35

(b) 1 ="

(c) Systém Maple vyjadii FeSeni za pomoci eliptického integrélu. Informace k tomu vy-
sledku mizeme nalézt v napovéde. Prlkazem evalf ziskdme pfiblizné numerické feseni.

1 =2-V2- EllipticE(42) =2-/2- fV dr = 3.82

(d) 1 =2-v/2- EllipticE( 22 =2.2- f\/l 2 x = 3.82

Priklad 2.65: Ve vSech pripadech vyuzijeme poznamky 2.24.
(a) 1=2-V3
(b) =272
() l=2-7-vV1+16 72— % -In(—4-7+V1+16 72)

Piiklad 2.66: Re§ime analogicky jako v piikladu 2.61, jen misto obsahu kruhu poéitame
obvod kruznice.

Priklad 2.69: Ve vSech pripadech vyuzijeme poznamky 2.25:
(a) Vysledek: V =

)
(b) Vysledek: V ==,
(c) Vysledek: V = &%,
(d) Vysledek: V = &%,
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pl = plot [xz,x=—% % color ="NavyBlue", thickness=2

p2 = plots| implicitplot | (y?' =x,x=-2.2,y=-2.2, color
="NavyBlue", thickness=2 ) :

f:= plottools| transform | ( (xy)— [x,y + xz] ) :

p3 = plot([x — 2, x=0..1, filled= true, color=cyan) :
plots| display] (pl. p2.f (p3))

2

(x|

coords = cylindrical, labels= ["x", "y", "z" ] :
plots| display] ( p, orientation=[ -91, 0, 120])

] . lp= plot.?d( [ x{ﬁ], 6=0.2-m. x=0.1, axes=frame,

e
<N
o

1 5
0.5 p :::‘::
V emssstuniiitiiit

04 06 08 1

X z

Obrazek 5.12: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z ptikladu 2.69.(a).

pl = plot([sin(x).0],x=0 ., color="NavyBlue", thickness=2) : |p = plot3d(sin(x),0=0.2-w x=0 .7, axes= frame,

p2 = plot(sin(x),x=0 ., filled= true, color= cyan) :

plots[ display](pl.p2)
1 -

024

06

044

0z

coords= cylindrical, labels=["x","y", "z"] ) :
plots| display | ( p, orientation= [ =91, 0, 120])

Obrdazek 5.13: Zobrazeni zadané plochy a ziskaného rotac¢niho télesa z ptikladu 2.69.(b).
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pl = pfor[

thickness=2 ] :

X, L: 2]: x=0.3,y=0.5, color="NavyBlue
x

ot

p2 ::ploz[E - %: x= % .1, filled= true, color=cyan] :

= plottools| transform | ( (x,¥) =[x,y +x]) :
p3 =plot(2 — x,x=1..2, filled=true, color=cyan) :

f:= plottools[ transform [ (x.y)—

plots[display] (pl.f(p2). g(p3))
5 -

o |pi=plot3d([ x,2].6=0.2-x, x= 1.2, axes= frame, coords

2]_. 6=0.2-mx= % .1, axes = frame,

= ¢ylindrical, labels= ["x"

1
q -—pfoﬁd[[ -
coords = eylindrical | :

plots| display ([ p. q |, orientation=[ -91,0,120])

N
\\\\\\\\\\\\\\\\\\\
\\\\\\\\\\\\\\\\\\\\

; i

"Hl'HHIHmmu’faﬁfm

I
‘L‘l

Obrdzek 5.14: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z pfikladu 2.69.(c).

pl :=pfoz( [1." 4-o 4= e .2 — x]:x=—2 .3, color

="NavyBlue", thickness=2 ) :

/= plottools| transform | ( (x,¥) =[x,y +2 —x]) :

p2 = pi’m(mII - -2+ x,x=0.2, filled= true, color= C'yan) :

plots[ display] (pl.f(p2))
4_

P ==p3033d([ 2-x4 4- x:2 ] 0=0.2-m.x=0.2, axes

= boxed, coords = eylindrical, labels= [ "x", "y", "z" ) :
plots| display ] ( p., orientation= [ -91, 0, 130])

_ III "Il
_ m"’{,’

Obrdzek 5.15: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z pfikladu 2.69.(d).
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Priklad 2.70: Ve vSech pripadech vyuzijeme poznamky 2.26:

3.
T

(a) Vysledek: V =

3
pl = p!or[ 32: t— IT: t=0 ﬁ] color="NavyBlue", xhickness=2] :

p2 :=pfor[ rg, t— ;—3, t=0 ..ﬁ],ﬁﬁed= true, color= cyan} :
plots| display] (pl, p2?)
0.6+
05
0.4
03

0.2

0.1

1] T
il 1

3

t
3 ]-cos(s}: [

3

t 1— L
3

p= pfor.?d[[ xz_. [

2., t=0../3, axes=frame, labels=["x","y", "z"] J :

]-sin(s] ,s=0

plots| display]( p, orientation= [ 90, 0, 150])

-02 02 06

z

Obrazek 5.16: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z pfikladu 2.70.(a).

z . __ 288w
pl ::pfor[ 3-sin3(z), 3 -coss( t). z=f% %l color="NavyBlue",
thickness =2, scaling= con.nrained] :
p2 ::pfor[ {3'Sin3(t]: 3-cosa[ t), r=f; ..%]_.ﬁffed= true, color= cyan] :
plots[ display](pl. p2)
! 2 E

plots| display | ( p, ortentation= [ 90, 0, 150])

p :=pfor3d[ [3'Sin3{t], 3-cos3{r) -cos(s), 3-cos3(z) -sin(s) ], s

n "
= 2. = —  — = f =
0.2 Tﬂ.‘t 5 T axes ame, labels

z

Obrdzek 5.17: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z pfikladu 2.70.(b).

(c) Vysledek: V =3 7.
(d) Vysledek: V =4 - 72
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pl = pfat( [sing(z}: 1-cos(t),t=0.. J'c]: color="NavyBlue",
thickness =2, scaling= consn‘amed) :

f:= plottools| transform | ( (xy)— [x v+ l—m]) :

p2 = plot(2-J1 —x ,x=0..1, filled= true, color=cyan) :

plots[display](pl.f(p2))
,-

0.5

D_
002040608 1

p :Zp!oﬁd( [sing(z}: (1— cos(t))-cos(s), (1 — cos(t))
-sin(s) ]: s=0.2'm t=0.m, axes= frame, labels
=["x","y","z" ) :

plots| display] ( p, orientation=[ 90, 0, 150])

0 02 04 06 08
X z

1 -10 1 2

Obrdzek 5.18: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z prikladu 2.70.(c).

pl ==plot([2 +sin(z),2 + cos(),1=0..2- &]. color="NavyBlue",
thickness =2, scaling= constramed, view= [0.4,0.4]) :

f:=pi’onooi’s[n‘am:ﬁ)rm]( (x_.y}—>[x_.y+2 -V 1= (x—2}2 ]) :
p2 ::pi'oz(Z-\.l' 1— (x—2}2 ,x=1.3, filled= true, cofor=c;van) :

plots[ display] (pl.f(p2))
4_

pi=plot3d([2 + sin(t), (2 + cos(t) ) -cos(s). (2 + cos(t))
-sin(s) [,s=0.2-m t=0.2- W axes=frame, labels
=["x","y","z"], scaling = constrained) :

plots| display | ( p, orientation=[ 90, 0, 150])

"

X z

Obrazek 5.19: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z prikladu 2.70.(d).

Priklad 2.71: Koule vznikne napftiklad rotaci ,horni“ poloviny kruhu kolem osy z. Je tedy

potfeba odvodit rovnici kruznice o poloméru r
do vztahu pro vypocet objemu.

a jeji ,horni“ polovinu pouzit pro dosazeni

Priklad 2.72: Vélec o poloméru podstavy r a vySce védlce v vznikne rotaci (kolem osy x)
obdélnika tvoreného stranou o délce v na ose x, kolmicemi v krajnich bodech o délkach r
a zbylou stranou o délce v (spojujici kolmice ,na druhé strané“).

Priklad 2.73: Kuzel vznikne rotaci trojuhelnika kolem osy z. Trojihelnik je tvoren tiseckou
na ose x odpovidajici vysce kuzele a kolmici na jednom konci tisecky o délce rovné polo-
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méru kuzele. Linearni funkce pak spoji ,zbyvajici konce“ tsecky a kolmice (pfi vhodném
,rozmisténi mize byt linedrni funkei funkce y = = - x).

Priklad 2.76: Ve vsech pripadech vyuzijeme poznamky 2.28. Obsah plasté zpravidla pocitame
rozdélenim na ¢asti plasté ziskané rotacemi jednotlivych funkci na odpovidajicich intervalech.

=L.7-(134-v5-3-In(vV5+2) —16) =9.14 .

)

(b) S=2-7-(V2+In(1+v2)) = 14.42.
)
)

Ptiklad 2.78: Resime zcela analogicky k piikladu 2.71.

Ptiklad 2.79: Resime analogicky k piikladu 2.72. Pozor na to, Ze v zadani se pozaduje povrch
celého valce, tj. musime urcit povrch plasté i podstavy valce.

Priklad 2.81: Postupujeme stejnym zptisobem jako v pfikladu 2.80. Tentokrat je funkce
1

—

nespojita v bodé 0, a musime tak urcit lim+ J - In(z) du.
t

Priklad 2.83:

(a) Integral diverguje: lim (2-/x) = oc.
T——00 T—00

(b) [ 15z dr = lim arctan(z) 4 lim arctan(z).

(c) Maple ve vyledku zobrazi Fresneltuv integréal definovany jako

x
1
FresnelS (z) = /sin (5 i t2) dt,
0
nebof neumi zapsat feSeni analyticky pomoci standardnich funkci. Piikazem evalf
zjistime, ze pfislusny integral konverguje.

(d) Integral diverguje: lim In(z) = oc.
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Priklad 3.4: Nakreslené oblasti jsou zobrazeny na obrazcich 5.20 — 5.24

plots| impliciplot] (xy < 1,x=-7 ..7,y=-7 .7, coloring = [ cyan, white],
filled = true, thickness =2, gridrefine=13)
&
4 L
F
-6 —I4 I ] : dll &
X
_4H
-6

Obrdzek 5.20: Zobrazeni zadané oblasti z piikladu 3.4.(a).

plots[ inequal | ( {0 < x,x <y, y < 1},x=-1.2,y=-1 .2, optionsfeasible
= ( color = cyan), optionsexcluded= ( color=white), labels=["x","y"])
2 _

Obrdazek 5.21: Zobrazeni zadané oblasti z piikladu 3.4.(b).
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plots| implicilpfof]( (x — 2]2 +_]-JZ

2

= [ evan, white|., filled = true. thickness= 2. gridrefine=3 )

=1.x=0.4,y=-2 .2, coloring

Obrazek 5.22: Zobrazeni zadané oblasti z ptikladu 3.4.(c).

pl = plots| implicitplot| ( [x?' +y2 <1 ], x=-4.4,y=-2.2, color
=black, thickness =2, gridrefine=13 ) :

p2 = plots| implicitplor| ( [x < +y2], x=-4.4,y=-2.2,
thickness = 2, color=black, gridrefine= 3) :

x v+

[ := plottaols| transform | [ (xy)—
2

p3 ::plof[m_m

,x=0.1, filled=1rue

color = eyan | :

1 1)
(3 )
p4 ::p]of[_ | 1 _x?- + | % — [x—%]z,x=0..1,ﬁlled=1m&

color = eyan | :

ps ==plot( [\/ 1—-2 v 1 — ],x =-1..0, filled = true, color

cyan

g = plottools| transform | [ (xy)—

plots| display](p1, p2, f(p3), g(p4). p3, view=[-2.2,-2..2])
2

Obrdazek 5.23: Zobrazeni zadané oblasti z piikladu 3.4.(d).
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pl = plots[ implicitplot| ([ 1 = |x| + [ ].x=-4 .4, y=-2 ..
color=black, thickness=2, gridrefine=3) :

p2 = plots[ implicitplot| ([ |x| + [y <2].x=-4 .4, y=-2..
thickness =2, color=black, gridrefine=3) :

B

B

f1 == plottools| transform | ( (x¥) —>[x, y+x+ 1]) :
f2 == plottools| transform | ( (x, y) =[x y+x—1]):
3 = plotrools| transform | ( (x ¥) —>[x, y—x— 1]) :
4 := plottools| transform | ( (%, ¥) =[xy —x+1]):
p3 ==plot(1,x=-1..0, filled = true, color = cyan) :
p4 = plot(-1.x=0..1, filled = true, color = cyan) :
p3 =plot(-1.x=-1..0, filled = true, color = cyan) :
p6 = plot(1,x=20..1, filled = true, color = cyan) :

=-2

p7 = plots[ implicitplot ] ( |x| + |y <2,x=-2.-1,y=-2.2,

gridrefine =2, filled= true, coloring = [ evan, white]) :
p8 = plots| implicitplot| ( |x| + |y <2,x=1.2,y=-2..
):

gridrefine =2, filled= true, coloring = [ cyan, white|

B

plots|display](pl, p2. f1(p3).f2(p4).f3(p3).f4(p6). p7. p8,
view=[-3.3,-3.3])
3 -

-3 4

Obrdzek 5.24: Zobrazeni zadané oblasti z prikladu 3.4.(e).

Priklad 3.6: Prislusné defini¢ni obory jsou zobrazeny na obréazcich 5.25 — 5.30

(a) Vyraz pod odmocninou musi byt nezaporny.

filled= true, thickness= 2, gridrefine= 13,
2 _

plots| implicitplot | (1 - x2 - 4. }'2 =0,x=-2.2,v

=-2 .2, coloring = [ cyan, white],

view=[-2.2,-2.2])

=2

-2 -

Obrdzek 5.25: Zobrazeni defini¢niho oboru funkce z piikladu 3.6.(a).
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(b) Vyraz pod odmocninou musi byt nezédporny.

plots| implicitplot] (sin( +3%) = 0,x=-3 .3, y=-3 ..3, coloring = [ cyan, white|, filled
= true, thickness= 2, gridrefine=3)

Obrazek 5.26: Zobrazeni defini¢niho oboru funkce z pifikladu 3.6.(b).

(¢) Argument funkce In musi byt kladny.

plots| implicitplot] (x +y = 0,x =-2 .2, y=-2..2, coloring = [ ¢yan, white], filled
= true, thickness=2)

Obrdazek 5.27: Zobrazeni defini¢niho oboru funkce z prikladu 3.6.(c).

(d) Argument funkce arccos musi nabyvat hodnot z intervalu [—1, 1]. Systém Maple ma
s vykreslenim pfislusné mnoziny ,problémy“. Pfi vyssi hodnoté parametru gridrefine
je vysledek akceptovatelny.
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plots| implicitplot H%‘ < 1,x=-2.2,y=-2..2, coloring = | cyan, white], filled
x+y

= true, thickness =2, gridrefine=8 ]

Obrdazek 5.28: Zobrazeni definiéniho oboru funkce z pfikladu 3.6.(d).

(e) Vyrazy pod odmocninami musi byt nezaporné. Diky jejich tvaru je pro né mozné vy-
tvofit jedinou nerovnost a zbyvajici ¢ast podminky ,,schovat® do rozsahu proménnych,
abychom mohli pouzit prikaz implicitplot.

plots| implicitplot | ( (1 - xz) . (1 —}'2) =0,x=-1.1,y=-1.1, coloring = [ cyan,
white], filled= true, thickness =2, gridrefine=3, view=[ -2 .2,-2.2] )
2 -

Obrdzek 5.29: Zobrazeni defini¢niho oboru funkce z prikladu 3.6.(e).
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(f) Argument funkce In musi byt kladny, tzn. z > 0Ay — z > 0.

pl = plots[ implicitplot] (v —x > 0,x=0..7, y=-4 .5, coloring = [ cyan, white], filled
= true, thickness =2, gridrefine=3,view=[ -2 .2,-2 .2]) :

p2 = plots| implicitplot| (x=0,x=-2 .2,y=0 .2, style= point, color = black,
symbolsize= 4, numpoints = 400) :

plots[ display](pl. p2)

Obrdzek 5.30: Zobrazeni defini¢niho oboru funkce z piikladu 3.6.(f).

Priklad 3.7:

(a) Pro nékteré hodnoty parametru contours Maple nezobrazi vrstevnice y = —z ay = .

2 2 2 2
plots| contourplot) (xh -y .x=-5.5y=-5.5, pi’ox.ﬁ'd(x‘ -y .,x=-5.5,y=-5 .5, stvle= patchcontour, axes=ﬁame)

contours =15 )

Obrdzek 5.31: Zobrazeni vrstevnic funkce z prikladu 3.7.(a).

(b) Pro rovnomérné rozlozeni vrstevnic na zadané oblasti je vhodné specifikovat parametr
contours seznamem funkénich hodnot.
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=-3 .3,y=-3 .3, style= patchcontour, axes = frame,

1

plots| contourplot | 5 ¥="5.5,y=-5.5, pfozi’d[ T X
x t+y x t+y

grid=[100, 100], view=[ -4 .4,-4 .4]. numpoints = 5000, view=[ -1..1,-1..1,-1 ..30], contours = 15]

contours =[0.1,0.2,0.3,1,1.5, 3.4, 5, 10]]
30 f

20
B

10 —

Obrdzek 5.32: Zobrazeni vrstevnic funkce z ptikladu 3.7.(b).

plots [ contourplot L x=-5.5, y=-5.5, grid pl = plot3d X x=-5 .5, y=-5 ..-0.01, style = patchcontour, axes
v y
=1200.2 " =[-05-1.-2.-3.- i
0 q["O[,]; 5005]] iis:firf_,)[ jO._.; 1,)] }‘" 3,73, = frame, numpoints = 5000, view= [ -5 ..5,-5 ..5,-5 5]] :
=p10:3d[ X x=-5 .5,y=0.01..5, style= patchcontour, axes

p2:

= frame, numpoints = 5000, view= [ -5 ..5,-5 ..5,-5 5]] :

\\\ \ 27
NN \ plots[ display] (p1., p2)

Obrdazek 5.33: Zobrazeni vrstevnic funkce z piikladu 3.7.(c).

()
Zadana funkce je nespojita pro y = 0, s ¢imz si Maple ,neumi poradit“ a vykresluje
v tomto misté svislou plochu. Ptikaz plot3d nemaé k dispozici parametr discont, coz se
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obchazi vytvorenim dvou grafi tak, abychom se nespojitosti ,,vyhnuli“ — vykreslime
funkci nalevo od mista nespojitosti a napravo, grafy pak spojime v jeden piikazem
display.

(d)

plots[ contourplot] (x-y,x=-5 .5, y=-5 ..5) plor3d(x-y,x=-5 .5, y=-5 .5, style= patchecontour, axes = frame)

¥
A2

f ‘_-" rd
bad | /

Obrdzek 5.34: Zobrazeni vrstevnic funkce z ptikladu 3.7.(d).

Priklad 3.10: Polozime 6 = min{e, 1}. Nasledné musime ukazat, ze pro libovolna z, y spliiujici
2| <4, |yl <, [z, y] # [0,0] plati:
2?2
x? 4+ y?
JelikoZ x,y spliuje [z,y] # [0,0], je asponi jedno z nich nenulové. Bez Gjmy na obecnosti
predpokladejme, Ze napiiklad y # 0. Pak pro jinak libovolnd x,y plati: 22 < 22 + 2. Z toho
mame:

< e

2 2

r-y 2
— < Y.
r2 4 y? Y
Pro e > 1 mame |z| < 1, |y| <1 a tedy
2,2
x.
2—y2<y2<1<8.
ety
Pro e <1 méme |z| < ¢, |y| < € a tedy
2. .2
x-
2—y2<y2<52§5.
ety

Priklad 3.11:

(a) Maple uréi spravné, ze limita neexistuje. Sami to mizeme ovéfit napiiklad piiblizo-
vanim se po primkach y = k - x. Vysledek je zavisly na k, tj. na pfimce, po niz se
k limitnimu bodu blizime.

(b) Maple limitu neumi spo¢itat. Limita v tomto pfipadé opét neexistuje, coz muzeme
stejné jako v pfedchozim piipadé ovérit priblizovanim se k limitnimu bodu po primkach.
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(c) Maple limitu nespoc¢ita. Limita neexistuje, coz miiZzeme zjistit pomoci transformace do
polarnich soutadnic. Ziskany vysledek zavisi na thlu ¢.

(d) Maple limitu nespo¢ita ani v tomto pfipadé, i kdyz stac¢i pouze dosadit.

(e) Maple limitu nespocita. Limita existuje a je rovna 0. Ovéfit to miZzeme transformaci
do polarnich soutadnic a aplikaci poznamky 3.4.

(f) Maple limitu nespocitad. Proménna y tu pfitom neni zdrojem nespojitosti, a tak za ni
muzeme dosadit a pocitat zadanou limitu pouze jako limitu v proménné z.

(g) Maple limitu nespo¢ita ani tentokrat. Limita existuje a je rovné % Vysledek ziskame
po rozsiteni zadaného vyrazu doplnénim citatele na rozdil ¢tvercid, nasledné tprave
a dosazeni.

Priklad 3.13: V pfipadech a) — d) jsou body nespojitosti tvoreny vzdy body, které nejsou
v definiénim oboru funkce f(x,y). Ve vSech bodech defini¢niho oboru jsou funkce totiz spo-
jité.

(a) Jmenovatel rovny nule, takze jedinym bodem nespojitosti funkce f(x,y) je bod [0, 0].
(b) Jmenovatel rovny nule, tj. body [z,y] takové, Ze x = 0 nebo y = 0.

)

)
(c) Jmenovatel rovny nule, tj. body [z, y| takové, ze y = 0.
(d) Argument funkce In(z) nekladny, tj. body [z, y] takové, ze 22 + y? = 1.
)

(e) Funkce f(x,y) nema body nespojitosti. Jediny ,podeziely“ bod z nespojitosti je bod
[0,0], v némz je vSak limita rovna funkéni hodnoté (viz piiklad 3.9).

Priklad 3.14:
(a) Podle prikladu 3.11.(g): C' = 3.

(b) Podle ptikladu 3.11.(c) limita v bodé [0, 0] neexistuje, tj. neni mozné ,dodefinovat* C
tak, aby zadané funkce byla v bodé [0, 0] spojita.

Priklad 3.15:

(a) f:/v('rvy :23}]/4—%,

~— —
|
(V]

(b) ;(ﬂf,y)=8-(xj-y+y)3-w-y,

oy =4- (2 y+y)° - (@ +1),

" (r,y) =56-28 yt + 1202yt + T2 2%yt + 8-yt

w(@,y) =32 2" 4P +96- 2% 4> +96 - 27 - P +32- 2 -y,

Z’/’w(a:,y):32-x7-y3+96;1x5-y3+96~x3-y3+32-x-y3,
_ 2 (2
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v y) =2ty (y — 1),
w(r,y) =a2v"1 - (y - In(z) + 1),
we(r,y) =2v"1 - (y - In(z) + 1),
3///3;(1:7y) =a¥- ID(ZE)Q,

(d) filz,y) =y-In(z+y)+ f;y,
flwy) =2 -In(z +y) + 75,

o T+2%

{r::r ($, y) - (:L“+y)% ) ey

xy(x7y) (‘T + y) + z+y + m - (x+y)2’
— 2-z+

() = o 222

Priklad 3.16:
1+1-V5
(a) f1(1,2) = 2, f3(1,2) = 2 205,

(b) file,e) =22 fi(e,e) = —12,
(c) f1(1,2) =0, f(1,2) = §

Piiklad 3.18:
(a) fu(A) =42,
(b) Pfikaz DirectionalDerivative neumi pracovat s obecnymi sméry. Je proto potfeba
vypocitat feeni jinak. fl,(A) = 1 - (cos(a) + sin(a)).
Piiklad 3.20:
(a) f(x,y) =aY, [zo,v0] = [3,1], [z, y] = [3.05,0.99],

(b) Nejprve prevedeme stupné na radidny. f(x,y) = /z - cos(y), [0, 40 = [3, 3], [z, y] =
[3.05, %5571,

(c) f(z,y) = arctan($), [zo, yo] = [1,1], [z, y] = [1.02,0.95],

(d) f(z,y) =logy(z - y?). [z0,y0] = [4,1], [z, y] = [4.01,0.97].

Priklad 3.22:

(a) t(z,y) =4 -2—-2-y—5,

(b) t(z,y) =5 -z +y—3,

(c) t(z,y) =3 -2+ 2 -y+In() -2,
(d) t(z,y) = L.
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Priklad 3.23: Ve vsech prikladech pouzijeme piikaz mtaylor.

(a)
(b

)
(c)
)

musime specifikovat bod [z = 1,y = 1],
musime specifikovat bod [z = 0,y = 7],
musime zménit proménnou Order nebo pridat tfeti parametr prikazu mtaylor,

musime specifikovat vsechny tii proménné.

Priklad 3.24:

(a)
(b)

(c)
(d)

f(x,y) =V x3 + y37 [x07y0] = [172]7 [«L?J] = [1027 1‘97]7

Nejprve pievedeme stupné na radiany. f(z,y) = /x - cos(y), [zo,y0] = [3, 5], [z,y] =
(3.0, 5],

[z, y) = arctan($), [zo, yo] = [1, 1], [z, y] = [1.02, 0.95],

f(x,y) =log,(z - y?), [zo, yo] = [4,1], [z, y] = [4.01,0.97].

Piiklad 3.25: Definice lokalniho minima je naprosto stejna s definici 3.9, jen nyni pozadujeme,
aby pro vSechna X z né&jakého okoli bodu X* platilo: f(X) > f(X*).

Priklad 3.30:

(a)
(b)

(c)

Funkce ma 2 stacionarni body, z nichz jeden (bod [1,1]) je lokdlnim minimem.

Funkce mé 4 stacionarni body. Dva z nich jsou lokalnimi extrémy. Bod [0, —1] je lokal-
nim minimem, bod [0, 1] je lokdlnim maximem.

Funkce m4 8 stacionarnich bodi. Ctyf¥i z nich jsou lokalni extrémy. Body [—%, —%]
a [zﬂee, 2@:] jsou lokalni minima, body [—\éi:, \éi:] a [%7 —%¢] jsou lokdlni maxima

zadané funkce.

Funkce ma nekone¢né mnoho stacionarnich bodi, které jsou téz jejimi lokalnimi ex-
trémy. V bodé [0, 0] se nachazi lokdlni minimum. Ostatni stacionarni body, které jsou
vsechny lokalnimi maximy, lezi na kruZnici 22 +y? = 1. Klasickym zptisobem neumime
o téchto bodech rozhodnout. Pro ovéfeni, Ze se jedna o lokdlni maxima, mizeme zavést
substituci t = 22 + y? a vysetiit lokalni extrémy funkce, jako by se jednalo o funkci
jedné proménné.

Funkce mé jediny stacionarni bod ([2,4]), ktery je jejim lokdlnim minimem. Pro y =0
neexistuje parcialni derivace podle proménné y. Podle toho, jak chapeme pojem okoli
bodu (funkce neni definovana pro y < 0), bychom méli vySetfit jesté body, pro néz
y = 0. Nicméné pro y = 0 funkce lokalniho extrému nenabyva, o ¢emz je potieba se

presvédcit vySetfenim okoli ,potencidlniho® lokalniho minima v bodé [‘5", 0].

Funkce ma jeden stacionarni bod, ktery neni jejim lokalnim extrémem. Pro z = —1
nebo y = —1 neexistuji parcidlni derivace zadané funkce. Opét je na uvazeni, jak chapat
pojem okoli bodu a pripadné vysetfit i lokalni chovani funkce v ptipadech x = —1 nebo
y = —1. Jiz z grafu je vidét, ze funkce tu dosahuje lokalné své nejvyssi hodnoty v bodé
[—1, —1], takze je mozné mluvit o lokdlnim maximu funkce v tomto bodé.
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(g) Funkce méa nekone¢né mnoho stacionarnich bodi, Zadny z nich v8ak neni jejim lokalnim
extrémem. Funkce ma déle dva body, v nichZ neexistuji parcialni derivace. Bod [0, 0]
neni lokalnim extrémem funkce, bod [2, 3] je lokdlnim minimem.

Priklad 3.31: Definice absolutniho minima je naprosto stejna s definici 3.11, jen nyni poza-
dujeme, aby pro vSechna X z mnoziny M platilo: f(X) > f(X*).

Priklad 3.35: Urcete absolutni extrémy funkce f(z,y) na mnoziné M:

(a) V tomto pfipadé ani neni potieba nic pocitat. Jen si pozorné precist zadani a zamyslet
se nad nim. Nejvétsi hodnota (absolutni maximum) zadané funkce je ddna ,pfimo“
mnozinou M a jsou to tedy vSechny body na jeji hranici. Absolutni minimum ziskame
tak, kdyz si uvédomime, Ze druhd mocnina redlného ¢isla je vzdy éislo nezédporné (t;j.
vétsi nebo rovno nule).

(b) Opét neni t¥eba nic pocitat, staci pouzit ,selsky rozum“. Mnozinu M muZeme piepsat
do intervalia: x € [—1,1],y € [—1,1] a odtud uz je na prvni pohled vidét, Ze absolutni
minimum se nachazi v bodé [—1, —1] a absolutni maximum v bodé¢ [1, 1].

(c) Absolutni minimum funkce uréime jiz ze zadani, nebot absolutni hodnota nabyva své
nejmensi hodnoty pro nulovy argument a ten je uvniti mnoziny M. Absolutni ma-
ximum mizeme hledat klasickou cestou. Zadana funkce nemé stacionarni body, ma
ovSem nekone¢éné mnoho bodi, kde neni diferencovatelna. Z grafu funkce (piipadné
rovnou ze zadéani) zjistime, Ze absolutni maximum lezi na hranici mnoziny M. Napfi-

klad piikazem extrema miizeme extrém najit, a to hned ve ¢tyfech bodech: [ﬁ @],

202
[?a _\/Ti]a [_\/757 g] a [_\/757 _\/75]

(d) Postupujeme ,klasickym“ zpisobem. Uréime lokalni extrémy (lok. max. v bodé [1,1])
a nasledné extrémy na hranici mnoziny M. Celkem dostaneme, ze absolutni maximum
je v bodé [1,1], absolutni minima jsou dvé, a to v bodech [0, 4] a [4, 0].

(e) Zadany trojuhelnik M je mozné vykreslit nasledujici posloupnosti ptikazu:
pl := plots[pointplot] ([[0, 2], [3, 0], [0, -1]], color = red, symbolsize
= 20, symbol = solidcircle):
p2 := plots[polygonplot] ([[0, 2], [3, 0], [0, -1]], style=line, color=red,
thickness = 2):
plots[display] (pl, p2)

Zakladnim krokem je zapis jednotlivych tsecek trojuhelniku v proménnych x a y. Pak
pokracujeme ,klasickym* zptisobem. Uréime lokéalni extrémy (lok. min. v bodé [%, 1))
a nasledné extrémy na hranici mnoziny M. Celkem dostaneme, ze absolutni maximum
je v bodg [0, —1], absolutni minimum v bodé [1, 1].

(f) Postupujeme opét ,klasickym* zptisobem. Nejprve hleddme lokalni extrémy. Dosté-
vame ,t¥i“ stacionarni body, pfricemz jeden z nich pokryva vSechny body takové, ze
y = 0. Tento stacionarni bod (body) vSak neni extrémem jiz na prvni pohled, protoze
funk¢ni hodnota je pro néj rovna nule. Zbylé dva stacionarni body [, ], [-%, —3] jsou
lokalni minimum a maximum zadané funkce. Nyni je potfeba si uvédomit, ze funkce
sinus je periodicka s periodou 27, takze téchto lokalnich extrémt je vlastné nekonecné
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mnoho a vSechny jsou soucasné i extrémy globalnimi na celém defini¢nim oboru. V za-
dani byla specifikovana mnozina M, a tak je potifeba omezit mnozinu téchto extrémi
tak, aby vyhovovala zadani, tj. absolutni maxima jsou body [§ +2-k-7, 5 —2-1- 7]
pro k,l € Ny, absolutni minima jsou body [5?“ +2-k-m,—%—2-1-7| pro k,l € Ny.

Ptiklad 3.37: Re$ime naprosto stejnym postupem jako v piikladu 3.36. Hledan4 kladné ¢isla
jsow: x =y =z =4.

Priklad 3.38: Opét postupujeme stejné jako v prikladu 3.36. Minimalizujeme funkci f(z,y) =
r+y+ % pro x > 0,y > 0. Nejmensi mozny soucet takovych ¢isel je 20 pro z = 5,y =
5,z = 10.

Priklad 3.39: Vzdalenost bodu o soutadnicich [z, vy, z] od po¢atku souradného systému je:
/1% 4+ y? + z2. Tento soucet musime minimalizovat pro z = z -y — 1. Pfepisem analogickym

k predchozim piikladiim dostavame tilohu minimalizovat funkci f(z,y) = /22 + y2 + (v -y — 1)2
na celém jejim definiénim oboru. K tomu mtzeme vyuzit piikaz minimize. Nejblize poc¢atku

je bod [0,0, —1].

Priklad 3.40: Hleddme rovnici piimky y = k- © + ¢, tj. redlnd Cisla k a ¢, pro néz plati, ze
S=(q—2*+(k+q—3)>*+(2-k +q—>5)? je minimalni. MiZzeme opét vyuzit ptikazu
minimize a dostavame: k = %, q= %.

Priklad 3.42: U kazdého pripadu vykreslime mnozinu €2 a z obrazku urc¢ime meze dvojna-
sobného integralu.

(a)

plots[ mequal | ({0 < x, 0 <y x+y<1},x=0.1,y=0.1, optionsfeasible
= (eolor=cyan), optionsexcluded= ( color=1white), labels= ["x","y"])
1_

0.2
0.6
¥

0.4

0.2

Obrdzek 5.35: Zobrazeni mnoziny Q) z ptikladu 3.42.(a).

Miizeme volit nasledujici:

1. 0<2<1,0<y <7,
2.0<y<1,0<z<y.
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Celkem tak ziskavame:

T

1= [[ 1wy dy—/lfﬂx,y) dy d =

/

Y

/ f(z,y) de dy.
0

sealing= cansn'amed) :

plots| display] (pl.p2)
1_

0.5 1

02040608
x

-0.54

I._E([_a’_za’_zlz : _
pl = plot J1—x .,/ 1—x |.x=0.1, thickness

2, color= black,

f 2 { 2
p2 ::pfaz( J1—x -/ 1—x |.x=0.1, filled = true, color = cyan) :

Obrdzek 5.36: Zobrazeni mnoziny 2 z prikladu 3.42.(b).

MiiZzeme volit nasledujici:
1.0<z<],—V1—-22<y<+V1-—22

Celkem tak ziskiavame:

)

V1i—x

I:é f(x,y)d:cdyzo/ f(z,y) dy dz.

1—x2

(c)

MiiZzeme volit nasledujici:

1. 3<z<0,— -3 <y<z+3,
0<r<3dzr—3<y<-—z+3.

Celkem tak ziskavame:

z+3

I—/ fa:ydxdy—//f(xy dy dx +

-3 —x—3
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plots| implicitplot] (x| + M < 3,x=-4 .4, y=-4 .4, view=[ -4 .4,-4
.4], coloring = [ eyan, white], filled= true, thickness=1, gridrefine=6)

Obrdzek 5.37: Zobrazeni mnoziny ) z ptikladu 3.42.(c).

pl = plots| pomtplot|([[2,1], [ -2.1]. [0, 0]], color
= red, symbolsize= 20, symbol = solidcirele) :

p2 = pfaz[ 1, %] x=0..2, thickness=2, color= bfack) :

p3 = pfoz[ 1,—%], x=-2..0, thickness =2, color= bfack] :
p4 == plot [1 + % x =-2..0, filled = true, color = q‘an] :
pJ3 == plot [1 - % x=0..2, filled = true, color = cyan] :

f1 = plottools| transform | [ (xv)—|x y—% ] :

2 := plottools| transform | [ (xy)—=|xy+ % ]

plots| display|(pl, p2.p3.f1(p4)./2(p3) )

4

0.8

0.6 1

0.4

0.2 1

Obrdzek 5.38: Zobrazeni mnoziny 2 z prikladu 3.42.(d).
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(d)

Mizeme volit nasledujici:

Celkem tak ziskdavame:

I:/Q/f(af,y)dx dy:[_ém’y) dy dv + o/;/f(x,y) dy dz.

Priklad 3.43: Podobné jako v predchozim ptikladu si nejprve zobrazime mmozinu ohrani¢enou
integracnimi mezemi a nasledné mnozinu vyjadiime v obraceném poradi mezi.

(a)

pl = plots| implicitplot] ( {x=0},x=0.4,y=0 .2, color
= black, thickness=2) :
p2 = pfoz[ 2, %] x=10 .4, thickness =2, color= bfac}'c] :
p3 = pfaz[f! - % x=0.4, filled= true, color= cyan] :
1= plottools| transform | [ (% ¥v) = |xy+ ;]] :
plots[ display|(pl. p2.f(p3))
2
1.5
Foo1
0.5
D T T T 1
0 1 2 3 4

Obrdzek 5.39: Zobrazeni mnozZiny ohranic¢ené integra¢nimi mezemi z pfikladu 3.43.(a).

Pfepis mnoziny v obraceném poradi proménnych:

0<y<20<z<2-y

Celkem tak ziskavame:
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pl = plots| implicitplot] ( {x=2},x=0.3,y=2 .4, color
= black, thickness= 2, scaling = constrained) :
p2 == plot([x,2-x],x=0.2, thickness= 2, color=black) :
p3 = plot( x,x=0.2, filled= true, color= cyan) :
[ := plottools| transform | ( (x, ¥) =[x y +x]):
plots| display](pl.p2.f(p3))
a-

o051 15 2

Obrazek 5.40: Zobrazeni mnoziny ohranicené integracnimi mezemi z piikladu 3.43.(b).

Ptepis mnoziny v obraceném poradi proménnych:

(Sl
IAINA
<
VANIVAN
8 8
IAINA

IAIN
\'r-lk [\
NI NI

Celkem tak ziskavame:
2 2.z 2y 4 2
//f(-’my) dy dw://f(af,y) dr dy + //f(af,y) dz dy.
0 z 0y 2 Y

Ptepis mnoziny v obraceném poradi proménnych:

0<y<4,y<z<2

Celkem tak ziskavame:

22

j/f(x,y) dy da:=/4

f(z,y) dz dy.

é\m
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pl = plots| implicitplot] ( {x=2},x=0.3,y=0 .4, color
=black, thickness= 2, scaling = constrained) :

p2 = pfaz( [O: xg]: x=0..2, thickness =2, color = bfack) :

p3 = pfoz{x{ x=0.2, filled= true, color= cyan) :

plots| display](pl, p2. p3)
4_

Obrdzek 5.41: Zobrazeni mnoziny ohranicené integra¢nimi mezemi z prikladu 3.43.(c).

pl = pfaz{ [xz, x3 ]: x=0..1, thickness = 2, color= black,
scaling= conm'amed) :
p2 = pfoz(xg - x3, x=0 .1, filled=true, color= cyan) :
1= plottools| transform | { (x v) —}[x, ¥ +x3]) :
plots[display](pl.f(p2))
1_
0E&q
06

0.4+

0.2

Obrazek 5.42: Zobrazeni mnoziny ohranicené integra¢nimi mezemi z prikladu 3.43.(d).

Pfepis mnoziny v obraceném poradi proménnych:

0<y<l,y<z< ¥y
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Celkem tak ziskavame:

1 z2 1 Yy
O/ / F(a,y) dy dv = / Z f(.y) do dy.

Piiklad 3.45: Regeni je velice jednoduché. U piikladu 3.42 staci dosadit f(z,y) = 1 do
integralt, které jsme ziskali feSenim piikladu. U pfikladu 3.43 staci dosadit f(z,y) = 1 jak
do zadani, tak do reseni ptikladu.

Priklad 3.46: Vyjdeme z rovnice kruznice o poloméru 7: z?+4y* = r2. Jestlize postupujeme od
proménné x, meze prvniho integrélu jsou zfejmé: = € [—1, 1]. Nésledné potiebujeme vyjadiit
meze proménné y, coZ provedeme pravée z rovnice kruznice: y € [—v/r2 — 22,y/r2 — x2]. Podle
vztahu v poznamce 3.20 jiz jednoduse pomoci systému Maple urc¢ime pozadovany obsah
kruhu.

Priklad 3.47: Postupujeme analogicky predchozimu prikladu. Tentokrat vyjdeme z rovnice
2
elipsy: i—z + % = 1. Proménnd x nyni nabyva hodnot z intervalu [—a, a], pro meze proménné

y plati: y € [—b-\/l—z—;,b'\/ —Z—;}

Priklad 3.49: Ve vSech piipadech je vhodné pro ziskani predstavy vykreslit alespon naznak
tvaru ziskaného télesa. Dale je vhodné si zobrazit podstavu télesa, z niz odvodime integracni
meze. Dvojny integral ndm néasledné spocita systém Maple, jen v piipadé (c) neziskame
pfesnou (symbolickou) hodnotu a musime pouzit piikaz evalf.

plot3d( 6 —2-x—3-y,x=0.3,y=0.2,view=[0.3,0.2,0.6], 22 s _ _ _
axes = frame, filled= true) plot 3 x +2.x=0.3.filled= [ color = cyan), color= black
2_
1.54
1_
0.5+
1] T T \
0 1 2 3
2 .,
3 —? X &
V=J,J, 6 —2-x—3 pdvdx
00
=6

Obrdzek 5.43: Reseni pifkladu 3.49.(a).
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pl = pi’az.?d{ X +2-x=-1.1,y=0.2,view=|
-1.1,0.2.0 ..5],a‘ces=ﬁame) :

p2 = pfoz.s[.spacecuwe]( [x: X, 5 + 2-x]: x=0.1,
color = black, axes= frame, thickness = 4) :

p3 = pi’m.s[.spacecuwe]( [x,— X, 7 —2-x], x=-1.0,
color = black, axes= frame, thickness = 4) :

pd = pi’az.s[.spacecuwe]{ [ x,2— xg: 4— xz]: x=-1
..1, color = black, axes = frame, thickness = 4) :
plots[display](pl.p2,p3.p4)

pl ::ph)r( [2 - xg: |x] ]_. x=-1.1,y=0.2, color= bfack) :

p2 :prm(E —x +x, x=-1..0, filled= true, color= cyan) :
p3 :=pfor(2 —¥- x,x=0..1, filled= true, color= cyan) :

f1 == plottools| transform | ((x. y) =[x,y —x]) :

12 == plottools| transform | ((x. ) =[x,y +x]) :

plots[ display] (p1.f1(p2).f2(p3))

05 1
x
02— 12—
V=j j (f-l—?.-,') d}'clx-l-jj‘ (f-l—?.-y) dydx
-17-x 0 x
11
=7

Obrdzek 5.44: Reseni prikladu 3.49.(b).

2,2
Xty

pl :=pfox3d(e x=-2.2,y=-2.2,view=[ -2
.2,-2.2,0 ..100]_.axe.s=ﬁame) :

p2 = plots| spacecurve ( [2-(:05(:): 2-sin(t), 54]: t=0
.2-m, color = black, axes = frame, thickness = 4) :

p3 = plots| implicitplot3d] (x2 -I—y2 =4,x=-2.2,y=-1
.2,z=0 ..54: axe.s=ﬁame) :

plots[display](pl. p2. p3)

p2 = plor([
f:= plottools| transform ]( (x,y
plots| display](pl. p2)

2

pl = plots| implicitplot ( [x + y =4]: x=-2.2.y=-2.2, color= bi’ac}’c) :

4-7 4 : ] =-2..2. filled= true, color= C'yan) :

—
—
=4
=
|
- .
E
(3=}
—
e

2 Ja-2
¥ j j o dydx
_2 7
*\."1473("
2 )
=[ [—Ierf(l\.-"azl—xz)e}l \;"Jt)dx
Y2
evalf (%)

F=168.3835544

Obrdzek 5.45: Reseni prikladu 3.49.(c).
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.1,0..24], ares—ﬁame):

p3
= frame, thickness=4) :

p4 = plots| spacecurve) [

x=0..

plots[ display] (pl.p2. p3. p4)

pl :=pi'r9:3’d(5-x2 +2-xy,x=

p2 = plots| spacecurve) ( [x 0,5-x ] x=0..
axes = frame, thickness= 4) :
:= plots[ spacecurve] ([0, v.0].y=0 .1, color= black, axes

\“\\“\“\\“‘I‘I‘I‘I\“\‘I
LAAVIELEERREERERANEANAY

0.2,y=0.1,view=[0.2,0

2, color= black,

pi’oz[l - % x=0.2,filled= [ color=cyan],

color= black, scaling= con.szrained]

3| =

_ X 2 _ X 0g
x, 1 7:5-)( +2-x-[1 7]]
< < 06
2, color= black, axes = frame, thickness=4 04
0z
0+ . : . .
0 0.5 1 15 2

2 y= (557 +2-x-y) dydx
A 00
11
V=—
3
Obrdzek 5.46: Reseni piikladu 3.49.(d).
vy’ 1 1 1= plot[ | 1 1.2,y=2 lor= black
pl = plot3d [—J x=l.2,y=- .2 w,ew—[l 2, .2,0 P plot P L A T
¥ 2 2
..lél:cnces:ﬁ'ameJ : p2 = plots| implicitplot] [ [x=2].x=1.2,y= % .2, cofor=biacfc] :
1
. 3 :=plot| x — —,x=1.2, filled= true, color= cy.
p2 = p?uzs[spacecun'e][ X, L_.Q]_.le ..2, color = black, axes P ple {x x -fille e, cotor=cyan
x

= frame, thickness=4

2

(2]
J

p3 == plots| spacecurve) [

axes = frame, thickness =4

p4 == plots| spacecurve]( [x,x. 1],x=1 ..

= frame, thickness=4) :
p3 = plots| implicitplot3d) ( [y=x],x=

plots[display] (pl. p2. p3. p4. p3)

f == plottools| transform | [ (xy)—

plots[display] (pl. p2.f(p3))
5

l,y= % .2, color= black,

2, color= black, axes

1.. v:L..E.z:D..l]:
ST

et

0.54,

assume(x > 0)

Obrdzek 5.47: Reseni ptikladu 3.49.(e).

191




Priklad 3.50: Kvadr je treba vhodné umistit do souradné soustavy — naptiklad tak, ze spodni
roh podstavy dame do bodu [0, 0, 0], zbylé rohy podstavy budou v bodech [a, 0, 0], [0, b, 0]
a [a,b,0]. Vyska kvadru bude rovna c. Z toho vyplyva, Ze funkce ohranicujici kvadr je
konstantni funkce f(z,y) = ¢ a podstavu kvidru muzeme piepsat do mezi néasledovné:
z € [0,a],y €[0,D].

Ptiklad 3.51: Je potieba znat rovnici koule: 2% 4 3% + 2% = r2. Koule vyjadiend touto rovnici
maé stfed v pocatku souradné soustavy. Jeji objem urc¢ime tak, ze spoc¢itdme objem jeji horni
poloviny (ktera lezi nad rovinou z = 0) a ten vynésobime dvéma. P43t horni poloviny

koule je popsan funkci f(z,y) = /r? —x? —y?, podstava je tvofena kruhem popsanym
nerovnici 2 + y? < r?. Integra¢ni meze tak miZeme zapsat nasledovné: x € [—r, 7|,y €

[—V/r2 — 22 /12 — 22|

Priklad 3.52: Opét je potfeba vhodné umistit valec do soufadného systému. Mizeme na-
priklad podstavu valce umistit do roviny z = 0 tak, ze jeji stfed je v pocatku souradné
soustavy. Podstava je pak popsana nerovnici 22 + 9> < r? a je mozné ji prepsat do inte-
gracnich mezi néasledovné: x € [—r,7],y € [—vr? — 22,4/r? — 22]. Vélec je shora ohraniden
konstantni funkci f(z,y) =

Priklad 3.54: Postupujeme stejnym zptisobem jako v pfikladu 3.53.
Vysledky:

(a) S=3-V14,
( L+ -n(5)+32- V6425 arcsinh (2-v/5) = 5.58,

o>

(
(d

) S
) S
c¢) prislusny integral musime vyhodnotit numericky, S = 583.77,
) piislusny integral musime vyhodnotit numericky, S = 7.57,
)

(e) prislusny integral musime vyhodnotit numericky, S = 6.00.

Priklad 3.55: Kouli umistime opét stfedem do pocatku souradného systému. Povrch horni
poloviny koule je pak popsan funkci f(z,y) = /72 — 22 — y2. Integraéni meze muzeme za-
psat nasledovné: z € [—r, 7|,y € [=Vr?2 — 22, /1?2 — x2]. Ziskany vysledek je tfeba vynasobit
dvéma (nebot pocitdme povrch pouze horni poloviny koule).

Priklad 3.56: Povrch horni poloviny koule je popsan funkci f = /25— . Déle
je treba odvodit integracni meze. Rovina z = 2 protne kouh \ bodech kruznlce popsane
rovnici 22 + y? = 21 a rovina z = 4 protne kouli v bodech kruznice popsané rovnici z? +
y> = 9. Mnozina © je tedy prstencového tvaru vymezena kruznicemi o polomérech v/21
a 3. Diky symetrii celého télesa je mozné zabyvat se pouze prvnim oktantem a vysledek
vynasobit ¢tyfmi. Integracni meze (meze ¢asti mnoziny §2) bychom pak zapsali nasledovné:
r€[0,3],y€[vVI—a2 V21 —2% U z <€ [3,V21],y €[0,V21 — 2.

Pro ziskani symbolického vysledku je tfeba prevést integral do polarnich souradnic, napft.
prikazem ChangeOfVariables z baliku Student[MultivariateCalculus]. Maple to ne-
zvladne dokonale, a tak je potieba nasledné zapsat do polarnich soutfadnic jesté mnozinu
Q (pro ziskdni integracnich mezi). V polarnich soufadnicich je navic jednodussi mnozinu {2
zapsat, a tak ji pfepiSeme rovnou celou. Pro polomér r plati: 3 < r < /21, a pro thel 6:
0<0<2- 7.
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Flay) =25 -2 —)F

(x3) =25 =2 =

3 J21—x . .

il - il -
Student| MultivariateCalculus| [ ChangeOfVariables| [‘/1 + [Ef(r L)] + [af(x: 1)] J y dx,
s
[ cartesian, ,, pola.r}_: e]
_yv=i 21—

¥ do

Obrdzek 5.48: Reseni piikladu 3.56

Priklad 3.58: Miizeme vyuzit dvojnych integrali jiz ziskanych pii feseni ptikladu 3.48 a pouze
funkei f(z,y) ,prepsat do mezi pro proménnou z v tfetim integralu. Zrejmé plati:

(a) z € 0,27 +y7,

(b) z € (0,64 — x2].

Priklad 3.59: Postupujeme analogicky k feseni pfikladu 3.50. Kvadr vhodné umistime do
soufadné soustavy a jeho meze pak miizeme zapsat nasledovné: x € [0,a],y € [0,b],z € [0,].

Priklad 3.60: Koule je specialnim piipadem trojosého elipsoidu z ptikladu 3.57 pro a = b =
¢ = r. Mizeme tedy pouze pozménit tyto hodnoty v feseni v piikladu 3.57 a ziskame vztah
pro objem koule o poloméru r.

Priklad 3.61: Postupujeme analogicky k feseni prikladu 3.52. Véalec vhodné umistime do
soufadné soustavy a jeho meze pak mizeme zapsat nasledovneé:
z € [-rrly €[—Vr2—a22Vr2—2?,2 €[-v,v].

Piiklad 3.63: Zadan4 funkce piedstavuje plast horni poloviny koule o poloméru r» = 1. V pii-
kladu tak pocitame objem horni poloviny koule o zminéném poloméru a z predeslych prikladi
vime, ze by vysledek mél vyjit 2% Mizeme naptiklad zapsat dvojny integral v kartézskych
soufadnicich a pouzit piikaz ChangeOfVariables. Nové integracni meze odvodime velmi
snadno, nebot se jedna o kruh o poloméru r = 1. Dostavame tedy: r € [0,1],6 € [0,2 - 7.
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Priklad 3.64: Ve vSech piikladech (3.46, 3.51, 3.52, 3.60 a 3.61) jsme v tomto textu vyuzili
kartézskych soutadnic. Nyni tedy provedeme pfislusné vypocty v soufadnicich polarnich,
sférickych a cylindrickych.

V prikladu 3.46 pocitame obsah kruhu o poloméru r. V polarnich souradnicich mtizeme
kruh popsat nésledovné: z = p - cos(f),y = p - sin(d), kde p € [0,7],0 € [0,2 - w]. Podle
poznamky 3.24 tak pocitame integral

2w r
/ / p dp db.
0 0
Jak v ptikladu 3.46, tak i nyni bychom maéli obdrzet tabulkovy vzorec: S = - r2.
V prikladu 3.51 pocitame objem koule o poloméru r. Vyuzijeme polarnich souradnic,

v nichz popiSeme podstavu horni polokoule néasledovné: = = p - cos(6),y = p - sin(f), kde
p €10,7],6 €[0,2 - x]. Podle pozndmky 3.24 tak poc¢itame integral

2 7
2-//p-\/r2—p2-cos(9)—p2-sin(9) dp db.
00

Jak v ptikladu 3.51, tak i nyni bychom méli obdrzet tabulkovy vzorec: V = % s,

V prikladu 3.52 pocitame objem valce o poloméru podstavy r a vysce v. Vyuzijeme opét
polarnich soufadnic, v nichz popiSeme podstavu véalce: = = p - cos(f),y = p - sin(d), kde
p €10,7],6 €[0,2-x]. Podle poznamky 3.24 tak poc¢itame integral

[\

/p-vdpd@.
0

Jak v pifkladu 3.52, tak i nyni bychom méli obdrZet tabulkovy vzorec: V =7 -r? - v.

=]

V ptikladu 3.60 pocitdme objem koule o polomeéru r. Ve sférickych souradnicich mtizeme
kouli popsat nasledovné: © = p - cos(¢) - sin(f),y = p - sin(¢) - sin(d),z = p - cos(d), kde
p€[-rrl,¢p€]0,2 7,0 €[0,2-7]. Podle poznamky 3.25 tak pocitame integral

2.w2mw
///sin(@) - p* dp do db.
0 0 —r
Jak v ptikladu 3.60, tak i nyni bychom méli obdrzet tabulkovy vzorec: V = % e,
V prikladu 3.61 pocitdme objem valce o poloméru podstavy r a vysce v. V cylindrickych

soufadnicich mizeme vélec popsat nasledovné: x = p - cos(d),y = p - sin(h),z = z, kde
p€10,r],0 €[0,2- 7],z € [0,v]. Podle poznamky 3.26 tak pocitdme integral

2 r v
///p dz dp df.
00 0
Jak v piikladu 3.61, tak i nyni bychom méli obdrZet tabulkovy vzorec: V =7 -r? - v.
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Priklad 3.65: Vsechny tfi fady umi Maple ,,secist“.

@) 3 it = 1 0) X h=7, (©)

8

L — 0, fada diverguje.
n

S
Il
—

Priklad 3.68:

(a) s, =+/n, s = lim s, = co = fada diverguje,

n—oo
1 1 1 1 o 1
(b) a, = Tmns D T = Toa T m fada 7;1”_+1 diverguje = zadana tada
také diverguje,
(c) an = \/;L/fﬁ < /=5, fada Z -5 konverguje = konverguje i zadana fada,

n=1
o 1
(d) pouzijeme limitni srovnavaci kritérium a budeme srovnéavat s fadou Z =3, 0 niz vime,
Ze konverguje,
(e
(f

) pouzijeme limitni verzi podilového kritéria a zjistime, Zze fada konverguje,
g) vyuzijeme limitni verze odmocninového kritéria a zjistime, Ze zadana fada konverguje,

vyuzijeme opét limitni verze podilového kritéria a zjistime, ze fada diverguje,
(

(h
(i

vyuzijeme limitni verze podilového kritéria a zjistime, zZe zadané rada konverguje,

staci zadat systému Maple a zjistime, Ze zadané fada konverguje; jinak je mozné pouzit
napiiklad integralni kritérium.

Priklad 3.71:

(a) Jak soucet zadané fady, tak soudet fady absolutnich hodnot umi uréit Maple pfimo.
Zadana tada konverguje absolutné.

(b) Soucet zadané fady i fady absolutnich hodnot opét uréi Maple pfimo (i kdyz je po-
tieba se ,nevydésit* vypsanym tvarem vysledku pro soucet zadané fady). Zadana fada
konverguje neabsolutné.

(c) Pomoci Leibnizova kritéria zjistime, Ze zadané fada konverguje. Pomoci integralniho
kritéria ovérime, ze fada absolutnich hodnot diverguje. Zadana fada proto konverguje
neabsolutné.

(d) Pomoci Leibnizova kritéria zjistime, Ze zadana fada konverguje. Srovnavacim krité-
o0

riem s fadou Y 1 ovéfime, Ze Fada absolutnich hodnot diverguje. Zadana fada proto
n=1
konverguje neabsolutné.

(e) Pomoci limitni varianty odmocninového kritéria zjistime, ze fada absolutnich hodnot
konverguje. Zadana fada proto konverguje absolutné.

(f) V prikladu 3.67.(c) jsme zjistli, ze fada absolutnich hodnot zadané fady konverguje,
tedy zadana rada konverguje absolutné.
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Rejstrik

7,13
%, 16

abs, 11

absolutni konvergence rady, 143
All values, 22

AllSolutions, 21

allvalues, 22

alternujici rada, 142

animate, 43

apply, 32

Approximate Integration, 74, 130
Approximatelnt, 130

assign, 17

assume, 25, 86

assuming, 26

Asymptotes, 65

axes, 40

bod uzavéru, 113

Change, 69
changecoords, 120, 134
ChangeOfVariables, 120, 134
Classic Worksheet, 5
coeff, 26

collect, 26

color, 40

combine, 25
contourplot, 94
contours, 94, 176
convert, 26, 56, 69
CriticalPoints, 65

D, 51, 100

defini¢ni obor, 33
Determinant, 109

diff, 51, 99

Digits, 14, 17
DirectionalDerivative, 103
discont, 48, 60, 62, 63, 98
display, 81, 101
divergence tady, 135

Document Mode, 7

dolni integral, 71

dolni integralni soucet, 70
Drawing, 40

dsolve, 21

Error, (in plot) ..., 149

Error, illegal use of an object as a name, 147

Error, invalid assignment, 146

Error, invalid input, 145

Error, invalid operator parameter name, 149

Error, invalid power, 147

Error, numeric exception: division by zero,
147

Error, unable to match delimiters, 146

eval, 30, 31, 51, 109

evalb, 35

evalf, 14, 15, 22

expand, 26, 30

extrema, 60, 109, 113, 114

ExtremePoints, 65

factor, 26

frames, 43

fsolve, 21
FunctionChart, 65

gridlines, 89
gridrefine, 89, 91, 93

hessian, 109

Hessian, 109

Hessova matice, 109
hlavni menu, 5

horni integral, 71

horni integralni soucet, 71

implicitplot, 89, 91, 93, 121
implicitplot3d, 100
inequal, 91, 121
InflectionPoints, 65

Int, 68, 119

int, 67, 72, 119
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integralni kritérium, 140 parfrac, 69

integracni konstanta, 66 Parts, 68

IntegrationTools, 68, 69 pdsolve, 21

integrovatelna funkce, 72 Pi, 10

intsolve, 21 piecewise, 32

InversePlot, 36 Plot, 40

InverseTutor, 36 plot, 40, 62, 135

invfunc, 36 Plot Builder, 40

isolve, 21 plot3d, 80, 81, 88, 89, 94, 100, 101, 106

PlotBuilder, 88

plots, 43, 91, 101, 106, 121
plottools, 76, 121

podilové kritérium, 140

kernelopts(maxdigits), 14
kontextova lista, 5
konvergence tady, 135

labels, 40 pointplot3d, 101, 106

lem, 15 polygonplot, 182

legend, 40 posloupnost, 135

Leibnizovo kritérium, 143 posloupnost ¢astecnych souctt, 135
limit, 46, 95 primitivni funkce, 66

limitni Raabeovo kritérium, 140 _
limitni srovnavaci kritérium, 139 RealDomain, 19, 34

LinearAlgebra, 18, 109 restart, 17
LinearSolve, 21 Riemanntv integral, 72

RiemannSum, 72, 130

Maclaurintiv vzorec, 56 Roots, 65

Maclaurintv zbytek, 56 rsolve, 21

Maple Help, 11

Math Mode, 7 seq, 135

Maximize, 111, 113 simplify, 20, 25, 26, 30
maximize, 34, 111, 113, 114 singular, 98

metoda per partes, 67 solve, 20, 60, 76
Minimize, 111, 113 sort, 26

minimize, 34, 111-114 spacecurve, 101, 113, 114
msolve, 21 sqrt, 10

mtaylor, 107 srovnavaci kritérium, 139
Multilnt, 120 stacionarni body, 59

Standard Worksheet, 4

nastrojova lista, 5 stavova lista, 5

neabsolutni konvergence rady, 143 Student[Calculusl], 36, 65, 72, 84
nekonecné fada, 135 Student[MultivariateCalculus], 103, 120, 130
neurcity integral, 66 subs. 69

normalj 25 substituc¢ni metoda, 67

numpoints, 89 Sum, 135

obor hodnot, 33 sum, 135

odmocninové kritérium, 140
ohranic¢enda funkce, 33
Optimization, 111, 113

taylor, 56, 107
Taylortiv polynom, 55, 107

Order, 56, 107 TaylorL:w vzorec, 55, 107
. N Taylortav zbytek, 55, 107
oscilace tady, 135
Text Mode, 7
palety, 5, 9 thickness, 40
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trace, 43
transform, 76, 121
type, 146

unapply, 31, 51, 72
unassign, 17

Units, 20

Units Calculator, 20
unwith, 18

uzévér mnoziny, 113
uzaviena mnozina, 113

value, 68, 69

VectorCalculus, 109

verify, 35

Warning, solutions may have been lost, 151
Warning, unable to determine if ..., 151
What Assumptions, 22

with, 18, 109

Worksheet Mode, 7
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